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Notices

All Rights Reserved

© 2021, BioTek Instruments, Incorporated. No part of this publication may be reproduced,
transcribed, or transmitted in any form, or by any means electronic or mechanical,
including photocopying and recording, for any purpose other than the purchaser’s use
without written permission of BioTek Instruments, Inc.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a commitment
by BioTek Instruments, Inc. Changes made to the information in this document will be
incorporated in new editions of the publication. No responsibility is assumed by BioTek for
the use or reliability of software or equipment that is not supplied by BioTek or its affiliated
dealers.

Contact Information

Agilent Technologies, Inc.
5301 Stevens Creek Blvd.
Santa Clara, CA  95051

Worldwide Sales and Support

www.agilent.com/en/contact-us/page

Technical Support and Service

www.agilent.com/en/support

bio.tac@agilent.com

Instrument service and repair is available worldwide at one of our international service
centers and in the field at your location.

UK Responsible Person (UKRP)
Agilent LD UK Ltd
5500 Lakeside
Cheadle Royal Business Park
Cheadle, Cheshire SK8 3GR
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Intended Use Statement

The Synergy Neo2 is a multi-mode microplate reader and intended to be used for the
examination of specimens to analyze their characteristics and impact on a variety of analytes.

Quality Control
It is considered good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay package insert for the test
to be conducted. Failure to conduct Quality Control checks could result in erroneous test
data.

Warranty and Product Registration
Review the warranty information that shipped with your product. Register to ensure you
receive important information updates about the products you have purchased.
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Safety Notices
Raadpleeg Bijlage D voor informatie in andere talen.
Reportez-vous à l'annexe D pour obtenir des informations dans d'autres langues.
Informationen in anderen Sprachen finden Sie in Anhang D.
Fare riferimento all'Appendice D per informazioni in altre lingue.
Consulte el Apéndice D para obtener información en otros idiomas.

Pay special attention to the following safety notices in all product documentation.

A WARNING notice denotes a hazard. It calls attention to an operating
procedure, practice, or the like that, if not correctly performed or
adhered to, could result in personal injury or death. Do not proceed
beyond a WARNING notice until the indicated conditions are fully
understood and met.

A CAUTION notice denotes a hazard. It calls attention to an operating
procedure, practice, or the like that, if not correctly performed or
adhered to, could result in damage to the product or loss of important
data. Do not proceed beyond a CAUTION notice until the indicated
conditions are fully understood and met.

Warnings and Precautions

Electrical Hazards

Internal Voltage. Always turn off the power switch and unplug the power
supply before cleaning the outer surface of the instrument.

Power Rating. The instrument’s power supply or power cord must be
connected to a power receptacle that provides voltage and current within
the specified rating for the system. Use of an incompatible power
receptacle may produce electrical shock and fire hazards.

Electrical Grounding. Never use a plug adapter to connect primary power
to the external power supply. Use of an adapter disconnects the utility
ground, creating a severe shock hazard. Always connect the power cord
directly to an appropriate receptacle with a functional ground.

viii | Safety Notices
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Warnings and Precautions| ix

Service. Only qualified technical personnel should perform service
procedures on internal components.

Power Supply. Use only the power supply shipped with the instrument,
and operate it within the range of line voltages listed on it.

Chemical/Environmental

Potential Biohazards. Some assays or specimens may pose a biohazard.
Adequate safety precautions should be taken as outlined in the assay’s
package insert. Always wear safety glasses and appropriate protective
equipment, such as chemical-resistant rubber gloves and apron.

Liquids. Avoid spilling liquids on the instrument; fluid seepage into internal
components creates a potential for shock hazard or instrument damage. If
a spill occurs while a program is running, stop the program and turn off the
instrument. Wipe up all spills immediately. Do not operate the instrument
if internal components have been exposed to fluid.

Liquids. Do not immerse the instrument, spray it with liquid, or use a
dripping-wet cloth on it. Do not allow water or other cleaning solution to
run into the interior of the instrument. If this happens, contact Technical
Support.

Environmental Conditions. Do not expose the instrument to temperature
extremes. For proper operation, temperature near the instrument should
remain within the range in the Specifications section of this document.
Performance may be adversely affected if temperatures fluctuate above or
below this range

Sodium Hypochlorite. Do not expose any part of the instrument to the
recommended diluted sodium hypochlorite solution for more than 20
minutes. Prolonged contact may damage the instrument surfaces. Be
certain to rinse and thoroughly wipe all surfaces.

Lubricants. Do not apply lubricants to moving parts. Lubricant on
components in the carrier compartment will attract dust and other
particles, which may cause the instrument to produce an error.
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Components

Laser Beam. Serious eye injury may occur if you stare directly
into the laser beam of the barcode scanner during operation of
the scanner. This hazard is noted by the symbol shown here. Do
not look directly into the laser beam during operation of the
scanner.

Class 1 Laser Product. Alpha laser “A” and TRF laser “T” models

See Report on laser safety on page xi.

Pinch Hazard. Some areas of the external dispense module can
present pinch hazards when the instrument is operating. Keep
hands and fingers clear of these areas when the instrument is
operating.

Hot Surface. Models with incubation: The microplate carrier is
hot when the incubator is turned on and for a period of time
after the incubator is turned off. Do not touch the carrier or the
inside surface of the door.

Two-person lift. The instrument should be lifted by two people.
The instrument with all available modules weighs up to 45.5 kg.

Accessories. Only accessories that meet the manufacturer's
specifications shall be used with the instrument.

Shipping Hardware. All shipping hardware must be removed
before operating the instrument and reinstalled before
repackaging the instrument for shipment.

Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and
accessories may result in a loss of warranty and potentially
impair instrument performance or cause damage to the
instrument.
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Warnings and Precautions| xi

Service. Only qualified technical personnel should perform
service procedures on internal components.

Intended Product Use

Software Quality Control. The operator must follow the manufacturer’s
assay package insert when modifying software parameters and establishing
reading methods. It is considered good laboratory practice to run
laboratory samples according to instructions and specific
recommendations included in the assay package insert for the test to be
conducted. Failure to conduct quality control checks could result in
erroneous test data.

Data Reduction. No limits are applied to the raw measurement data. Data
exported via computer control must be analyzed by the operator. The
performance characteristics of the data reduction software have not been
established with any laboratory diagnostic assay. Users must evaluate this
instrument and PC-based software in conjunction with their specific assay
(s). This evaluation must include the confirmation that performance
characteristics for the specific assay(s) are met.

Unspecified Use. Failure to operate equipment according to the guidelines
and safeguards specified in the product user documentation could result in
a hazardous condition.

Use of labware other than described in this document can result in
positioning errors during program execution.

Report on laser safety

Synergy Neo2 T-models with the N2 laser

Synergy Neo2 “T” models include a nitrogen laser MNL-100 manufactured by LTB. This
laser is classified to class 3B and therefore the safety aspects are made according to laser
class 3B.

Synergy Neo2 A-models with the Alpha Laser

Synergy Neo2 “A” models include an Alpha Laser, K6880E09FN-0.800W manufactured by
BWT Beijing. This laser is classified to class 3B and therefore the safety aspects are made
according to laser class.
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Concerning class 3B lasers, the International Standard IEC 60825-1 on the safety of laser
products states the following: “Class 3B: Lasers are normally hazardous when direct
intrabeam exposure occurs (i.e., within the NOHD). Viewing diffuse reflections is normally
safe.”
Regarding laser safety, it is extremely important to prevent the user from being exposed to
laser beam, either directly or through reflection from a mirror surface. Although the laser
used in Synergy Neo2 is a class-3B laser, the Synergy Neo2 instrument is a class 1 laser
product. This is possible, because Synergy Neo2 has adequate laser shielding which
prevents the user being exposed to the laser radiation.
The Synergy Neo2's interlock system prevents user exposure to the laser beam by disabling
the laser whenever the top-filter door, plate carrier, or side (bottom-filter) hatch of the
instrument is open. The state of the interlock is made visible to users via LEDs on the laser
unit attached to the rear of the instrument. Red LEDs indicate interlock activity; green LEDs
indicate safe laser usage.
When closed the three doors form a light-tight system. Light tightness is essential not only
for laser safety, but also for the functional performance of the instrument. The laser itself
has been installed on the instrument under a protective casing, and the laser beam is led
by an optical fiber via the electronics compartment to the light-tight instrument
compartment.
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Symbols| xiii

Symbols
Veiligheidssymbolen
Symboles de sécurité
Sicherheitssymbole
Simboli di sicurezza
Símbolos de seguridad

Caution, consult the instructions for use for important
cautionary information such as warnings and
precautions

Voorzichtig, raadpleeg de gebruiksaanwijzing voor
belangrijke voorzorgsinformatie zoals waarschuwingen
en voorzorgsmaatregelen

Attention, pour des informations de mise en garde
importantes telles que des avertissements et des
précautions, consultez le mode d'emploi.

Achtung, lesen Sie die Gebrauchsanweisung für
wichtige Vorsichtshinweise wie Warnungen und
Sicherheitsvorkehrungen

Attenzione, consultare le istruzioni per l'uso per
importanti informazioni cautelative come avvertenze e
precauzioni

Precaución, consulte las instrucciones de uso para
obtener información importante, como advertencias y
precauciones

Warning; Biological hazard

Waarschuwing; biologisch gevaar

Avertissement : Risque biologique

Warnung; biologische Gefahr

Avvertenza, rischio biologico

Advertencia: peligro biológico
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Warning; Laser beam (If equipped with the optional
external barcode scanner)

Waarschuwing; Laserstraal (Als ik Uitgerust met de
optionele externe barcode scanner)

Avertissement; faisceau laser (Si j'EQUIPEE avec le
scanner de codes à barres externe en option)

Warnung; Laserstrahl (Wenn ich mit den optionalen
externen Barcode-Scanner ausgerüstet)

Avvertimento; Raggio laser (Se equipaggiata con il
barcode scanner esterno opzionale)

Advertencia; rayo láser (Si equipado con el escáner de
código de barras externo opcional)

Warning; Class 1 Laser Product (Alpha laser “A” and
TRF laser “T” models)

Waarschuwing; Klasse 1 Laser Product (Alpha Laser "A"
en TRF laser "R" -modellen)

Avertissement; Laser de classe 1 (Alpha Laser "A" et
TRF laser modèles "R")

Warnung; Laser Klasse 1 (Alpha Laser "A" und TRF-
Laser "R" -Modelle)

Avvertimento; Classe prodotto 1 Laser (Alpha Laser "A"
e la FR laser modelli "R")

Advertencia; Producto láser de clase 1 (Alpha Laser "A"
y TRF láser modelos "R")
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Symbols| xv

Complies with FDA performance standards for laser
products except for conformance with IEC 60825-1
Ed.3., as described in Laser Notice No.56, dated May 8,
2019. (Alpha laser “A” and TRF laser “T” models)

Voldoet aan FDA-prestatienormen voor laserproducten
behalve conform IEC 60825-1 Ed.3., Van beschreven in
Laser Notice No.56, gedateerd 8 mei 2019. (Alpha
Laser "A" en TRF laser "R" -modellen)

Conforme aux normes de performance de la FDA pour
les produits laser sauf pour la conformité à la norme
IEC 60825-1. Ed.3, De décrits dans Laser Notice No.56,
datée du 8 mai 2019. (Alpha Laser "A" modèles et TRF
laser "R")

Erfüllt Performance FDA-Standards für Laserprodukte
außer für die Konformität mit IEC 60825-1 Ed.3., In
Laser Notice No.56 beschrieben Aus, vom 8. Mai 2019
(Alpha Laser "A" und TRF-Laser "R" -Modelle)

Conforme agli standard di prestazione FDA per i
prodotti laser tranne che per la conformità alla norma
IEC 60825-1. Ed.3, Da descritti nella Laser Notice
No.56, in data 8 maggio 2019. (e laser modelli Alpha
Laser "A" della Fondazione "R")

Conforme con las normas de rendimiento de la FDA
para productos láser, excepto para la conformidad con
la norma IEC 60825-1. Ed.3, desde que se describen en
Laser Notice No.56, de fecha 8 de mayo de 2019. (láser
y modelos Alfa láser "A" TRF "R")

Warning; Pinch hazard

Waarschuwing; beknellingsgevaar

Avertissement : risque de pincement

Warnung; Quetschgefahr

Avvertenza, rischio di pizzicamento

Advertencia: peligro de atrapamiento
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Caution; carton exceeds 50lbs (22.5kg). When
handling, two or more people are required.

Voorzichtig; de doos weegt meer dan 22,5 kg. Bij het
hanteren zijn twee of meer personen nodig.

Attention : le carton dépasse 50 lb (22,5 kg). Lors de la
manipulation, deux personnes ou plus sont
nécessaires.

Vorsicht; Karton überschreitet 22,5 kg (50 lbs). Zur
Handhabung sind zwei oder mehr Personen
erforderlich.

Attenzione, la confezione pesa più di 22,5 kg. Per la
movimentazione sono necessarie due o più persone.

Precaución: la caja pesa más de 22,5 kg (50 lb). Para
manipularla hacen falta dos o más personas.

Warning; Hot surface

Waarschuwing; heet oppervlak

Avertissement : surface chaude

Warnung; heiße Oberfläche

Avvertenza, superficie molto calda

Advertencia: superficie caliente
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Symbols| xvii

Disposal Notice: Dispose of the instrument according
to Directive 2012/19/EU, “on waste electrical and
electronic equipment (WEEE)” or local ordinances

Kennisgeving van verwijdering: Verwijder het
instrument volgens Richtlijn 2012/19/EU betreffende
afgedankte elektrische en elektronische apparatuur
(AEEA) of lokale verordeningen

Avis concernant la mise au rebut : mettez l'instrument
au rebut conformément à la directive 2012/19/EU
portant sur les déchets d'équipement électrique et
électronique (DEEE) ou aux dispositions locales.

Entsorgungshinweis: Entsorgen Sie das Gerät gemäß
der Richtlinie 2012/19/EU „für Elektro- und Elektronik-
Altgeräte (WEEE)“ bzw. den Landesvorschriften.

Avviso per lo smaltimento: smaltire lo strumento in
base alla Direttiva 2012/19/EU, sui "rifiuti di
apparecchiature elettriche ed elettroniche (WEEE)" o
le ordinanze locali

Aviso de eliminación: elimine el instrumento de
conformidad con la Directiva 2012/19/UE sobre
residuos de aparatos eléctricos y electrónicos (RAEE) o
las ordenanzas locales
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CE Marking – Indicates compliance with the
requirements of the Directive 2014/30/EU on
Electromagnetic Compatibility and the Directive
2014/35/EU on Low Voltage

CE-markering – Geeft aan dat wordt voldaan aan de
vereisten van Richtlijn 2014/30/EU inzake
elektromagnetische compatibiliteit en Richtlijn
2014/35/EU inzake laagspanning

Marquage CE – Indique la conformité aux exigences de
la directive 2014/30/UE sur la compatibilité
électromagnétique et de la directive 2014/35/UE sur la
basse tension

CE-Kennzeichnung – Zeigt die Einhaltung der
Anforderungen der Richtlinie 2014/30/EU über
elektromagnetische Verträglichkeit und der Richtlinie
2014/35/EU über Niederspannung

Marcatura CE – Indica la conformità ai requisiti della
Direttiva 2014/30/UE sulla Compatibilità
Elettromagnetica e della Direttiva 2014/35/UE sulla
Bassa Tensione

Marcado CE: indica el cumplimiento de los requisitos
de la Directiva 2014/30 / UE sobre compatibilidad
electromagnética y la Directiva 2014/35 / UE sobre
baja tensión.

Date of manufacture

Productiedatum

Date de fabrication

Herstellungsdatum

Data di produzione

Fecha de fabricación
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TÜV SÜD Certification Mark – Type tested; production
monitored

TÜV SÜD certificeringsmerk - type getest; productie
bewaakt

TÜV SÜD Marque de certification – Type testé ;
production contrôlée

TÜV SÜD-Prüfzeichen – Typ geprüft; Produktion
überwacht

Marchio di certificazione TÜV SÜD: tipo testato,
produzione monitorata

Marca de certificación TÜV SÜD: tipo probado,
producción controlada
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This product complies with environmental protection
use period as defined in People’s Republic of China
Electronic Industry Standard SJ/T11364-2006. Toxic or
hazardous substances will not leak or mutate under
normal operating conditions for 40 years.

Dit product voldoet aan de
milieubeschermingsgebruiksperiode zoals gedefinieerd
in de Electronic Industry Standard SJ/T11364-2006 van
de Volksrepubliek China. Giftige of gevaarlijke stoffen
zullen onder normale bedrijfsomstandigheden
gedurende 40 jaar niet lekken of muteren.

Ce produit est conforme à la période d'utilisation dans
le cadre de la protection de l'environnement telle que
définie par la norme de l'industrie électronique de la
République populaire de Chine SJ/T11364-2006. Les
substances toxiques ou dangereuses ne fuiront pas ou
ne subiront pas de mutation dans des conditions de
fonctionnement normales pendant 40 ans.

Dieses Produkt entspricht der Umweltschutz-
Nutzungsdauer gemäß der Definition im Electronic
Industry Standard SJ/T11364-2006 der Volksrepublik
China. Giftige oder gefährliche Stoffe werden unter
normalen Betriebsbedingungen 40 Jahre lang nicht
austreten oder mutieren.

Questo prodotto è conforme al periodo di utilizzo della
protezione ambientale come definito nello Standard
del settore elettronico della Repubblica Popolare
Cinese SJ/T11364-2006. Le sostanze tossiche o
pericolose non fuoriescono o non subiscono mutazioni
in condizioni operative normali per 40 anni.

Este producto cumple con el periodo de uso de
protección ambiental según el estándar SJ/T11364-
2006 de la República Popular China para la industria
electrónica. Las sustancias tóxicas o peligrosas no se
filtrarán ni mutarán en condiciones de funcionamiento
normales durante 40 años.
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UK Conformity Assessed marking is a certification mark
that indicates conformity with the applicable
requirements for products sold within Great Britain.

De 'UK Conformity Assessed'-markering is een
certificeringsmerk dat aangeeft dat producten die in
Groot-Brittannië worden verkocht, voldoen aan de
toepasselijke eisen.

Le marquage UK Conformity Assessed est une marque
de certification qui indique la conformité aux
exigences applicables aux produits vendus en Grande-
Bretagne.

Die Kennzeichnung „UK Conformity Assessed“ ist ein
Zertifizierungszeichen, das die Konformität mit den
geltenden Anforderungen für in Großbritannien
verkaufte Produkte anzeigt.

Il marchio UKCA (conformità valutata del Regno Unito)
è un marchio di certificazione che indica la conformità
ai requisiti applicabili per i prodotti venduti in Gran
Bretagna.

El marcado UKCA (UK Conformity Assessed) es una
marca de certificación que indica la conformidad con
los requisitos aplicables para los productos vendidos
en Gran Bretaña.
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EAC-MED is a certification mark to indicate products
that conform to all the safety and quality requirements
of the Eurasian Customs Union. It means that the EAC-
MED marked products meet all requirements of the
corresponding technical regulations and have passed
all conformity assessment procedures.

EAC-MED is een certificeringsmerk om producten aan
te duiden die voldoen aan alle veiligheids- en
kwaliteitseisen van de Euraziatische douane-unie. Dit
betekent dat de producten met een EAC-MED-
markering aan alle eisen van de desbetreffende
technische voorschriften voldoen en alle
conformiteitsbeoordelingsprocedures hebben
doorlopen.

EAC-MED est une marque de certification qui indique
la conformité des produits à toutes les exigences de
sécurité et de qualité de l'Union douanière
eurasiatique. Cela signifie que les produits marqués
EAC-MED satisfont à toutes les exigences des
réglementations techniques correspondantes et ont
passé toutes les procédures d'évaluation de la
conformité.

EAC-MED ist ein Zertifizierungszeichen zur
Kennzeichnung von Produkten, die allen Sicherheits-
und Qualitätsanforderungen der Eurasischen Zollunion
entsprechen. Das bedeutet, dass die EAC-MED-
gekennzeichneten Produkte alle Anforderungen der
entsprechenden technischen Bestimmungen erfüllen
und alle Konformitätsbewertungsverfahren bestanden
haben.

EAC-MED è un marchio di certificazione che indica
prodotti conformi a tutti i requisiti di sicurezza e
qualità dell'Unione doganale eurasiatica. Ciò significa
che i prodotti con marchio EAC-MED soddisfano tutti i
requisiti dei regolamenti tecnici corrispondenti e
hanno superato tutte le procedure di valutazione della
conformità.
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EAC-MED es una marca de certificación para indicar
productos que cumplen con todos los requisitos de
seguridad y calidad de la Unión Aduanera Euroasiática.
Significa que los productos con la marca EAC MED
cumplen todos los requisitos de los reglamentos
técnicos correspondientes y han superado todos los
procedimientos de evaluación de conformidad.

Product complies with Australian Communications
Requirements
EESS - The Regulatory Compliance Mark (RCM)
ACMA Labeling Requirements

Product voldoet aan de Australische communicatie-
eisen
EESS - De markering voor naleving van de regelgeving
(RCM)
ACMA-etiketteringsvoorschriften

Le produit est conforme aux exigences australiennes
en matière de communication
EESS - Marque réglementaire de conformité (RCM)
Exigences en matière d'étiquetage ACMA

Das Produkt entspricht den australischen
Kommunikationsanforderungen.
EESS – Kennzeichnung „Regulatory Compliance Mark“ 
(RCM)
ACMA-Kennzeichnungsanforderungen

Il prodotto è conforme ai requisiti Australian
Communications Requirements
EESS: marchio di conformità alle normative
Requisiti di etichettatura ACMA

El producto cumple con los requisitos de
comunicaciones de Australia.
EESS: marcado RCM (Regulatory Compliance Mark) de
cumplimiento de la normativa.
Requisitos de etiquetado de ACMA
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Korea Certification (KC) mark signifies Korea product
compliance mark for safety and EMC/Radio/SAR of
electrical and electronic equipment. The EMC
requirements are applied to Agilent products.

Korea Certification (KC)-merkteken staat voor Korea-
productconformiteitsmerk voor veiligheid en
EMC/Radio/SAR van elektrische en elektronische
apparatuur. De EMC-eisen worden toegepast op
Agilent-producten.

La marque de certification coréenne (KC) signifie la
marque de conformité des produits coréens pour la
sécurité et l'EMC/Radio/SAR des équipements
électriques et électroniques. Les exigences CEM
s'appliquent aux produits Agilent.

Das Korea-Zertifizierungszeichen (KC) bezeichnet das
koreanische Produktkonformitätszeichen für Sicherheit
und EMV/Funk/SAR von elektrischen und
elektronischen Geräten. Die EMV-Anforderungen
gelten für Agilent-Produkte.

Il marchio Korea Certification (KC) indica il marchio di
conformità del prodotto Corea per la sicurezza e
EMC/Radio/SAR di apparecchiature elettriche ed
elettroniche. I requisiti EMC vengono applicati ai
prodotti Agilent.

La marca de certificación de Corea (KC) significa la
marca de cumplimiento de productos de Corea para la
seguridad y EMC / Radio / SAR de equipos eléctricos y
electrónicos. Los requisitos de EMC se aplican a los
productos Agilent.

Conformance to Standards

The Synergy Neo 2 meets the requirements of the following standards:

2014/35/EU – Low Voltage Directive

2014/30/EU – EMC Directive

xxiv | Conformance to Standards
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2011/65/EU (with exemptions) and (EU) 2015/863 – RoHS Directives

2012/19/EU – WEEE Directive as amended by (EU) 2018/849

2006/42/EC of the European Parliament and of the Council of 17 May 2006 on machinery

Standard Description

IEC QC 080000 IEC Quality Assessment System for Electronic Components
(IECQ System) - Hazardous Substance Process Management
(HSPM) System Requirements

UL 61010-1 UL Standard for Safety Electrical Equipment For
Measurement, Control, and Laboratory Use; Part 1: General
Requirements

EN 61010-1 Safety Requirements for Electrical Equipment For
Measurement, Control, and Laboratory Use – Part 1: General
Requirements

EN 61010-2-010 Safety Requirements for Electrical Equipment For
Measurement, Control, and Laboratory Use – Part 2-010:
Particular requirements for laboratory equipment for the
heating of materials

EN 61010-2-081 “Particular requirements for automatic and semi-automatic
laboratory equipment for analysis and other purposes.”

EN 61010-2-010 “Particular requirements for laboratory equipment for the
heating of materials.“ 

EN 60825-1 "Safety of laser products. Part 1: Equipment classification and
requirements."

CAN/CSA C22.2 No. 61010-1 Safety Requirements for Electrical Equipment For
Measurement, Control, and Laboratory Use – Part 1: General
Requirements

CAN/CSA C22.2 No. 61010-2-010 Safety Requirements for Electrical Equipment For
Measurement, Control, and Laboratory Use – Part 2-010:
Particular requirements for laboratory equipment for the
heating of materials
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EMC Information and Technical Description

The Synergy Neo 2 conforms to:

Emissions:

EN55011/CISPR 11, Class A

CFR Title 47 FCC Part 15 Subpart B, Class A

ICES-001, Issue 5, Class A  (CAN ICES-001(A)/NMB-001(A))

ACMA AS/NZS CISPR 11, Class A

Immunity:

EN/IEC 61326-1 and 61326-2-6

ELECTRICAL EQUIPMENT FOR MEASUREMENT, CONTROL AND LABORATORY USE

PART 1: GENERAL REQUIREMENTS FOR (NON IVD) LISTED PRODUCTS

Ingress Protection Code

IP 20. Protected against solid foreign objects of 12.5 mm diameter and greater. No protection
against water.

Disposal

Dispose of the instrument according to Directive 2012/19/EU, “on waste electrical and
electronic equipment (WEEE)” or local ordinances.

xxvi | EMC Information and Technical Description
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Chapter 1

Introduction

This chapter introduces the Synergy Neo 2 Multi-Mode Microplate Reader,
describes its hardware and software features, and provides contact
information for technical assistance.

Product Description 2

Package Contents 3

Optional Accessories 4

Technical Support 7
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2 | Chapter 1: Introduction

Product Description
The Synergy Neo 2 is a multi-mode microplate reader. Depending on the model, Synergy
Neo 2 detection modes include fluorescence intensity (FI), fluorescence polarization (FP),
time-resolved fluorescence (TRF) — using a xenon flash or nitrogen laser, luminescence,
UV-visible absorbance, and alpha. The reader is modular, and upgrade options are
available; contact BioTek Customer Care for more information.
The reader is computer-controlled using Gen5 software for all operations, including data
reduction and analysis. The Synergy Neo 2 is robot accessible and compatible with the
BioTek Synergy Neo Stacker and BioStack 4; and with BioSpa 8 Automated Incubator. Gen5
supports OLE automation to facilitate the Synergy Neo 2’s integration into an automated
system.
The Synergy Neo 2 can perform reads using barcoded filter cubes or a monochromator.1
The filter-based system can perform top and bottom fluorescence, luminescence, and
alpha reads. Filter fluorescence uses a xenon flash light source or TRF laser in equipped
models, along with interference filters and dichroic mirrors for wavelength specificity and
up to three photomultiplier tubes (PMTs). To run a fluorescence polarization protocol, the
filter cube must contain polarizing filters. Luminescence is measured through an empty
filter position in the filter cube, (filters can be used if light filtering is necessary) and a
dedicated broadband luminescence fiber.
The monochromator-based system, which has both top and bottom probes, is used for
absorbance, fluorescence, and luminescence spectral reads. The xenon lamp allows for
both UV and visible light measurements. The monochromator provides wavelength
selection from 230–999 nm in 1 nm increments. Available absorbance and fluorescence
read methods are endpoint, area scan, spectral scanning, and pathlength correction. You
can use the monochromator optics for luminescence spectral scanning.
The alpha detection method can be used for endpoint reads using the top filter system in
non-synchronized plate mode.
The Synergy Neo 2 has 4-Zone temperature control from 4°C over ambient to 70°C. (For
alpha detection mode, the range is 3°C over ambient to 30°C.) Internal plate shaking, with
both linear and orbital modes, is supported to ensure that reagents are properly mixed
prior to reading.
The Synergy Neo 2 supports the reading of 6-, 12-, 24-, 48-, 96-, 384, and 1536-well
microplates with 128 x 86 mm geometry as well as the Take3 and Take3 Trio Multi-Volume
Plates.

Use of microplates other than those listed can result in positioning errors during
program execution.

1This dual light path capability is protected by U.S. patent number 8,218,141.
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Models with injectors support dual-reagent dispensing to 6-, 12-, 24-, 48-, 96-, and 384-
well microplates. An external dispense module pumps fluid from the supply bottles to the
two injectors located inside the instrument.

See Appendix A for performance and technical specifications.

Package Contents
Package contents and part numbers are subject to change.

Item Part #

Synergy Neo 2 User Manual 1351000N

Power cord set (specific to installation environment):

Europe (Schuko)

USA/International

United Kingdom

Australia/New Zealand

75010

75011

75012

75013

USB cable 75108

Filter cube rack (except NEO2MON models) 1030541

Models with an external dispense module (packed separately), with the following accessories:

Injector 8040541

Inlet tubes (2) from supply bottles to syringe drives 7082121

250-µL syringes (2) 7083000

Syringe thumbscrews 19511

Priming plate 8042202

Injector tip priming trough 8042068

Dispense module communication cable 75107

Dispense module front cover 8042313

Dispense module box 8040579

Supply bottles (2, 30 mL) 7122609

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



4 | Chapter 1: Introduction

Item Part #

Supply bottle holders (2) 8042193

Injector tip cleaning stylus and plastic storage bag 2872304

Strap reagent racks (6) 7212035

Optional accessories per the sales order, unless shipped separately.

Optional Accessories

Accessory availability and part numbers are subject to change.

Item Part #

7-filter Absorbance Test Plate for absorbance
measurement testing

7260522

Absorbance Test Plate for absorbance
measurement testing at 340 nm

7260551

Synergy Neo 2 Product Qualification (IQ-OQ-PQ)
package

1350526N

Microplate Barcode Scanner 1030008

Take3 Micro-Volume Plate TAKE3

Take3 Trio Micro-Volume Plate TAKE3TRIO

RS-232 serial cable 75034

PCR Tube Adapter Plates 6002072
6002076

BioCell Quartz Vessel 7272051

BioCell Adapter Plate 7270512

Replacement Shipping Materials 1033027 (instrument shipping box for all except
T-models); 1843002 for T-models

1030009 Shipping hardware kit
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Item Part #

Luminometer Reference Microplate (includes
microplate carrier adapter PN #8042263 for
Synergy Neo2)

8030015

Gas controller, CO2 control only 1210012

Gas controller, CO2 and O2 control 1210013

Filter cubes Contact BioTek

Fluorescence Test Plate 1400501

The Synergy Neo 2 is compatible with the Synergy Neo Stacker and BioStack 4. The
stacker rapidly and systematically transfers microplates to and from the instrument’s
microplate carrier.

Materials for Conducting Liquid Tests

Manufacturer part numbers are subject to change.

Item Part Number

Absorbance Liquid Tests

BioTek Wetting Agent Solution 7773002

BioTek QC Check Solution #1 (25 mL) 7120779

BioTek QC Check Solution #1 (125 mL) 7120782

Phosphate-Buffered Saline (PBS) tablets (pH 7.2–7.6) Sigma #P4417

β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, reduced form) 98233 or
Sigma #N6785-10VL

Fluorescence Liquid Tests

Test Kits

Kit with microplates and test solutions for conducting
Corners/Sensitivity/Linearity (FI) tests using Sodium Fluorescein and
Methylumbelliferone, and Time-Resolved Fluorescence (TRF) tests using
Europium

7160010 (contains
7160013, 7160012, and
7160011 described
below)
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Item Part Number

Kit for FI tests using Sodium Fluorescein 7160013

Kit for FI tests using Methylumbelliferone 7160012

Kit for TRF tests using Europium 7160011

Kit for Fluorescence Polarization (FP) test 7160014 or
Invitrogen #P3088

Individual Materials

Sodium Fluorescein Powder, 1 mg vial 98155

Methylumbelliferone, 10 mg vial 98156

Carbonate-Bicarbonate Buffer (CBB) capsules
Sigma #3041

Phosphate-Buffered Saline (PBS) tablets, pH 7.2–7.6 Sigma #P4417

Sodium Borate, pH 9.18 Fisher Scientific
#159532 or equivalent

Injection System Tests

BioTek Green Test Dye 7773003

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



Technical Support | 7

Technical Support

See also "Contact Information" on page vi

Please be prepared to provide the following information:

l Your name and company information, along with a daytime phone or fax number,
and/or an e-mail address

l The product name, model, and serial number

l The instrument software part number and basecode version (available via Gen5 for
the Synergy Neo 2 by selecting System > Instrument Control > Information)

l The version of Gen5. From the main Gen5 screen, select Help > About Gen5.

l A copy of the Synergy Neo 2 system test results.

l For troubleshooting assistance or instruments needing repair, the specific steps that
produce your problem and any error codes displayed in Gen5 (see also Appendix B,
Error Conditions)

If you need to return an instrument to BioTek for service or repair, please contact Technical
Support for instructions. Repackage the instrument according to the instructions at the end
of Chapter 2
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Chapter 2

Installation

This chapter includes instructions for unpacking and setting up the Synergy
Neo 2 and, if applicable, the external dispenser, the barcode reader, and
the Synergy Neo Stacker. Instructions are also included for preparing the
reader and dispenser for shipment.

Product Registration 9

Important Information 9

1: Unpack and Inspect the Reader 10

2: Unpack and Inspect the Dispenser 10

3: Unpack and Inspect the Gas Controller (if applicable) 11

4: Select an Appropriate Location 11

5: Remove the Shipping Hardware 12

6: Install the Power Supply 14

7: Install the Gas Controller (if applicable) 15

8: Install the Dispenser 15

9: Connect the Host Computer 19

10: Install Gen5 on the Host Computer 19

11: Turn on the Reader 20

12: Establish Communication 20

13: Set Dispenser Calibration Values 21

14: Run a System Test 22

15: Test the Injector System 24

Operational/Performance Qualification 25

Repackaging and Shipping Instructions 25
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Product Registration
Register with BioTek to ensure that you receive important information and updates about
the products you have purchased.

Important Information

Two-person lift. The instrument should be lifted by two people. The
instrument with all available modules weighs up to 45.5 kg.

Shipping Hardware. All shipping hardware must be removed before
operating the instrument and reinstalled before repackaging the
instrument for shipment.

l This chapter contains installation and setup tasks for the Synergy Neo 2 and
accessories. Perform the tasks in the order presented.

l Save all packaging materials. Be sure to use packaging materials supplied by the
manufacturer when shipping the reader. Using other forms of commercially available
packaging, or failing to follow the repackaging instructions, may void your warranty.

l During the unpacking process, inspect the packaging, reader, and accessories for
shipping damage. If the reader is damaged, notify the carrier and your BioTek
representative. Keep the shipping boxes and the packaging materials for the carrier's
inspection.
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1: Unpack and Inspect the Reader

Save all packaging materials. If you need to ship the reader to BioTek for repair or
replacement, you must use the BioTek-supplied materials. Using other forms of
commercially available packaging, or failing to follow the repackaging instructions, may
void your warranty.

During the unpacking process, inspect the packaging, reader, and accessories for
shipping damage. If the reader is damaged, notify the carrier and your BioTek
representative. Keep the shipping boxes and the packaging materials for the carrier's
inspection. BioTek will arrange for repair or replacement immediately.

1. Open the shipping box, remove the instrument from the box, and place it on a level,
stable surface.

2. Place the packaging materials back into the shipping box for reuse if the instrument
needs to be shipped again.

2: Unpack and Inspect the Dispenser

Save all packaging materials. If you need to ship the reader to BioTek for repair or
replacement, you must use the BioTek-supplied materials. Using other forms of
commercially available packaging, or failing to follow the repackaging instructions, may
void your warranty.

During the unpacking process, inspect the packaging, reader, and accessories for
shipping damage. If the reader is damaged, notify the carrier and your BioTek
representative. Keep the shipping boxes and the packaging materials for the carrier's
inspection. BioTek will arrange for repair or replacement immediately.

If applicable, perform these steps to unpack the dispenser.

1. Open the shipping box. Remove the accessories box and foam insert that contains the
injector tubing and bottle holders.

2. Lift out the dispenser and place it on a level surface.

3. Open the accessories box and remove its contents. The accessories should include the
dispenser-related items listed under Package Contents in Chapter 1.

4. Place all packaging materials into the shipping box for reuse if the dispenser needs to be
shipped.
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3: Unpack and Inspect the Gas Controller (if applicable)
If applicable, perform these steps to unpack the gas controller.

1. Open the shipping box.

2. Lift out the accessories (power supply, tubing, and manual), and set them aside.

3. Lift out the gas controller, and place it on a level surface.

4. Place all packaging materials into the shipping box for reuse if the gas controller needs
to be shipped.

4: Select an Appropriate Location
Install the reader on a level, stable surface in an area where temperatures between 18°C
(64°F) and 40°C (104°F) can be maintained.

For alpha laser reads, the temperature should be no warmer than 30°C (86°F).

Leave at least six inches of space between the instrument’s rear panel and any other
object. This space ensures proper air flow in and out of the instrument.

If you intend to use the bottom filter access door on the left side of the instrument,
ensure that you select a location that allows for easy access to the door.

The reader is sensitive to extreme environmental conditions. Avoid the following:

l Excessive humidity. Condensation directly on the sensitive electronic circuits can
cause the instrument to fail internal self-checks. The humidity must be in the range of
10–85%, non-condensing.

l Excessive ambient light. Bright light may affect the reader’s optics and readings,
reducing its linear range.

l Dust. Readings may be affected by extraneous particles (such as dust) in the
microplate wells. A clean work area is necessary to ensure accurate readings.

BioStack/Barcode Scanner: If you are installing the barcode scanner "Microplate
Barcode Scanner" on page 175or the Synergy Neo Stacker or BioStack 4 for operation
with the Synergy Neo 2, you may wish to set them up now. This is a good time, for
example, to seat the instruments in their aligning plates. (Refer to the Synergy Neo
Stacker User Manual or BioStack User Manual for more information.)
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5: Remove the Shipping Hardware

Shipping Hardware. All shipping hardware must be removed before
operating the instrument and reinstalled before repackaging the instrument
for shipment.

1. Locate the shipping hardware: plate carrier shipping brackets, and, if equipped, top filter
chamber shipping brackets, the bottom filter chamber shipping bracket, and T-model
set screw with yellow tag.
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2. Using a #2 Phillips screwdriver, remove the screws holding the carrier shipping bracket.
Push the carrier off the rear of the bracket, and then lift and withdraw the bracket from
the instrument.

If equipped:

3. Remove the top filter chamber shipping bracket(s).

4. T-Models: remove the set screw and its yellow tag from the switching block.

5. Remove the bottom filter chamber shipping bracket.
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6. Store the shipping brackets
and hardware with the
original packaging for reuse in
case you need to ship the
instrument.

7. T-Models: Remove safety keys
taped to the top of the TRF
laser, insert a key and turn to
ON.

The filter cubes are shipped in a protective case. The Getting Started chapter explains
when and how to install filter cubes.

6: Install the Power Supply

Power Rating. The instrument must be connected to a power receptacle
that provides voltage and current within the specified rating for the
system. Use of an incompatible power receptacle may produce electrical
shock and fire hazards

Electrical Grounding. Never use a plug adapter to connect primary power
to the instrument. Use of an adapter disconnects the utility ground,
creating a severe shock hazard. Always connect the system power cord
directly to an appropriate receptacle with a functional ground.

Power Supply. Use only the power supply shipped with the instrument,
and operate it within the range of line voltages listed on it.

Do not plug the power supply into a power receptacle until after the power supply is
connected to the instrument.
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1. Locate the power inlet on the left side of the reader.

2. Examine the power supply's plug. It has three small holes and a small groove that line up
with the prongs and a tab inside the power inlet.

3. Insert the plug into the power inlet and finger-tighten the collar of the plug. Plug the
power supply's cord into an appropriate power receptacle.

7: Install the Gas Controller (if applicable)
The gas controller is an external module that enables the user to control CO2 and O2
concentrations inside the attached instrument’s reading chamber. If you purchased the
module for operation with the Synergy Neo 2, refer to the Gas Controller User Guide for
installation instructions.

8: Install the Dispenser

Place the dispense module on top of the reader or on top of the gas controller (if
equipped). Do not place the dispenser next to the reader.

Synergy Neo2 with dispenser, and with dispenser and gas controller

1. Open the plastic bag containing the injector tube and tips. Remove the clear plastic
shrouds from the tubes.
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2. Remove the two inlet tubes from their plastic canisters.

3. Identify the two syringe valves on the dispense module. Each is labeled with a left-
pointing arrow.

When installing the inlet and outlet tubes, do not use any tools. Finger-tighten only!

4. Screw the fitting of one inlet tube into the right side of the Syringe 1 valve.

5. Identify the #1 outlet tube, and screw it into the left side of the Syringe 1 valve.

6. Repeat these steps to attach the inlet and outlet tubing for Syringe 2.

It is critical that the tubing is installed in the correct ports. Otherwise, injected fluid
may miss the intended well.

7. Remove the round tubing feed-through cover from the top of the reader (2 screws).
Store the cover and screws with the shipping hardware in case the reader needs to be
shipped again.

8. Thread the injector tip holder, with outlet tubing connected to both ports, through the
hole in the top of the reader.

9. Open the reader's top door, and, holding the injector tip holder by the tab, insert the
injector tips into the appropriate holes inside the reader, behind the filter cube chamber
(s).

Removing any filter cubes that are installed in the filter cube chambers may be
necessary to reach the injector tip holes.
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Injector tip holder in its
socket

A magnet located between the injector tips helps to guide the tips into place and
secures them in the reader.

10. Place the tubing feed-through cover over the hole in the top of the reader, and finger-
tighten the thumbscrews to secure it.

11. Remove the two syringes from their protective boxes. They are identical and
interchangeable.
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12. Install both syringes.

l Hold the syringe vertically with the threaded end at the top.

l Screw the top of the syringe into the bottom of the syringe valve. Finger-tighten
only.

l Carefully pull down the bottom of the syringe until it rests inside the hole in the
bracket.

l Pass a thumbscrew up through this hole and thread it into the bottom of the
syringe. Hold the syringe to prevent it from rotating while tightening the
thumbscrew. Finger-tighten only.

13. Locate the dispenser cable. Plug one end into the port on the back of the dispenser. Plug
the other end into the “Dispenser Port” on the left side of the reader.

14. Locate the injector tip-cleaning stylus, packaged in a small cylinder. Attach the cylinder
to the back of the dispenser for storage.

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



19 | Chapter 2: Installation

Perform a visual inspection or a Performance Qualification test after reconnecting the
tubes.

9: Connect the Host Computer
The Synergy Neo 2 is equipped with two communication ports: USB and Serial (RS-232).
Both ports are located on the left side of the reader.

l A USB cable is included in the accessories box; the RS-232 cable is available as an
optional accessory.

l Connect one end to the appropriate port on the reader and the other end to the
appropriate port on the host computer.

10: Install Gen5 on the Host Computer

The Synergy Neo 2 is controlled by Gen5 software running on a host computer. There is
a certain sequence of events thatmust be followed to ensure that the software is
properly installed and configured. Please follow the instructions provided with the
Gen5 to install the software and the USB Driver.

Before Installing Gen5

l Gen5 v3.11 and higher require Windows 10 (Professional edition, 64-bit).

l If you will use Gen5 Quick Export or PowerExport, Microsoft Excel 2010 through 2016
(32- or 64-bit edition) is required.

l You must have administrator privileges to install Gen5. Log in to Windows as
“Administrator” or consult your IT department for assistance

Procedure

1. Insert the Gen5 software USB flash drive into an available port on the computer. Using
File Explorer, navigate to the flash drive and locate the setup file.

2. Double-click setup and follow the instructions to install the software. Choose Typical
when prompted for the install type. Click Finish when prompted.

3. Enter the Gen5 Serial Number (located on the Gen5 storage case) when prompted, and
click Continue.
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11: Turn on the Reader

1. If Gen5 is open, close it now.

T-Models: Make sure the laser safety key is in its ON position.

2. The reader’s power switch is located on the lower-right corner of the front panel. Turn
the reader on. The reader performs a system test. When the test is completed, the
reader extends the microplate carrier.

The carrier eject button, located above the reader’s power switch, can be used to
extend/retract the microplate carrier.

When the reader is idle, the light on the carrier eject button is green. When the reader
is busy (when running an assay or a self-test) the light is red. If an error occurs, the light
is red and blinking.

12: Establish Communication

If using the USB cable, refer to the instructions that shipped with the USB Driver
Software on the Gen5 software media to install the necessary drivers.

1. Start Gen5 and log in if prompted. The default System Administrator password is admin.

2. Choose Standardmode in Gen5 v.3.06 and higher to complete instrument installation
and setup.Simple mode can be used to operate the reader.

3. From the Gen5 main screen, select System > Instrument Configuration and click Add
Reader.

4. Set the Reader Type to Synergy Neo 2, and click OK.

5. Perform one of the following steps:

l Select Plug & Play and click on the Reader Type you are using.

A Synergy Neo 2 must be connected via USB to the computer and turned on to
appear in the Available Plug & Play Readers list.

l Set the Com Port to the computer’s COM port to which the reader is connected.
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Com Port: When using the RS-232 cable you must define the COM port. With
either method, com port information can be found via the Windows Control
Panel, under Ports in the Hardware/Device Manager area of System Properties
(e.g., USB Serial Port (COM5)).

6. Click Test Communication. Gen5 attempts to communicate with the reader. If the
communication attempt is successful, return to Gen5’s main screen.

Communication Errors
If the communication attempt is not successful, try the following:

l Is the reader connected to the power supply and turned on?

l Is the communication cable firmly attached to both the reader and the computer?

l Did you select the correct Reader Type in Gen5?

l Did you install the USB driver software, if applicable?

l Was the reader allowed to fully complete its power-up self-test before initiating
communication with Gen5?

If you remain unable to get Gen5 and the reader to communicate with each other,
contact Technical Support .

13: Set Dispenser Calibration Values

Applies only to models equipped with injectors.

Before using the external dispense module with the Synergy Neo2, you must set its
calibration values in Gen5.

The calibration values for both dispensers (#1 and #2) are printed on labels affixed to
the rear of the dispense module. Each label lists six target calibration values (e.g., 200,
80, 40) with their actual measured values (e.g., 199.3, 79.7, 39.9). You will enter the
measured calibration values into Gen5.

1. If you have not already done so, power on the instrument, and establish
communication.

2. In Gen5, go to System > Instrument Configuration, select your instrument, and click
View/Modify.
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3. Click Setup, and then select the Dispenser 1 tab.

4. On the keyboard, press CTRL+SHIFT+M to enter maintenance mode for the Dispenser 1
window.

5. Enter the syringe calibration values from the corresponding label on the rear of the
dispenser box.

6. Click Send Volumes, and then click Get Volumes to verify that the entered values were
sent to the instrument.

7. Select the Dispenser 2 tab, and repeat steps 4 through 6 for Dispenser 2.

14: Run a System Test
Running a system test will confirm that the reader is set up and running properly, or will
provide an error code if a problem is detected.

"T" models: Make sure the laser safety key is installed and turned to ON; otherwise,
the self-test will fail.
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1. Turn on the incubator:

l Open the Instrument Control panel by
clicking the tab on the left border. At the top
of the Instrument Control panel, make sure
the correct instrument is selected (if you have
more than one instrument).

l Click Incubate and enter a Requested
temperature of at least 37°C and click On.

Wait until the incubator temperature
reaches the set point before continuing.

2. From Gen5's main view, select System >
Diagnostics > Run System Test. If prompted to
select a reader, select Synergy Neo 2 and click OK.

3. When the test is completed, a dialog requesting
additional information appears. Enter the
information and click OK.

If a message appears that a pending system test is waiting from the initial power-up
self-test, view the pending system test and repeat steps 2 and 3.

4. The results report appears. Near the top of the report in the Test Results area, the text
should read “SYSTEM TEST PASS.”

l You may wish to print the report and store it with your records. The report can
also be saved as a .txt file.

l Gen5 stores system test information in its database; you can retrieve it at any
time.

l Sign and date the report, and store it with your test documentation.
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If an error code is returned, refer to Appendix B and look up the code. If the
problem is something you can fix, do so now and run another system test. If the
problem is something you cannot fix, or if the test continues to fail, contact
Technical Support.

5. Turn off the incubator.

15: Test the Injector System

1. If necessary, press the carrier eject button to extend the microplate carrier.

2. Place the tip priming trough in the rear pocket of the carrier.

3. Place the priming plate on the carrier.

4. Fill the two reagent bottles with distilled or deionized water. Place the bottles in their
holders, and place the holders directly in front of the syringes. Insert the inlet tubes into
the bottles.

5. Select Prime/Dispense from the Instrument Control panel or from the Gen5 main
screen, select System > Instrument Control > Synergy Neo 2.

6. Click the Prime tab.

7. With Dispenser set to 1, set the Volume to 5000 µL and click Prime.
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The syringe should move down and up repeatedly, drawing fluid from the bottle. The
fluid should pump through the tubing and dispense into the priming plate. Examine
the fittings; no leaks should be detected. If leaks are detected, tighten all fittings and
repeat the prime. If leaks are still detected, contact Technical Support.

8. When the prime finishes, set Volume to 2000 µL and click Purge to clear the fluid lines.

9. Set Dispenser to 2 and repeat steps 7 and 8.

10. When finished, remove and empty the priming plate.

11. Return to the Gen5 main screen.

The installation and setup process is complete.

Operational/Performance Qualification
Your Synergy Neo 2 was fully tested prior to shipment and should operate properly
following the successful completion of the installation and setup procedures described in
this chapter.
If you suspect that problems occurred during shipment, if you received the reader back
following service or repair, or if regulatory requirements dictate that
Operational/Performance Qualification is necessary, refer to the Instrument Qualification
Process chapter.

A Product Qualification & Maintenance (IQ/OQ/PQ) package for the Synergy Neo 2 is
available for purchase (PN 1350526N).

Repackaging and Shipping Instructions

Important! Please read all of the information provided below
before preparing the Synergy Neo 2 for shipment.

l Contact Technical Support before returning equipment for service.

l Decontamination prior to shipment is required by the U.S. Department of
Transportation regulations.

l If the Synergy Neo 2 has been exposed to potentially hazardous material,
decontaminate it to minimize the risk to all who come in contact with the instrument
during shipping, handling, and servicing. TheMaintenance chapter contains
decontamination instructions.
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l Remove the microplate and tip prime trough (if equipped) from the carrier before
shipment. Spilled fluids can contaminate the optics and damage the instrument.

l Install the shipping hardware (see next section).

l The instrument’s packaging design is subject to change. If the instructions in this
document do not apply to the packaging materials you are using, contact Technical
Support for guidance.

l Be sure to use packaging materials supplied by the manufacturer. Other forms of
commercially available packaging are not recommended and can void the warranty.
You can order replacement shipping materials (PN 1033027 , except “T” models order
PN 1843002) if necessary. The shipping box, accessories box, foam caps, and so on are
included as a whole set under these part numbers and cannot be ordered separately.

l If you have misplaced the shipping hardware, order part number 1030009 which
includes the following items:

l Carrier shipping bracket [x1] (PN 1030539)

l Carrier shipping bracket screws [x2] (PN 1032190)

l Filter chamber shipping bracket [x3] (PN 1030527)

l T-Models: Set screw for switching block (PN 01735) and its yellow tag
(7091006)
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Replace the Shipping Hardware
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1. Open the carrier door and push the carrier into the reader about 2 inches.

2. Place the big plate carrier shipping bracket (without the hardware) in the read chamber
so that the two holes on the horizontal surface of the bracket slip over the two studs
sticking up from the read chamber floor.

3. Pull the carrier out toward the front of the instrument until it rests against the foam
piece on the sloped part of the shipping bracket.

4. Holding the carrier against the shipping bracket, place one of the screw brackets against
one of the holes at either end of the carrier bracket, so that the screw is pointing toward
the hole in the carrier shipping bracket.

5. Insert the screw so that it passes through both shipping brackets and catches the
threads in the carrier itself.

6. Repeats steps 4 and 5 to install the second screw bracket.

7. Remove all filter cubes from the instrument. Place them into plastic bags, and then
place them into the filter cube case.
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8. Install the top filter chamber shipping brackets using the inner mounting screws.

9. T-Models: Install the set screw and its yellow tag into the switching block.

10. If equipped, install the bottom filter chamber shipping bracket using the outer mounting
screw.

Repack the Instrument

1. Contact Technical Support for shipping instructions before returning equipment for
service.

2. Decontaminate the reader and, if attached, the dispense module, according to the
instructions provided in the As-Needed Maintenance chapter.

3. If you will also be shipping the dispense module, see Preparing the Dispenser for
Shipment on page 31.

If you are not shipping the dispenser, purge all fluids from the lines, and then
disconnect it from the reader.

4. Place the accessories in the accessories box, then seal the accessories box with tape.
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5. Place the instrument in the large plastic bag, then place it in the interior box,
surrounded by foam boards. Then, place the interior shipping box, surrounded by the
foam corners, into the external shipping box. Refer to the next figure.
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Preparing the Dispenser for Shipment

1. If you have not already done so, contact Technical Support for shipping instructions.

2. Decontaminate the dispenser according to the instructions in the As-Needed
Maintenance chapter. Be sure to purge the dispenser of all fluid when finished.

3. With the reader on, start Gen5 and select System > Instrument Control > Synergy Neo
2.

4. Perform this step twice, for both dispensers: Click the Prime tab and set the dispenser
number (1 or 2). ClickMaintenance. The syringe bracket lowers itself. Remove the
thumbscrew from underneath the bracket. Carefully unscrew the top of the syringe
from the syringe valve. Lift out the syringe and store it in its original box.

5. Fully detach the dispenser from the reader. (The screws are stored in the plastic bag
attached to the back of the dispenser.) Set the dispenser aside for the moment.

6. Remove the tip priming trough and store it in the dispenser accessories bag.
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7. Remove the two inlet tubes from the syringe valves and store them in their plastic
canisters.

8. Remove the two outlet tubes from the syringe valves. Attach the clear plastic shrouds to
the fittings of the outlet tubes. Place the tubes in a plastic bag.

9. Remove the front cover from the dispenser.

10. Insert the bottom foam end cap in the dispenser accessories shipping box and place the
accessories in the insert.

11. Insert the bottom foam end cap in the shipping box, and place the dispenser inside the
end cap.

12. Insert the foam insert that holds the reagent bottle holders and injector tubing into the
shipping box and place the bottle holders and tubing in it.

13. Slide the dispenser accessories box into the shipping box.

14. Insert the top foam end cap. Close and seal the outer box with tape.
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Chapter 3

Getting Started

This chapter describes some of the Synergy Neo 2's external and internal
components, and provides an introduction to using Gen5 software to
control the instrument.

Modular Design 35
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Recommendations for Optimum Performance 57
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Modular Design
The Synergy Neo 2 is a multi-mode microplate reader, with a design that allows you to
initially purchase only the detection capabilities you need and then upgrade later as your
requirements expand. Please contact BioTek to learn more about your upgrade options.
Gen5 software is used to control the reader. If the reader is connected and turned on,
Gen5 will present only those options that apply to your reader model. For example, if your
model is not equipped with the alpha detection system, alpha will not be available as a
detection method.
The module letters form the part number for each Synergy Neo 2 model, which is shown
on a label on the reader.

These configurations include dual top PMTs for fluorescence and luminescence (Lum).

Monochromator-based Filter-based
Alpha
laser

TRF
laserPart Number

UV-Vis
absorbance

top/bottom FI Lum
top

FI/FP/TRF
bottom
FI/FP/TRF

Lum

N2-SN • • •

N2M-SN • • • • •

N2MB-SN • • • • • •

N2MA-SN • • • • •  •

N2MAB-SN •  • • • •  • •

N2MT-SN • • • • • •

N2MAT-SN • • • • • • •

N2MABT-SN • • • • • • • •

N2MBT-SN • • • • • • •

N2T-SN • • • •

N2AT-SN • • • • •

N2ABT-SN • • • • • •
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These configurations include a single top PMT for fluorescence and luminescence.

Monochromator-based Filter-based
Alpha
laserPart

Number
UV-Vis

absorbance
top/bottom FI Lum

top
FI/FP/TRF

bottom
FI/FP/TRF

Lum

N2S-SN • • •

N2MON-SN • • •

N2SM-SN • • • • •

N2SMB-SN • • • • • •

N2SA-SN • • • •

N2SMA-SN • • • • •  •

N2SMAB-SN •  • • • •  • •
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External Components

1 Upper and lower top filter cubes access door

2 Light-blocking microplate carrier access door

3 Microplate carrier eject button

4 Power switch

5 Bottom filter cube access door (if equipped)

6 Entry port for the dispense outlet tubes and injectors (if equipped)

7 not shown -"T" models, TRF laser attached to back of instrument ( page 53)
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1: RS232 cable port

2: USB port

3: Dispenser port

4: Barcode reader cable port (with cover
installed)

5: Legend for gas controller ports

6: Mixing fan power port

7: Gas controller ports (with cover
installed)

8: Instrument power inlet

Note: TRF Laser is not shown.
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Internal Components

Component Description Page

Barcoded Filter
Cubes

The barcoded filter cubes contain excitation and emission filters,
mirrors, and polarizing filters. Preconfigured cubes are available
for purchase.

page 39

Shaking System The instrument supports six different shake rates from each of
three different shake types: linear, slow orbital, and fast orbital.

page 47

Injector System Optional dispense module accessory: Syringes and tubing may
require replacement over time. The tubing and injectors require
cleaning at regular intervals.

page 51

Alpha Laser A-models only: Equipped with an alpha laser for AlphaScreen,
Alpha LISA, and other assays.

page 53

TRF Laser T-models with TRF Laser only: Equipped with a 337 nm nitrogen
laser for TR-FRET/HTRF/TRF applications. Gen5 version 3.06 or
higher is required.

page 53

Filter Cubes
The Synergy Neo 2 is equipped with up to three filter cubes to perform filter-based
fluorescence (using xenon flash or TRF laser), luminescence, and alpha reads. Each cube
consists of excitation and emission filters, dichroic mirrors, polarizing filters, and/or unique
apertures. When placed into the instrument, the unique component information for each
cube is automatically identified via an internal barcode scanner.

Important: If two or more custom filter cubes (with ID 255) are configured in Gen5, it is
the customer's responsibility to install the correct filter cube when performing a read.

The top filter cubes are accessed through the hinged door on the front of the reader. The
bottom filter cube (if equipped) is accessed through a door on the left side of the reader.
See the photo under External Components on page 37.
Each filter cube is labeled with an ID number (e.g., "107" or "61") and a short description of
its contents and purpose (e.g., "360/460, 485/528" or "FP 485/530, LUM"). Each cube also
has a barcode label that represents this information.

Be careful not to scratch the surface of the barcode label (see below). If the label is
damaged, the Synergy Neo 2 may have trouble reading it correctly, requiring you to
manually enter the filter cube information in Gen5.
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Filter Cubes and Gen5

When the instrument reads a new filter cube barcode label, information such as cube
position type, filter and mirror specifications, and PMT location is passed to Gen5.
You can view the filter cube's ID number by selecting System > Information Configuration
> Synergy Neo > View/Modify > Setup. If a location shows "?", either no filter cube is
installed or the system could not read the barcode label. You can manually enter the filter
cube ID number using the Override feature.
You can use the Gen5 Filter Cube Library (System > Optics Library > Filter Cubes) to define
all cubes that you have available at your site and to import filter cube definitions, if
necessary. Read step options in a protocol or experiment will be available for selection
based on the filter cubes that you identify as being "On Site."
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Gen5 also uses the filter cube information to prompt for filter cube installation at runtime,
if necessary.
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Installing or Removing a Filter Cube

Filter cubes can be installed or removed when the instrument is turned on or off, with one
exception:

Do not open the filter cube access doors while a plate is being read (unless Gen5
prompts you to install a particular filter cube). Doing so may affect measurements and
result in invalid data.

Open the top or side access door, as appropriate. Gently slide the filter cube into (or out
of) its chamber, and then close the door. The barcode label will be scanned upon door
closure.

Cleaning Filter Cubes

Do not disassemble filter cubes.

Refer to Inspect/Clean Filter Cubes in Periodic Maintenance.

Filter Cubes Available for Purchase

Preconfigured barcoded filter cubes are available for purchase. Custom filter cubes are also
available. Contact BioTek with any questions.

Custom Filter Cubes

Custom barcoded filter cubes are assembled at BioTek. The information in this section
is for reference purposes.

Custom barcoded filter cubes support single PMT measurements. For dual
simultaneous-measurement filter cubes (e.g., FP, TR-FRET), please contact BioTek.

The Synergy Neo 2 supports the use of custom filter cubes. Each custom cube has the same
ID: 255. It is the user's responsibility to ensure that the correct custom filter cube is
installed before performing a read.
The following drawings shows the orientation of the filters inside the cubes.
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Fluorescence Intensity Filter Cube: Use Position 1 or 2

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



Internal Components | 44

TRF Filter Cube: Use Position 1 or 2
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FP Filter Cube: Use both Positions 1 and 2
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Luminescence Filter Cube: Use Position 1 or 2
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Creating or Modifying Custom Barcoded Filter Cubes in Gen5

Each custom filter cube has the same barcode ID: "255." You must enter the custom filter
cube's information in Gen5.

If you define two or more filter cubes with ID 255, it is your responsibility to install the
correct filter cube when performing a read. To facilitate this, it is recommended to
match the Cube name field in Gen5 with the name you write on the cube's label.

To create a new cube:

1. Click System > Optics Library > Filter Cubes > Create Cube.

2. Enter a unique Cube Name.

3. Select the detection type for Position 1 (away from the cube's handle), and then click
Edit.

4. Define information as applicable to the selected detection type. Click Help for
assistance. Click OK with finished.

5. Repeat steps 3 and 4 for Position 2 (closest to the cube's handle), if used.

To modify an existing cube:

1. Click System > Optics Library > Filter Cubes.

2. Select the desired cube and clickModify Cube.

3. Edit information as necessary.

Shaking System
The user can choose six different shake rates from each of three different shake types:
linear, slow orbital, and fast orbital. Each shake rate corresponds to a specific carrier
displacement for one or both axes, ranging from 1 mm to 6 mm. A linear shake simply
moves the carrier's y-axis back and forth in a line, whereas an orbital shake moves both
carrier axes to scribe a circle. Each orbital type may also be selected in a double format, in
which the carrier scribes a figure-eight pattern instead.

Carrier Shake Definitions

Shake
Type

Displacement
(mm/steps)

Period
(msecs)

Frequency
(Hz)

RPM
Ramp
Profile

Linear 1/6 54.8 18.3 1096 13
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Shake
Type

Displacement
(mm/steps)

Period
(msecs)

Frequency
(Hz)

RPM
Ramp
Profile

2/12 82.0 12.2 731 14

3/18 105.8 9.5 567 15

4/24 121.6 8.2 493 16

5/30 146.3 6.8 410 17

6/36 166.9 6.0 360 18

Slow
orbital

1/6 107.3 9.3 559 19

2/12 164.4 6.1 365 20

3/18 212.5 4.7 282 21

4/24 253.5 3.9 237 22

5/30 292.1 3.4 205 23

6/36 334.2 3.0 180 24

Fast
orbital

1/6 74.3 13.4 807 25

2/12 109.6 9.1 548 26

3/18 141.3 7.1 425 27

4/24 169.0 5.9 355 28

5/30 195.4 5.1 307 29

6/36 222.8 4.5 269 30

Each shake consists of a series of repeated ramped moves for one or both carrier axes. The
sinusoidally defined ramps are used for acceleration and deceleration only; the plateau
section of the ramp is skipped. When an axis reaches the end of the ramp profile, it simply
repeats the ramp in the opposite direction (except for double-orbital shakes, where the y-
axis repeats a ramp twice before changing directions).
The circular pattern of the orbital shake is achieved by starting the carrier's y-axis move
sequence first. When that axis reaches peak speed at the top of its ramp, the carrier's x-
axis begins its own series of repeated moves using the same profile. The axes remain in
synch but out of phase, with the maximum speed of one always coinciding with the
minimum speed of the other, until the specified shake time has expired.
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Maximum Shaking Amplitude Based on Assay Volume and Plate Type

The Synergy Neo 2 offers a broad range of shaking speeds and amplitudes. If the wells of a
microplate are almost full, shaking can result in spillage inside the instrument. The
following table is designed to help avoid this issue. Select your microplate type and assay
volume, and you will get the acceptable shake amplitude on your instrument.

Sample Volume Linear Orbital Slow Orbital Fast Double Orbital Slow Double Orbital Fast

6-well Microplate

0–3 mL 1–6 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm

3–4 mL 1–6 mm 1–6 mm 1–6 mm 1–6 mm 1 mm

4–5 mL 1 mm 1–6 mm 1–6 mm 1–6 mm 1 mm

5–7 mL 1 mm 1–6 mm 1–3 mm 1 mm No

7–8 mL 1 mm No 1–3 mm No No

9 mL 1 mm No No No No

Sample Volume Linear Orbital Slow Orbital Fast Double Orbital Slow Double Orbital Fast

12-well Microplate

0–1.5 mL 1–6 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm

1.5–2.5 mL 1–2 mm 1–6 mm 1–6 mm 1–6 mm 1 mm

2.5–3 mL 1–2 mm 1–6 mm No No 1 mm

3–4 mL No 1–6 mm No No No

Sample Volume Linear Orbital Slow Orbital Fast Double Orbital Slow Double Orbital Fast

24-well Microplate

0–0.75 mL 1–6 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm

0.75–1 mL 1 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm

1–1.5 mL 1 mm 1–6 mm 1–6 mm 1–6 mm No

1.5–2 mL 1 mm 1–6 mm No 1–6 mm No
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Sample Volume Linear
Orbital
Slow

Orbital
Fast

Double
Orbital Slow

Double
Orbital Fast

48-well Microplate

0–0.5 mL 1–6 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm

0.5–1 mL 1 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm

1–1.3 mL No 1–6 mm 1–6 mm 1–6 mm No

Sample Volume Linear Orbital Slow Orbital Fast Double Orbital Slow Double Orbital Fast

96-well Microplate

0–0.25 mL 1–6 mm 1–6 mm 1–6 mm 1–6 mm 1–6 mm
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Injector System

The tubing and injectors should be cleaned at least every three months. See Periodic
Maintenance, for instructions.

Inspect the injector system daily for leaks, preferably immediately after priming and
whenever tubing changes have been made.

If a syringe is leaking, it may need to be replaced. See As Needed Maintenance, for
instructions.

Dispense Module

The dispense module sits on top of the reader and pumps fluid from the reagent bottles to
the injectors located inside the instrument. Fluid is injected into one well at a time. The
injectors support plate types from 6- to 384-wells.

1 Two 250 µL syringes draw fluid from the supply bottles.

2 Inlet tubes transport fluid from the supply bottles to the syringes.
These tubes are short pieces of opaque PTFE (Teflon) tubing
connected to stainless-steel probes on one end and threaded
fittings on the other end.
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3 Solenoid valves allow the fluid drawn from the supply bottles by
the syringe pumps to flow into the outlet tubes.

4 Outlet tubes transport fluid from the syringes into the
instrument, through the tubing ports on the Synergy Neo 2's top
cover. The outlet tubes are opaque PTFE tubes with threaded
fittings on each end.

Avoid continuous contact with harsh chemicals. Rinse the fluid path with deionized
water after contact with any strong acid, base, or solvent.

See the Periodic Maintenance chapter for cleaning instructions.

Priming the Injector System

Before running a dispense assay, prime the system with the reagent or dispensing fluid. In
addition, tip priming can be performed at the start of an assay and, sometimes, just before
each dispense to a well. The tip prime compensates for any fluid loss at the injector tip due
to evaporation since the last dispense. All priming activities are controlled via Gen5.

If the injector system is not primed adequately, air bubbles can get trapped in the
system and affect injection volumes. Air bubbles in the system can also result in fluid
spraying or scattering inside the reader.

Both types of primes require a fluid reservoir to be present on the microplate carrier.

l The priming plate is placed on the microplate carrier for a Prime operation (to prime
the dispense system with fluid).

l The tip priming trough is placed in the rear pocket of the carrier, and is used for
performing the Tip Prime before dispensing. The trough holds up to 1.5 mL of liquid
and must be periodically emptied and cleaned by the user.

Do not perform tip priming when using tall plates. Generally, plates with fewer than
96 wells are too tall for error-free tip priming; and, tip priming is rarely required for
these larger-volume plates.

The priming tray should be empty before priming and should contain fluid after
priming.
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Alpha Laser

Class 1 Laser Product. Alpha laser “A” and TRF laser “T” models

See"Report on laser safety" on page xi.

"A"-model instruments are equipped with an alpha laser to support Laser Alpha LISA,
AlphaScreen® SureFire and similar applications.

Light source 100 mW, 680 nm laser

Detector PMT

Wavelength selection Filters (top)

Read speed 96 well: 30 seconds
384 well: 1 minute 50 seconds
1536 well: 7 minutes 20 seconds

TRF Laser

Class 1 Laser Product. Alpha laser “A” and TRF laser “T” models

See"Report on laser safety" on page xi.

“T” models provide a 337 nm nitrogen laser for TR-FRET/HTRF/TRF applications. Gen5
version 3.06 or higher is required. The TRF laser in enhanced sweep mode is more sensitive
than the Xenon flash lamp.

384-Well Plates Xenon Flash TRF Laser

Detection limit 40 fM 5 fM
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Dedicated barcoded filter cubes are required:

PN Description Barcode # Label Notes

1035018 Cube 18 EX 337
dual PMT

018 TRF Laser:
EX 377

For running dual PMT TRF
laser assay, e.g. HTRF

1035126 Cube 126
337/620 LUM
ASBY

126 337/620:
LUM

For running Eu testing
during instrument
qualification

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



55 | Chapter 3: Getting Started

Gen5 Software
BioTek Gen5 software supports all Synergy Neo 2 reader models.

Note: “T”-models with TRF Laser and “M”-models with dedicated broadband
luminescence fiber require Gen5 version 3.06 or higher.

Use Gen5 to control the reader, the dispense module (if equipped), and the stacker (if
equipped); perform data reduction and analysis on the measurement values; print or
export results; and more. This section provides brief instructions for working with Gen5 to
create protocols and experiments and read plates in Standard Mode for versions 3.06 and
higher. Refer to the Gen5 Help system for more information.

Simple mode can be used after instrument
installation is completed. Simple mode is a basic
workflow designed for faster set up and execution
of experiments; it limits user choices and guides
users toward success using interactive dialogs.

Protocols and Experiments
In Gen5, a protocol contains instructions for controlling the reader and (optionally)
instructions for analyzing and reporting or exporting the data retrieved from the reader. At
a minimum, a protocol must specify the procedure for the assay you wish to run. After
creating a protocol, create an experiment that references the protocol. You’ll run the
experiment to read plates and analyze the data.
These instructions briefly describe how to create a protocol in Gen5. See the Gen5 Help
system for complete instructions.

1. Create a new protocol.

2. Open the Procedure dialog. If prompted to select a reader, select the Synergy Neo 2 and
click OK.

3. Select a Plate Type.

The Plate Type selected in Gen5 must match the assay plate. Otherwise, the results of
the read may be invalid. Also, a collision may result with the transport system because
of differing plate dimensions. Be sure to select the Use lid check box, if applicable.

4. Add steps to the procedure for shaking or heating the plate, dispensing fluid, reading
the plate, and more. Click Validate to verify that the reader supports the defined steps,
and then click OK.
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Optionally, perform the next steps to analyze and report the results:

5. Open the Plate Layout dialog and assign blanks, samples, controls, and/or standards to
the plate.

6. Open the Data Reduction dialog to add data reduction steps. Categories include
Transformation, Well Analysis, Curve Analysis, and Qualitative Analysis/QC.

7. Create a report or export template via the Report/Export Builders.

8. Select File > Save and give the file an identifying name.

These instructions briefly describe how to create an experiment and then read a plate in
Gen5. See the Gen5 Help system for complete instructions.

1. Create a new experiment using an existing protocol.

2. Select the desired protocol and click OK.

3. Select a plate in the menu tree and read it.

4. When the read is complete, measurement values appear in Gen5. Select the desired
data set from the Data list.

5. Select File > Save and give the file an identifying name.

Dispense Module Control

This section applies only to models with injectors.

Gen5 is used to perform several dispense functions, such as initialize, dispense, prime, and
purge. The Prime and Purge functions are introduced here. See the Gen5 Help system for
more information.

Priming routines are used to fill the dispense tubing with fluid so that air is not
dispensed first, resulting in an incorrect dispense volume. The purging routines are
used to clean the fluid paths. See also Flushing/Purging the Fluid Path in the Periodic
Maintenance chapter.

Prime

Before running an experiment with a dispense step, prime the system with the fluid to be
used.
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1. Place the priming plate on the carrier.

2. Fill the supply bottle with a sufficient volume of the fluid to be used for the prime and
the assay. Insert the appropriate inlet tube into the bottle.

3. In Gen5, select System > Instrument Control > Synergy Neo 2 and click the Prime tab.

4. Select the Dispenser number (1 or 2) associated with the supply bottle.

5. Enter the Volume to be used for the prime. The minimum recommended prime volume
is 2000 µL.

6. Select a prime Rate, in µL/second.

7. Click Prime to start the process.

8. When finished, carefully remove the priming plate from the carrier and empty it.

If the priming plate is empty, the prime volume was too low or there is a problem with
the dispense system.

Purge

To save reagent, Gen5 provides the option to purge fluid from the dispense tubing back
into the supply bottle.

1. In Gen5, select System > Instrument Control > Synergy Neo 2 and click the Prime tab.

2. Select the Dispenser number (1 or 2) associated with the supply bottle.

3. Enter the desired purge Volume in µL (e.g., 2000).

4. Select a prime Rate in µL/second.

5. Click Purge to start the process.

Recommendations for Optimum Performance

General

l Microplates should be clean and free from dust or bottom scratches. Use new
microplates from sealed packages. Do not allow dust to settle on the surface of the
solution; use microplate covers or seals when not reading the plate. If reading plates
with covers still installed, do not forget to compensate for this. See the Gen5 Help.

l Filter solutions to remove particulates that could cause erroneous readings.
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l Although the Synergy Neo 2 supports standard flat, U-bottom, and V-bottom
microplates, the reader achieves optimum performance with flat-bottomed wells
when running in Absorbance mode. See Appendix A, Specifications for more
information on the supported plates.

l Non-uniformity in the optical density of the well bottoms can cause loss of accuracy,
especially with U- and V-bottom polyvinyl microplates. Check for this by reading an
empty microplate. Dual wavelength readings can eliminate this problem, or bring the
variation in density readings to within acceptable limits for most measurements.

l Inaccuracy in pipetting has a large effect on measurements, especially if smaller
volumes of liquid are used. For best results in most cases, use at least 100 µL per well
in a 96-well plate and 25 µL in a 384-well plate.

l Pipetting solution into 384-well plates often traps air bubbles in the wells, which may
result in inaccurate readings. A dual-wavelength reading method usually eliminates
these inaccuracies. For best results, however, remove the air bubbles by degassing
the plate in a vacuum chamber or spinning the plate in a centrifuge before reading.

l The inclination of the meniscus can cause loss of accuracy in some solutions,
especially with small volumes. Shake the microplate before reading to help bring it
within acceptable limits. Use Tween 20, if possible (or some other wetting agent) to
normalize the meniscus for absorbance measurements. Some solutions develop
menisci over a period of several minutes. This effect varies with the brand of
microplate and the solution composition. As the center of the meniscus drops and
shortens the light path, the density readings change. The meniscus shape will stabilize
over time.

l It is the user’s responsibility to understand the volumetric limits of the plate type in
use as it applies to the assay being run.

l Use UV transparent microplates for UV wavelength reads.

l Use of liquids with concentrations of acids, corrosives, or solvents of 3 percent and
greater can begin attacking the materials inside the instrument's chamber. Running
multiple plates with concentrations < 3% in long kinetics may also have a destructive
effect. If the experiment is incubated, it will accelerate the deterioration of chamber
components. When in doubt about the use of acids, corrosives, or solvents, please
contact Technical Support.
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Dimethyl sulfoxide (DMSO) vapor can create a removable deposit on optical
surfaces, which can trigger instrument self-test errors. Using DMSO assay
concentrations of 2% or below is recommended. Limit long exposure in kinetic
assays or incubated assays when possible. For questions about the use of
DMSO, contact Technical Support.

Read Direction
The Synergy Neo 2 performs most reads in a column-wise direction, that is, moving from
well A1, to B1, then C1, and so on. The exception to this is for reads that use sweep speed
and random well reads, which are read in a row-wise fashion.

Luminescence Measurements
For highly sensitive luminescence assays using white plates, add a Delay step to your
procedure to "dark adapt" the plates in the Synergy Neo 2's reading chamber before taking
measurements.

Monochromator-Based Fluorescence Systems
Although Time-Resolved Fluorescence can be performed with the monochromator, the
filter-based fluorescence system is more sensitive for TRF and is the better choice.

Models with Injectors

l To keep the dispense system in top condition, flush and purge the fluid lines with
deionized (DI) water every day or upon completion of an assay run, whichever is more
frequent. Some reagents may crystallize or harden after use, clogging the fluid
passageways. Flushing the tubing at the end of each day, letting the DI water soak,
and then purging the lines at the beginning of each day ensures optimal performance
of the dispense system. See the Periodic Maintenance chapter for more information.

l When dispensing volumes less than or equal to 20 µL/well, we recommend specifying
a tip prime volume that is equal to the dispense volume. For dispense volumes
greater than 20 µL/well, we recommend a tip prime volume of 20 µL.

l To avoid spillage and possible contamination of the instrument, empty the tip prime
trough frequently and do not exceed the total fluid volume of the plate well when
dispensing.
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Using 384-Well Microplates
When using a 384-well microplate, you can use the Gen5 Auto Map feature to ensure you
are using an accurate plate map for your reads. See the Gen5 Help for more information.

Incubation and Partial Plates
When performing a partial plate read that includes an incubation step, the following
recommendations can reduce the effects of evaporation of your samples:

l Use microplate lids.

l Fill unused wells with fluid.

l Cluster your sample wells rather than spacing them throughout the plate.

l Place your sample wells in the center of the plate. This placement may lead to less
evaporation than if you place the samples in wells on the edge of the plate.

Alpha Laser Detection
When using alpha detection, ensure that the relative humidity remains below 85% and the
ambient temperature is less than 30°C.
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This chapter provides instructions for maintaining the Synergy Neo 2 and
external dispense module (if used) in top condition, to ensure that they
continue to perform to specification.

Periodic Maintenance Overview 62
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Warnings and Precautions 63
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Inspect/Clean Filter Cubes 65

Flush/Purge the Fluid Path 65

Run a Dispense Protocol (Optional) 67

Empty/Clean the Tip Priming Trough 68

Clean the Priming Plate 68

Clean the Dispense Tubes and Injectors 68
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Periodic Maintenance Overview
A general maintenance regimen for all Synergy Neo 2 models includes periodically cleaning
all exposed surfaces and, except for NEO2MON models, inspecting, and if necessary,
cleaning the filter cubes.
For models with the external dispense module, additional tasks include flushing/purging
the fluid path and cleaning the tip prime trough, priming plate, supply bottles, dispense
tubing, and injectors.

Daily Cleaning for the Dispense Module
To ensure accurate performance and a long life for the dispense module and injectors,
flush and purge the fluid lines with deionized (DI) water every day or after completing an
assay run, whichever is more frequent. Some reagents may crystallize or harden after use
and clog the fluid passageways. Take special care when using molecules that are active at
very low concentrations (e.g., enzymes, inhibitors). Remove any residual reagent in the
dispense lines using a suitable cleaning solution (review the reagent’s package insert for
specific recommendations).
Flushing the tubing at the end of each day, letting the DI water soak overnight, and then
purging the lines at the beginning of each day ensures optimal performance of the
dispense system. BioTek recommends performing a visual inspection of the dispense
accuracy before running an assay protocol that includes dispense steps.
BioTek also recommends flushing the module with DI water before conducting the
decontamination procedure described in the As Needed Maintenance chapter.

Models with injectors: Accumulated algae, fungi, or mold may require
decontamination. See the As-Needed Maintenance chapter for complete
decontamination instructions.

Recommended Maintenance Schedule
This table recommends maintenance tasks and the frequency with which each task should
be performed.

The risk and performance factors associated with your assays may require that some of
all of the maintenance procedures be performed more frequently than shown here.
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Task Daily Quarterly As Needed

All models:

PM-1 Clean exposed surfaces ü

PM-2 Inspect/clean filter cubes* ü

Decontamination before shipment or storage

Models with injectors:

PM-3 Flush/purge the fluid path ü

PM-4 (Optional) Run Dispense protocol ü

PM-5 Empty/clean tip prime trough ü

PM-6 Clean priming plate ü

* except NEO2MON models

Warnings and Precautions
Read the following before performing any maintenance procedures:

Internal Voltage. Always turn off the power switch and
unplug the power supply before cleaning the outer surface
of the instrument.

Liquids. Avoid spilling liquids on the instrument; fluid
seepage into internal components creates a potential for
shock hazard or instrument damage. If a spill occurs while a
program is running, stop the program and turn off the
instrument. Wipe up all spills immediately. Do not operate
the instrument if internal components have been exposed to
fluid.

Liquids. Do not immerse the instrument, spray it with liquid,
or use a dripping-wet cloth on it. Do not allow water or other
cleaning solution to run into the interior of the instrument. If
this happens, contact Technical Support.

Lubricants. Do not apply lubricants to moving parts.
Lubricant on components in the carrier compartment will
attract dust and other particles, which may cause the
instrument to produce an error.
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Potential Biohazards.Wear protective gloves when handling
contaminated instruments. Gloved hands should be
considered contaminated at all times; keep gloved hands
away from eyes, mouth, nose, and ears.

Mucous membranes are considered prime entry routes for
infectious agents. Wear eye protection and a surgical mask
when there is a possibility of aerosol contamination. Intact
skin is generally considered an effective barrier against
infectious organisms; however, small abrasions and cuts may
not always be visible. Wear protective gloves when handling
contaminated instruments.

The instrument with all available modules weighs
approximately 100 lbs. (45.36 kg). Use two people when
lifting and carrying the instrument.

Clean Exposed Surfaces
Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened (not
soaked) with water or water and a mild detergent. You’ll need:

l Deionized or distilled water

l Clean, lint-free cotton cloths

l Mild detergent (optional)

1. Turn off and unplug the instrument.

2. Moisten a clean cotton cloth with water, or with water and mild detergent, then
thoroughly wring it out so that liquid does not drip from it. Do not soak the cloth.

3. Wipe the plate carrier and all exposed surfaces of the instrument.

4. Wipe all exposed surfaces of the dispense module (if used).

5. If detergent was used, wipe all surfaces with a cloth moistened with water.

6. Use a clean, dry cloth to dry all wet surfaces.

Models with injectors: If the Tip Priming Trough overflows or other spills occur inside
the instrument, wipe the carrier and the surface beneath the carrier with a dry cotton
cloth. The internal chamber and probes are not customer-accessible. If overflow is
significant, contact Technical Support with any questions about your particular model.
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Inspect/Clean Filter Cubes

* except NEO2MON-N models

Ambient laboratory air is used to cool the flash bulb, and the filter cubes can become dusty
as a result. Filters should be inspected and cleaned at least every three months. You’ll
need:

l Isopropyl, ethyl, or methyl alcohol

l 100% pure cotton balls or high-quality lens-cleaning tissue

l Cloth gloves

l Magnifying glass

Do not touch the filters with your bare fingers!

1. Open the access door on the front of the instrument, and the side door, if equipped
with a bottom filter cube. Slide the filter cubes out of their compartments.

2. Inspect the glass filters for speckled surfaces or a “halo” effect. This may indicate
deterioration due to moisture exposure over a long period of time.

If you have any concerns about the quality of the filters, contact Technical Support.

3. Using cotton balls or lens-cleaning tissue moistened with a small amount of high-quality
alcohol, clean each filter by lightly stroking its surface in one direction.

4. Use a magnifying glass to inspect the surface; remove any loose threads left from the
cotton ball.

5. Replace the filter cubes and close the door.

Flush/Purge the Fluid Path

Applies only to Synergy Neo 2 models with injectors.

At the end of each day that the dispense module is in use, flush the fluid path using the
Gen5 priming utility. Leave the fluid to soak overnight or over a weekend, and then purge
the fluid before using the instrument again.
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This flushing and purging routine is also recommended before disconnecting the outlet
tubes from the reader to prevent a spill. It is required before decontamination to
remove any assay residue prior to applying isopropyl alcohol or sodium hypochlorite.

To flush the fluid path:

1. Fill two supply bottles with deionized or distilled water. Insert the supply (inlet) tubes
into the bottles.

2. Place the priming plate on the carrier.

3. Select Prime/Dispense from the Instrument Control panel or from the Gen5 main
screen, select System > Instrument Control > Synergy Neo 2.

4. Click the Prime tab and select Dispenser 1.

5. Set the Volume to 5000 µL. Keep the default prime rate.

6. Click Prime to start the process. When the process is complete, carefully remove the
priming plate from the carrier and empty it.

7. Repeat the process for Dispenser 2.

Leave the water in the system overnight or until the instrument will be used again. Purge
the fluid from the system (see below) and then prime with the dispense reagent before
running an assay.
To purge the fluid from the system:

1. Place the inlet tubes in empty supply bottles or a beaker.

2. Select Prime/Dispense from the Instrument Control panel or from the main menu
System > Instrument Control > Synergy Neo 2.

3. Click the Prime tab and select Dispenser 1.

4. Set the Volume to 2000 µL.

5. Click Purge to start the process.

6. When the purge is complete, repeat the process for Dispenser 2.

After purging the system, you may wish to run a quick Dispense protocol to visually
verify the dispense accuracy (see below) or the more thorough Dispense Accuracy and
Precision Tests (see Instrument Qualification).
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Run a Dispense Protocol (Optional)

Applies only to Synergy Neo 2 models with injectors.

After flushing/purging the system and before running an assay that requires dispense,
visually verify the dispense function.

1. Create a Dispense protocol in Gen5:

a. Create a new protocol with the plate type set to match the plate you will use.

b. Add a Dispense step with the following parameters:

l Select Dispenser 1.

l Set Tip Priming to Before this dispense step and Volume to 10 µL.

l Set the Dispense Volume to 100 µL (or an amount to match your assay
protocol).

l Adjust the Rate to support the dispensing volume.

l Click OK to close the dialog and add the Dispense step to the procedure.

c. Add another Dispense step with the same parameters; select Dispenser 2.

d. Add a Read step with the following parameters (Gen5 requires a Read step in a
Dispense protocol):

l Select any Detection Method.

l Set the Read Type to Endpoint.

l Click Full Plate, click Clear All, then select well A1. Click OK.

l Select any wavelength or define one Filter Set.

l Click OK to close the dialog and add the Read step to the procedure.

e. Click OK to close the procedure.

f. Select File > Save and give the protocol an identifying name, such as “Dispense
Observation.”

2. Fill the reagent bottles with a DI water–Tween solution (e.g., add 1 mL Tween 20 to
1000 mL of deionized water).

3. Create a new experiment using the "Dispense Observation" protocol.

4. Click Read and follow the prompts.
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5. When the procedure is complete, visually assess the fluid level in the wells for accuracy.
If the well volume appears to be unevenly distributed, clean the internal dispense tubes
and injectors.

Empty/Clean the Tip Priming Trough

Applies only to Synergy Neo 2 models with injectors.

The tip priming trough is a removable cup located in the rear pocket of the microplate
carrier, used for performing the Tip Prime. The trough holds about 1.5 mL of liquid and
must be periodically emptied and cleaned by the user. Gen5 will instruct you to do this at
the start of an experiment that requires dispensing.

1. Extend the microplate carrier and carefully remove the tip priming trough from the
carrier.

2. Wash the trough in hot, soapy water. Use a small brush to clean in the corners.

3. Rinse the trough thoroughly and allow it to dry completely.

4. Replace the trough in the microplate carrier.

Clean the Priming Plate

Applies only to Synergy Neo 2 models with injectors.

Clean the priming plate regularly to prevent bacteria growth and residue buildup. Wash the
plate in hot, soapy water, using a small brush to clean in the corners. Rinse thoroughly and
allow it to dry completely.

Clean the Dispense Tubes and Injectors

Applies only to Synergy Neo 2 models with injectors.

The Synergy Neo 2’s dispense tubes and injectors require routine cleaning, at least
quarterly and possibly more frequently depending on the type of fluids dispensed.

Required Materials

l Protective gloves

l Safety glasses

l Mild detergent
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l Clean, lint-free cotton cloths

l Deionized or distilled water

l Stylus (stored in a plastic cylinder affixed to the rear of the dispense module or
reader) (PN 2872304)

Remove the Dispense Tubes and Injector Holders

1. Open the door on the front of the reader.

2. Grasp the injector tip holder by the tab and pull it up out of its socket.

3. Using your fingers, remove the thumbscrews securing the light shield to the top of the
reader and slide the shield up the outlets tubes.

4. Slide the injector tip holder through the hole in the top of the reader.

5. Turn each tube’s thumbscrew counterclockwise and gently pull each tube from its
injector tip.

6. On the dispense module, turn each outlet tube’s thumbscrew counterclockwise to
disconnect it from the injector.

Clean the Dispense Tubes and Injectors
Some reagents can crystallize and clog the tubing and injectors. Daily flushing and purging
can help to prevent this, but more rigorous cleaning may be necessary if reagent has dried
in the tubing or injectors.
To clean the dispense tubes, soak them in hot, soapy water to soften and dissolve any
hardened particles. Flush each tube by holding it vertically under a stream of water.

To clean the injectors:

1. Gently insert the stylus into each injector tip to clear any blockages. (The stylus is stored
in a plastic cylinder affixed to the rear of the dispense module.)

2. Stream water through the pipe to be sure it is clean. If the water does not stream out,
try soaking in hot, soapy water and then reinserting the stylus.

Be careful not to bend the injector tips. A bent tip might not dispense accurately.
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This chapter contains maintenance and component-replacement
procedures that need to be performed only occasionally.

Decontamination 71

Procedure for Models without a Dispenser 72

Procedure for Models with a Dispenser 73

Dispenser Syringe Replacement 76
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Decontamination

l The Synergy Neo 2 requires decontamination prior to shipping, storage, and disposal.

l Decontamination is required by the U.S. Department of Transportation regulations.

l Persons performing the decontamination process must be familiar with the basic
setup and operation of the instrument.

l BioTek recommends the use of the following decontamination solutions and methods
based on our knowledge of the instrument and recommendations of the Centers for
Disease Control and Prevention (CDC). Neither BioTek nor the CDC assumes any
liability for the adequacy of these solutions and methods. Each laboratory must
ensure that decontamination procedures are adequate for the biohazard(s) they
handle.

Internal Voltage. Always turn off the power switch and unplug the power
supply before cleaning the outer surface of the instrument.

The sodium hypochlorite (NaClO) solution is caustic; wear gloves and eye
protection when handling the solution.

Do not immerse the instrument, spray it with liquid, or use a dripping-wet
cloth. Do not allow the cleaning solution to run into the interior of the
instrument. If this happens, contact Technical Support.
Wear prophylactic gloves when handling contaminated instruments. Gloved
hands should be considered contaminated at all times; keep gloved hands away
from eyes, mouth, and nose. Eating and drinking while decontaminating
instruments is not advised.

Mucous membranes are considered prime entry routes for infectious agents.
Wear eye protection and a surgical mask when there is a possibility of aerosol
contamination. Intact skin is generally considered an effective barrier against
infectious organisms; however, small abrasions and cuts may not always be
visible. Wear protective gloves when performing the decontamination
procedure.

Required Materials
For all Synergy Neo 2 models:

l Sodium hypochlorite (NaClO, or bleach)

l 70% isopropyl alcohol (as an alternative to bleach)

l Deionized or distilled water

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



Procedure for Models without a Dispenser | 72

l Safety glasses

l Surgical mask

l Protective gloves

l Lab coat

l Biohazard trash bags

l 125-mL beakers

l Clean, lint-free cotton cloths

Additional materials for models with the dispense module:

l Phillips screwdriver

l Small brush for cleaning the tip priming trough and priming plate

l (Optional) Mild detergent

Procedure for Models without a Dispenser

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects of
bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the solution you are using. Commercial products are
typically 10.0% NaClO; prepare a 1:20 dilution. Household products are typically 5.0%
NaClO; prepare a 1:10 dilution.

3. Wet a cloth with the NaClO solution or alcohol, then thoroughly wring it out so that
liquid does not drip from it. Do not soak the cloth.

4. Open the plate carrier door and slide out the plate carrier.

5. Wipe the plate carrier and all exposed surfaces of the instrument.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces of the instrument that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.
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9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Procedure for Models with a Dispenser

Perform the Routine Procedure when the Synergy Neo 2 is functioning normally. If you
are unable to perform a prime due to a system failure, perform the Alternate
Procedure described on page 76.

Routine Procedure

If disinfecting with sodium hypochlorite (NaClO), be sure to flush repeatedly with
deionized water to remove the NaClO. After disinfecting with sodium hypochlorite,
perform the rinse procedure provided on page 74.

If disinfecting with alcohol, do not immediately prime with deionized water, because
the drying effect of the alcohol is an important aspect of its disinfectant properties.

Clean Exposed Surfaces

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects of
bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the solution you are using. Commercial products are
typically 10.0% NaClO; prepare a 1:20 dilution. Household products are typically 5.0%
NaClO; prepare a 1:10 dilution.

3. Open the plate carrier door and slide out the plate carrier.

4. Wet a cloth with the bleach solution or alcohol, then thoroughly wring it out so that
liquid does not drip from it. Do not soak the cloth.

5. Wipe the plate carrier and the exposed surfaces of the dispenser.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.
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8. If the dispenser is installed, purge any fluid (see Flush/Purge the Fluid Path on page 65)
and detach the outlet tubes from the instrument. If it is not installed, attach only the
dispenser’s communication cable to the instrument. Remove the supply bottles and
their holders.

9. Perform the decontamination procedures described below through page 75.

Decontaminate the Fluid Lines

1. Place a beaker with 20 mL of 0.5% sodium hypochlorite solution or 70% isopropyl
alcohol near SYRINGE 1 on the dispenser.

2. Place the SYRINGE 1 inlet tube in the beaker.

3. If you have not already done so, detach the dispenser’s outlet tubes from the
instrument. Place the ends of the outlet tubes in an empty beaker and set the beaker
next to the dispenser.

4. Launch Gen5 and from the main screen select System > Instrument Control, and click
the Prime tab.

5. Select Dispenser 1, enter a Volume of 5000 µL, and keep the default dispense Rate.

6. Place the priming plate on the carrier.

7. Run two prime cycles, for a total of 10,000 µL.

8. Wait at least 20 minutes to allow the solution to disinfect the tubing.

9. Remove the inlet tube from the beaker of disinfectant solution.

10. From the Instrument Control dialog, change the Volume to 1000 µL.

11. Run one prime cycle, to flush the disinfectant out of the fluid lines.

12. Empty the beaker containing the outlet tubes. Put the tubes back in the empty beaker.

13. If sodium hypochlorite (bleach) was used, perform Rinse the Fluid Lines.

Otherwise (or after performing the Rinse procedure), repeat steps 1–13 for SYRINGE
2/Dispenser 2.

Rinse the Fluid Lines

Perform this procedure only if decontamination was performed using sodium hypochlorite.
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1. Place a beaker containing at least 30 mL of deionized water on the dispenser.

2. Place the SYRINGE 1 or 2 inlet tube in the beaker.

3. If you have not already done so, place the outlet tubes in an empty beaker.

4. From the Instrument Control dialog, select Dispenser 1 or 2, set the Volume to 5000 µL,
and keep the default dispense Rate.

5. Run five prime cycles, for a total of 25,000 µL.

6. Pause for 10 minutes and then run one prime cycle with 5000 µL. This delay will allow
any residual sodium hypochlorite to diffuse into the solution and be flushed out with
the next prime.

7. Empty the beaker containing the outlet tubes.

8. Wipe all surfaces with deionized water.

9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Clean the Tubing and Injectors

Perform the procedures under Clean the Dispense Tubes and Injectors in Periodic
Maintenance.

Decontaminate the Tip Priming Trough and Priming Plate

1. Remove the tip priming trough from the instrument’s microplate carrier.

2. Wash the tip priming trough and priming plate in hot, soapy water. Use a small brush or
cloth to clean the corners of the trough and plate.

3. To decontaminate, soak the trough and plate in a container of 0.5% sodium
hypochlorite or 70% isopropyl alcohol for at least 20 minutes.

l If decontaminating in a bleach solution, thoroughly rinse the trough and plate with
DI water.

l If decontaminating with alcohol, let the trough and plate air dry.

4. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.
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Alternate Procedure
If you are unable to prime the Synergy Neo 2 due to a system failure, decontaminate the
instrument and the dispenser as follows:

1. Perform the procedures under Clean the Dispense Tubes and Injectors in Periodic
Maintenance.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects of
bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the solution you are using. Commercial products are
typically 10.0% NaClO; prepare a 1:20 dilution. Household products are typically
5.0% NaClO; prepare a 1:10 dilution.

3. Slide the microplate carrier out of the instrument.

4. Wet a cloth with the bleach solution or alcohol, then thoroughly wring it out so that
liquid does not drip from it. Do not soak the cloth.

5. Use the cloth to wipe:

l All exterior surfaces of the instrument

l All surfaces of the plate carrier

l The exposed surfaces of the dispenser, including the syringe valves

6. Remove the tubing and the syringes from the dispenser and soak them in the bleach or
alcohol solution. Wait for 20 minutes.

7. Moisten a cloth with DI or distilled water and wipe all surfaces that have been cleaned
with the bleach solution or alcohol.

8. Rinse all tubing and the syringes with DI water.

9. Use a clean, dry cloth to dry all surfaces on the instrument and the dispenser.

10. Reassemble the dispenser as necessary.

11. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Dispenser Syringe Replacement
Refer to the Periodic Maintenance chapter for cleaning procedures you must perform
regularly and also in the case of poor performance (for example, when Dispense Accuracy
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and Precision tests fail). If cleaning the dispenser does not eliminate performance
problems, or if a syringe is obviously leaking, perform these instructions to replace a faulty
syringe. Contact Technical Support to order replacement syringes.
To change a syringe, first use Gen5 to put the syringe in its maintenance position.

Syringe Maintenance Position

Do not change the syringe position or calibrate the dispensers unless instructed to do
so as part of installation, upgrade, or maintenance.

Gen5 provides access to syringe setup functions for maintenance and calibration purposes.
When a syringe needs to be installed or replaced, it must first be moved to its
“maintenance position.”

1. From the Gen5 main screen, select System > Instrument Control > Synergy Neo 2 and
click the Prime tab.

2. Select the appropriate Dispenser number (1 or 2) associated with the syringe.

3. ClickMaintenance. The syringe plunger will move to its furthest-from-home position.
The syringe can then be disconnected from the drive bracket and unscrewed from the
valve.

Replace the Syringe
After using Gen5 to move the syringe into its maintenance position:

1. Using your fingers, unscrew the bottom thumbscrew that secures the syringe,
underneath the bracket. Retain this bottom thumbscrew; it is needed for the
replacement syringe.

2. Unscrew the top thumbscrew to disengage the syringe from the valve.

3. Remove the new syringe from its protective box. (The syringe should already be
assembled in one piece; if it is not, see “Install the Dispenser” in the Installation
chapter.

4. Hold the syringe vertically with the threaded end at the top. Screw the top of the
syringe into the bottom of the syringe valve. Finger-tighten only.

5. Carefully pull down the bottom of the syringe until it rests inside the hole in the bracket.

6. Pass the thumbscrew (used to hold the old syringe) up through this hole and thread it
into the bottom of the syringe. Hold the syringe from rotating while tightening the
thumbscrew. Finger-tighten only.
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7. From the Gen5 main screen, select System > Instrument Control > Synergy Neo 2. Click
the Prime tab and click Initialize.
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Instrument Qualification

This chapter describes the tests that BioTek has developed for complete
qualification of all models of the Synergy Neo 2. This chapter introduces the
various test methods, describes the materials and relevant Gen5 protocols
used to execute the tests, explains how to analyze test results, and provides
troubleshooting tips in the event of a failure.
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Instrument Qualification Overview
This chapter contains the recommended Installation Qualification (IQ), Operational
Qualification (OQ), and Performance Qualification (PQ) procedures for all models of the
Synergy Neo 2 Microplate Reader.
Every Synergy Neo 2 reader and external dispense module is fully tested prior to shipment
and should operate properly upon initial setup. If you suspect that a problem occurred
during shipment, if you have received the equipment after returning it to the factory for
service, and/or if regulatory requirements dictate that you qualify the equipment on a
routine basis, perform the procedures outlined in this chapter.

A Product Qualification Package (PN 1350526N) for the Synergy Neo 2 is available for
purchase. The package contains complete procedures, Gen5 protocols, checklists, and
logbooks for performing Installation Qualification, Operational Qualification,
Performance Qualification, and Periodic Maintenance.

IQ/OQ/PQ Description
Installation Qualification confirms that the reader and its components have been supplied
as ordered and ensures that they are assembled and configured properly for your lab
environment.

l The recommended IQ procedure consists of setting up the instrument and its
components as described in Chapter 2, Installation, and performing the System Test.
For models with injectors, a quick “Injector Test” is also performed, to ensure that the
dispense module is properly installed and there are no leaks.

l The IQ procedure should be performed initially (before the reader is used for the first
time).

l The successful completion of the IQ procedure verifies that the instrument is installed
correctly. The Operational Qualification procedure should be performed immediately
following the successful IQ.

Operational Qualification confirms that the equipment operates according to specification
initially and over time.

l The recommended OQ procedure consists of performing the system test, Absorbance
Plate Test, luminescence test, a series of liquid tests, and, if the external dispense
module is used, the Dispense Accuracy and Precision Tests.

l The OQ procedure should be performed initially (before first use) and then routinely;
the recommended interval is annually. It should also be performed after any major
repair or upgrade to the hardware or software.
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l Although out-of-tolerance failures will be detected by the OQ tests, results should be
compared with those from the routine Performance Qualification tests and previous
OQ tests to monitor for trends.

l The successful completion of the OQ procedure, in combination with results that are
comparable to previous PQ and OQ tests, confirms that the equipment is operating
according to specification initially and over time.

Performance Qualification confirms that the reader consistently meets the requirements
of the tests performed at your laboratory.

l The recommended PQ procedure consists of performing the System Test, Absorbance
Plate Test, Luminescence test, a series of Liquid Tests, and, if the external dispense
module is used, the Dispense Accuracy and Precision Tests.

l Your facility’s operating policies may also require that you routinely perform an actual
assay, to confirm that the reader will consistently give adequate results for the assays
to be run on it.

l These tests should be performed routinely; the recommended interval is monthly or
quarterly, depending on the test. This frequency may be adjusted depending on the
trends observed over time.

l The successful completion of the PQ procedure confirms that the equipment is
performing consistently under normal operating conditions.

Recommended Qualification Schedule
This table defines the recommended intervals for qualification for an instrument used two
to five days a week. The schedule assumes that the Synergy Neo 2 is properly maintained
as outlined in the Periodic Maintenance section.

The risk and performance factors associated with your assays may require that the
Operational and Performance Qualification procedures be performed more or less
frequently than shown here.

Tasks/Tests

IQ OQ PQ

Initially
Initially/
Annually

Monthly Quarterly

All models:

Unpacking, installation, setup, and verification ü
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Tasks/Tests

IQ OQ PQ

Initially
Initially/
Annually

Monthly Quarterly

System Test ü ü ü

Absorbance capability:

Absorbance Plate Test ü ü

Absorbance Liquid Test 1 or Liquid Test 2** ü ü

(Optional) Absorbance Liquid Test 3 or
Absorbance Plate Test at 340 nm with
PN 7260551

ü ü

Fluorescence capability:

Corners, Sensitivity, Linearity Tests ü ü

Fluorescence Polarization Test* ü ü

Time-Resolved Fluorescence Test -Flash* ü ü

Time-Resolved Fluorescence Test -Laser* ü ü

Luminescence capability:

Luminescence Test ü ü

Dispenser system*:

Injection System Test ü

Dispense Accuracy/Precision Test ü ü

Alpha Laser capability*:

Alpha Detection Test ü

* If applicable to your reader model
** If you have Absorbance Test Plate PN #7260522, perform Liquid Test 1. Otherwise,
perform Liquid Test 2.
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System Test
Each time the Synergy Neo 2 is turned on, it automatically performs a series of tests on the
reader’s motors, lamp, the PMTs, and various subsystems. The duration of this system test
depends on the reader model, and can take a few minutes to complete. If all tests pass, the
microplate carrier is ejected and the green LED on the carrier switch remains on.
If any test results do not meet the internally coded Failure Mode Effects Analysis (FMEA)
criteria, the reader beeps repeatedly and the red LED on the carrier switch flashes. If this
occurs, press the carrier eject button to stop the beeping. If necessary, initiate another
system test using Gen5 to try to retrieve an error code from the reader. Refer to Appendix
B, Error Codes for information on error codes and for troubleshooting tips.

If the power-up system test fails, when you initiate a system test using Gen5, Gen5
displays a message stating that the reader has a pending system test report. Click OK in
the message box to review the report; it contains information obtained up to the point
of the failure.

1. Turn on the reader and launch Gen5.

2. If your assays use incubation, we recommend enabling Temperature Control and
allowing the incubator to reach its set point before running the system test. To access
this feature, from the Gen5 main screen, select System > Instrument Control and click
the Pre-Heating tab. Wait until the display indicates that the temperature set point has
been reached.

3. Select System > Diagnostics > Run System Test.

If the test fails during execution, a message box appears in the software. Close the box;
the test report contains the error code that was generated by the failure.

4. When the test is complete, a dialog appears, requesting additional information. Enter
your user name and other information (if desired) and then click OK.

5. The results report appears. Scroll down toward the bottom of the report; it shows either
“SYSTEM TEST PASS” or “SYSTEM TEST FAIL *** ERROR (error code) DETECTED.”

6. Print the report if desired.

l Gen5 stores the results in a database, so the results can be retrieved at any time.
We recommend that you print and save the reports to document that the test was
performed. You can also save the report as an HTML file.
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7. If the test failed, look up the error code in Appendix B, Error Codes to determine its
cause. If the cause is something you can fix, turn off the reader, fix the problem, and
then turn the reader back on and retry the test.

If the test continues to fail, or if the cause is not something you can fix, contact Technical
Support.

Plate Shaker Test
This test verifies that the multispeed plate shaker is operating properly. The test involves
creating and running a protocol with shaking enabled for a duration of 30 seconds. The
sound of the carrier shaking is all that needs to be confirmed to verify that the plate shaker
is operating properly.
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Absorbance Testing Overview
Tests for the absorbance system use a combination of solid-state Absorbance Test Plates
and liquid plates. The test plates and the materials used for creating the liquid plates are
available for purchase.
To qualify the absorbance system for the Synergy Neo 2, you should perform:

l Absorbance Liquid Test 1 and Absorbance Plate Test (using 7260522) or

l Absorbance Liquid Test 2

Optionally, to qualify operation in the UV range, you should also perform:

l Absorbance Liquid Test 3 or Absorbance Plate Test at 340 nm (using 7260551)

Absorbance Liquid Tests

Test Methods

Absorbance Liquid Test 1 confirms repeatability and alignment of the reader when a
solution is used in the microplate. If these tests pass, then the lens placement and optical
system cleanliness are proven. For the Repeatability portion of this test, two columns
containing a color-absorbing solution are read five times at 405 nm. For each well, an
"allowed deviation" is determined based on its Mean OD and the reader's repeatability
specification. Each well's Standard Deviation must be less than its Allowed Deviation to
pass. To confirm the reader’s mechanical alignment, the plate is rotated 180 degrees in the
carrier (e.g., A1 is now in the H12 position) and the same two columns are read. The initial
and new OD readings are compared, using the reader's accuracy specification. If the two
readings in the same well do not meet specification, the reader may be out of alignment.
If an Absorbance Test Plate is not available, Absorbance Liquid Test 2may be conducted to
test the instrument's alignment, repeatability, and accuracy by preparing a series of
solutions of varying OD values. "Absorbance Liquid Test 2" on page 93.
Absorbance Liquid Test 3 is an optional test offered for those sites that must have proof of
linearity at 340 nm. (Alternatively, the BioTek 340 nm Absorbance Test Plate may be used.)
This test is optional since the instrument has good “front-end” linearity throughout the
specified wavelength range. While the absolute values of the OD cannot be determined by
this test, the results will indicate if there is adequate repeatable absorbance and a linear
slope. This method is dependent upon proper dye dilution and a skilled pipetting
technique. It is expected that the first dilution (mid-level solution) will have an absorbance
value near 75% of that of the stock (high-level) solution, and that the second dilution (low-
level solution) will have an absorbance value near 50% of that of the stock solution.
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Absorbance Plate Test
This test uses Absorbance Test Plate (PN 7260522) to confirm the mechanical alignment;
optical density accuracy, linearity, and repeatability; and wavelength accuracy of the
Synergy Neo 2. The Absorbance Test Plate compares the reader's optical density and
wavelength measurements to NIST-traceable values.

An alternate method for confirming accuracy, linearity, and repeatability is Liquid Test
2, described on page 93.

To run this test, you need Absorbance Test Plate (PN 7260522), with its accompanying data
sheet.

l The Absorbance OD Standards section contains NIST-traceable standard OD values for
the filters at several different wavelengths. We recommend testing at six
wavelengths—those at or close to the wavelengths used in your assays.

l The Wavelength Accuracy Standards section contains Expected Peak wavelength
values for the filter in position C6 on the plate. Each value has a valid test range and
expected peak range recorded on the accompanying data sheet. For example, an
Expected Peak value may be 586 nm with tolerance values of –6/+4 (or a test range of
580 to 590 nm).

Absorbance Test Plate PN 7260551 can be used to confirm optical density accuracy,
linearity, and repeatability at 340 nm and is offered as an alternative to conducting
Absorbance Liquid Test 3.

The instructions provided below are guidelines. Refer to the Gen5 Help system for
more information.

Define Absorbance Test Plate Parameters

1. Obtain the certificates that came with the Test Plate.

2. Start Gen5 and from the main screen select System > Diagnostics > Test Plates >
Add/Modify Plates.

3. Click Add. The Absorbance Test Plate dialog appears.

4. Select the appropriate Plate Type and enter the plate’s serial number.
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5. Enter the Last Certification and Next Certification dates from the calibration sticker on
the Test Plate.

6. If the wavelength values in the top row of the grid in Gen5 are appropriate for your
tests, enter the OD values from the data sheet into the grid. Make sure you enter the
correct value for each well/wavelength combination.

If you need to add, change, or delete any wavelength values, clickWavelength
List. Click the Gen5 Help button for assistance.

7. Select the number of Peak Wavelength tests to run (up to 4), based on the number of
expected peak wavelength values provided on the certificate.

8. Enter the Expected Peak value(s) from the certificate and set the Test Range – and +
values.

The glass in each test plate is unique. Therefore, the expected peaks may differ
slightly from plate to plate.

l If the C6 filter is Holmium or Erbium glass, the certificate contains two Spectral
Bandpass tables. For wavelengths greater than 285 nm, we recommend
performing the test using the 5.0 nm table. For wavelengths in the 230–285 nm
range, we recommend using the 2.4 nm table.

n For the Erbium glass, any peak can be used.

n For the Holmium glass, use the expected peak values closest to 242, 279,
362, 417, and 538 nm. For example, if your certificate looks like the one
below, you might choose to run the test at four of the five highlighted
Expected Peak/Test Range combinations:

2.4 nm Spectral Bandpass 5.0 nm Spectral Bandpass

Expected Peak Test Range Expected Peak Test Range

241 –5+5 242 –5+5

278 –6+4 279 –6+4

287 –4+6 288 –4+6

334 –5+5 334 –5+5
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360 –5+5 362 –5+5

417 –5+5 417 –5+5

484 –5+5 485 –5+5

537 –5+5 538 –5+5

642 –5+5 643 –5+5

l If your C6 filter is Didymium glass, a single peak wavelength value is provided.
Enter this value and set the Test Range – and + values so the range displayed in
parentheses is 580 to 590, as shown here:

9. Review all the values you entered. Click OK to save the data.

The information you just entered is available on Gen5 each time the Absorbance Plate Test
is performed. It may need to be modified after the annual recertification of your test plate.

Run the Absorbance Plate Test

1. From the Gen5 main screen, select System > Diagnostics > Test Plates > Run. If
prompted, select the desired Test Plate and click OK.

2. When the Absorbance Test Plate Options dialog appears, select Perform Peak
Wavelength Test if it is not already selected.

3. Highlight the wavelength(s) to be included in this test.

Select only those wavelengths most appropriate for your use of the reader.

4. (Optional) Enter any Comments.

5. Click Start Test.

6. Place the Test Plate in the microplate carrier so that well A1 is in the right-rear corner of
the carrier.
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7. Click OK to run the test.

8. When the test is completed, the results report appears. Scroll through the report; every
result should show “PASS”. Because Synergy Neo 2 absorbance specifications extend
only to 2.5 OD, any test results above this number do not state "PASS" or "FAIL," but
display only the numerical results. This information is for reference only and does not
imply any guarantee of accuracy above 2.5 OD. See Results and Troubleshooting Tips
for information on results and troubleshooting tips in the event of failures.

Gen5 stores the results in a database; they can be retrieved any time. We recommend you
print and save the report to document that the test was performed.

Results and Troubleshooting Tips
The Absorbance Test Plate Report contains results for the following:

l Peak Absorbance:When the test is performed, the C6 filter is scanned at the test
range(s) defined by the user in the Absorbance Test Plate dialog. To verify wavelength
accuracy, the wavelength of the maximum absorbance is compared with the peak
wavelength value entered in the software, which comes from the Peak Wavelength
Certificate supplied with the Test Plate. The accuracy of the wavelength should be ± 3
nm (± 2 nm instrument, ± 1 nm filter allowance). If the reader fails this test:

n Make sure the information entered into Gen5 matches the Test Plate’s Peak
Wavelength Certificate.

n Verify that the Test Plate has a filter in location C6. (Test Plates with the part
number 9000547 and 7260551 do not have this filter.) This test plate was
designed for use with readers that use interference filters to generate the
specific wavelength required. The Peak Absorbance filter in C6 is used for
testing the monochromator.

n Check the C6 filter to make sure it is clean. If needed, clean it with lens paper.
Do not remove the filter from the Test Plate, and do not use alcohol or other
cleaning agents.

n Verify that the Test Plate is within its calibration certification period. If it is
out of date, contact BioTek to schedule a recertification.

n Check the microplate carrier to ensure it is clear of debris and that the plate is
held securely in place by the retainer when the carrier moves into the reader.

l Alignment: This test measures the alignment of the microplate carrier with the optical
path. A reading greater than 0.015 OD represents an out-of-alignment condition.
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Wells A1, A12, H1, and H12 are the only valid alignment holes for the reader on the
PN 7260522 Test Plate.

If the reader fails this test:

n Ensure that the Test Plate is correctly seated in the microplate carrier.

n Check the four alignment holes (A1, A12, H1, H12) to ensure they are clear of
debris.

n Check the microplate carrier to ensure it is clear of debris and, again, that the
plate is held securely in place by the retainer when the carrier moves into the
reader.

l Accuracy: Accuracy is a measure of the optical density of Test Plate wells C1, D4, E2,
F5, G3, and H6 as compared with known standard values contained in the Standards
Certificate that accompanies each Test Plate.

If the reader fails this test:

n Verify that the filter calibration values entered in Gen5 are the same as those
on the Test Plate’s Standards Certificate.

n Check the filters on the Test Plate to ensure they are clean. If necessary, clean
them with lens paper. Do not remove the filters from the test plate, and do
not use alcohol or other cleaning agents.

n Verify that the Test Plate is within its calibration certification period. If it is
out of date, contact Technical Support to schedule a recertification.

l Repeatability: Repeatability is a measure of the instrument’s ability to read the same
well with minimum variation between two reads with the well in the same location. If
the reader fails this test:

n Check the filters on the Test Plate to ensure there is no debris that may have
shifted between readings and caused changes.

n Check the microplate carrier to ensure it is clear of debris.

Linearity of the optical density readings is confirmed by default if the optical
density readings are accurate. To further verify this, you can perform a regression
analysis on the Test Plate OD values in a spreadsheet program such as Microsoft
Excel. An R Squared value of at least 0.9900 is expected.
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Absorbance Liquid Tests
Conducting liquid tests confirms the reader’s ability to perform to specification with liquid
samples. Liquid testing differs from testing with the Absorbance Test Plate in that liquid in
the wells has a meniscus, whereas the Test Plate’s neutral density glass filters do not. The
optics characteristics may differ in these two cases, thus alerting the operator to different
types of problems.

Absorbance Liquid Test 1
Absorbance Liquid Test 1 confirms repeatability and alignment of the reader when a
solution is used in the microplate. If these tests pass, then the lens placement and optical
system cleanliness are proven.

Materials

Manufacturer part numbers are subject to change.

l New 96-well, clear, flat-bottom microplate (Corning Costar #3590 recommended)

l Stock Solution A or B, which may be formulated by diluting a dye solution available
from BioTek (A) or from the materials listed below (B).

Solution A

l BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; PN 7120782, 125 mL)

l Deionized water

l 5-mL Class A volumetric pipette

l 100-mL volumetric flask

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a 100-mL volumetric flask.

2. Add 95 mL of DI water; cap and shake well. The solution should measure approximately
2.000 OD when using 200 µL in a flat-bottom microwell.

Solution B

l Deionized water

l FD&C Yellow No. 5 dye powder (typically 90% pure)

l Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting agent (PN
7773002) (a 10% Tween solution)
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l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l Weigh boat

l 1-liter volumetric flask

1. Weigh out 0.092 g of FD&C Yellow No. 5 dye powder into a weigh boat.

2. Rinse the contents into a 1-liter volumetric flask.

3. Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent.

4. Fill to 1 liter with DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 µL in a flat-bottom microwell.

Prepare the Plate

Be sure to use a new microplate, because fingerprints or scratches may cause
variations in readings.

1. Using freshly prepared stock solution (Solution A or B), prepare a 1:2 dilution using
deionized water (one part stock, one part deionized water; the resulting solution is a 1:2
dilution).

2. Pipette 200 µL of the concentrated solution (A or B) into the first column of wells in the
microplate.

3. Pipette 200 µL of the diluted solution into the second column of wells.

After pipetting the test solution into the microplate and before reading the plate, we
strongly recommend shaking the plate for four minutes. This will allow any air bubbles
in the solution to settle and the meniscus to stabilize. Alternatively, wait 20 minutes
after pipetting the test solution before reading the plate.

Read the Plate

1. Using Gen5, read the microplate five times at 405 nm using the Normal read mode,
single wavelength, no blanking. Save the data after each read (“Normal” plate position).

2. Without delay, rotate the microplate 180 degrees so that well A1 is in the “H12”
position. Read the plate five more times, saving the data after each read (“Turnaround”
plate position).
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3. Print out the ten sets of raw data, or export them to an Excel spreadsheet.
See the calculations described below to obtain results for the tests performed.

Analyze the Results

1. The plate is read five times in the “Normal” position at 405 nm. Calculate the Mean OD
and Standard Deviation of those five reads for each well in columns 1 and 2.

2. For each well in columns 1 and 2, calculate the Allowed Deviation using the repeatability
specification for a 96-well plate: ± 1% ± 0.005 OD from 0.000 to 2.000 OD (Mean * 0.010
+ 0.005). For each well, its standard deviation should be less than its allowed deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result in a
mean of 0.8004 and a standard deviation of 0.0018. The mean multiplied by 1.0%
(0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this is the
allowed deviation for well A1. Since the standard deviation for well A1 is less than
0.013, the well meets the test criteria.

3. The plate is read five times in the “Turnaround” position at 405 nm. Calculate the Mean
OD of those reads for each well in columns 11 and 12.

4. Perform a mathematical comparison of the Mean values for each microwell in its
Normal and Turnaround positions (that is, compare A1 to H12, A2 to H11, B1 to G12,…
H2 to A11). To pass the test, the differences in the compared mean values must be
within the accuracy specification for a 96-well microplate: ± 1.0% ± 0.010 OD from 0.000
to 2.000 OD.

Example: If the mean value for well A1 in the Normal position is 1.902 with a
specified accuracy of ± 1.0% ± 0.010 OD, then the expected range for the mean of
the well in its Turnaround (H12) position is 1.873 to 1.931 OD. 1.902 x 0.010 + 0.010
= 0.029; 1.902 - 0.029 = 1.873; 1.902 + 0.029 = 1.931.

Repeatability Specification:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD
± 3.0% ± 0.005 OD from 2.000 OD to 2.500 OD

Accuracy Specification:

± 1.0% ± 0.010 OD from 0.000 to 2.000 OD
± 3.0% ± 0.010 OD from 2.000 OD to 2.500 OD

Absorbance Liquid Test 2
The recommended method for testing the instrument’s alignment, repeatability, and
accuracy is to use the Absorbance Test Plate. If the Test Plate is not available, however,
Liquid Test 2 can be used for these tests.
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Materials

l A new 96-well, clear, flat-bottom microplate (Corning Costar #3590 is recommended)

l Ten test tubes, numbered consecutively, set up in a rack

l Calibrated hand pipette (Class A volumetric pipette recommended)

l Solution A or B (see the instructions for Liquid Test 1)

l A 0.05% solution of deionized water and Tween 20

Prepare the Dilutions

Create a percentage dilution series, beginning with 100% of the original concentrated stock
solution (A or B) in the first tube, 90% of the original solution in the second tube, 80% in
the third tube, all the way to 10% in the tenth tube. Dilute using the 0.05% solution of
deionized water and Tween 20. This solution can also be made by diluting the wetting
agent 200:1.

Test Tube Dilutions for Liquid Test 2

Tube Number 1 2 3 4 5 6 7 8 9 10

Volume of Original
Concentrated Solution (mL)

20 18 16 14 12 10 8 6 4 2

Volume of 0.05% Tween
Solution (mL)

0 2 4 6 8 10 12 14 16 18

Absorbance expected if
original solution is 2.0 at
200 μL

2.0 1.8 1.6 1.4 1.2 1.0 0.8 0.6 0.4 0.2

The choice of dilutions and the absorbance of the original solution can be varied. Use
this table as a model for calculating the expected absorbances of a series of dilutions,
given a different absorbance of the original solution.

Prepare the Plate

l Pipette 200 µL of the concentrated solution from Tube 1 into each well of the first
column, A1 to H1, of a new flat-bottom microplate.

l Pipette 200 µL from each of the remaining tubes into the wells of the corresponding
column of the microplate (Tube 2 into wells A2 to H2, Tube 3 into wells A3 to H3, and
so on).
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Linearity and Repeatability Tests

1. Using Gen5, read the microplate prepared above five times using Normal mode, dual
wavelength at 450/630 nm. Save the data after each read.

Do not discard the plate; you will use it for the Alignment test.

2. Print out the five sets of Delta OD data, or export them to an Excel spreadsheet.

3. Calculate the results for Linearity:

l Calculate the mean absorbance for each well, and average the means for each
concentration.

l Perform a regression analysis on the data to determine if there is adequate
linearity.
Since it is somewhat difficult to achieve high pipetting accuracy when conducting
linear dilutions, an R Square value of at least 0.9900 is considered adequate.

4. Calculate the results for Repeatability:

l Calculate the mean and standard deviation for the five readings taken in Step 1 at
each concentration. Only one row of data needs to be analyzed.

l For each mean below 2.000 OD, calculate the allowed deviation using the
repeatability specification for a 96-well plate of ± 1.0% ± 0.005 OD. If above 2.000
OD, apply the ± 3.0% ± 0.005 specification.

l The standard deviation for each set of readings should be less than the allowed
deviation.
Example: Absorbance readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will result in a
mean of 1.951, and a standard deviation of 0.0026. The mean (1.951) multiplied by
1.0% (1.951 x 0.010) = 0.0195, which, when added to the 0.005 (0.0195 + 0.005) =
0.0245 OD, which is the allowed deviation. Since the standard deviation is less than
this value, the reader meets the test criteria.

Repeatability Specification:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD
± 3.0% ± 0.005 OD from 2.000 OD to 2.500 OD
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Alignment Test

1. Using the plate prepared for the Linearity Test on the previous page, conduct a
Turnaround test by reading the plate five times with the A1 well in the H12 position.
Save the data after each read.

This test results in values for the four corner wells that can be used to determine
alignment.

2. Calculate the means of the wells A1 and H1 in the Normal plate position (data from
Linearity Test) and in the Turnaround position (from Step 1).

3. Compare the mean reading for well A1 to its mean reading when in the H12 position.
Next, compare the mean values for the H1 well to the same well in the A12 position.
The difference in the values for any two corresponding wells should be within the
accuracy specification for the instrument.

Example: If the mean of well A1 in the normal position is 1.902, where the specified
accuracy is ± 1.0% ± 0.010 OD, then the expected range for the mean of the same
well in the H12 position is 1.873 to 1.931 OD. (1.902 x 1.0% = 0.019 + 0.010 = 0.029,
which is added to and subtracted from 1.902 for the range.)
If the four corner wells are within the accuracy range, the reader is in alignment.

Accuracy Specification:

± 1.0% ± 0.010 OD from 0.000 to 2.000 OD
± 3.0% ± 0.010 OD from 2.000 OD to 2.500 OD

Absorbance Liquid Test 3
Absorbance Liquid Test 3 is provided for sites requiring proof of linearity at 340 nm. This
test is optional because the Synergy Neo 2 has good "front end" linearity throughout its
wavelength range. As an alternative, the 340 nm Absorbance Test Plate (PN 7260551) may
be used for this test.

Materials

Manufacturer part numbers are subject to change.

l New 96-well, clear, flat-bottom microplate (Corning Costar #3590 recommended);
alternatively, a UV transparent microplate may be used

l Calibrated hand pipette(s)

l Beakers and graduated cylinder
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l Precision balance with readability to 0.01 g

l Buffer solution described below

Buffer Solution

l Deionized water

l Phosphate-Buffered Saline (PBS), pH 7.2–7.6, Sigma tablets, #P4417 (or equivalent)

l β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, Reduced Form) Sigma bulk
catalog number N 8129, or preweighed 10-mg vials, Sigma number N6785-10VL (or
BioTek PN 98233). Store the powder according to the guidelines on its packaging.

1. Prepare a PBS solution from the Sigma tablets.

2. In a beaker, mix 50 mL of the PBS solution with 10 mg of the β-NADH powder and mix
thoroughly. This is the 100% Test Solution.

3. (Optional) Read a 150-µL sample of the solution at 340 nm; it should be within 0.700 to
1.000 OD. If low, adjust up by adding more powder. Do not adjust if slightly high.

Prepare the Plate

1. Prepare the 75% Test Solution by mixing 15 mL of the 100% Test Solution with 5 mL of
the PBS Solution.

2. Prepare the 50% Test Solution by mixing 10 mL of the 100% Test Solution with 10 mL of
the PBS Solution.

3. Carefully pipette the three solutions into a new 96-well microplate:

l 150 µL of the 100% Test Solution into all wells of columns 1 and 2

l 150 µL of the 75% Test Solution into all wells of columns 3 and 4

l 150 µL of the 50% Test Solution into all wells of column 5 and 6

Read the Plate

1. Using Gen5, read the microplate five times using Normal mode, single wavelength at
340 nm, no blanking. Save the data after each read.

2. Print out the five sets of raw data, or export them to an Excel spreadsheet.

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



98 | Chapter 6: Instrument Qualification

Analyze the Results

The plate is read five times at 340 nm.

1. For each well, calculate the Mean OD and Standard Deviation of the five readings.

2. For each mean calculated in step 1, calculate the allowed deviation using the
repeatability specification for a 96-well plate: ± 1% ± 0.005 OD from 0.000 to 2.000 OD
(Mean x 0.010 + 0.005). For each well, its standard deviation should be less than its
allowed deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result in a
mean of 0.8004 and a standard deviation of 0.0018. The mean multiplied by 1.0%
(0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this is the
allowed deviation for well A1. Since the standard deviation for well A1 is less than
0.013, the well meets the test criteria.

3. Calculate the results for Linearity:

l For each of the three Test Solutions, calculate the average Mean OD for the wells
containing that solution (mean of wells A1 to H2, A3 to H4, and A5 to H6).

l Perform a regression analysis on the data to determine if there is adequate
linearity. The three average Mean OD values are the “Y” values. The solution
concentrations are the “X” values (1.00, 0.75, 0.50).
Since it is somewhat difficult to achieve high pipetting accuracy when conducting
linear dilutions, an R Square value of at least 0.9900 is considered adequate.

Repeatability Specification:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD
± 3.0% ± 0.005 OD from 2.000 OD to 2.500 OD

Fluorescence Testing

This section applies to all models except NEO2MON.

Fluorescence Testing Overview

Two options are provided for testing the Synergy Neo2 Multi-Mode Microplate Reader
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fluorescence system. One uses a solid state Fluorescence Test Plate (package PN
14005011). The other uses liquid plates.
Kits containing the microplates and solutions required for the Liquid Tests are available for
purchase; see Materials for Conducting Liquid Tests on page 5.

Fluorescence Test Plate
The Fluorescence Test Plate simplifies the process for conducting fluorescence intensity,
fluorescence polarization, and time-resolved fluorescence qualification tests on the
Synergy Neo2 Multi-Mode Microplate Reader. The test plate is solid and, therefore,
immune to pipetting errors, evaporation issues, and costs experienced with conventional
liquid tests.
The test plate package includes Gen5 protocols designed specifically for use with the test
plate. The protocols include embedded Microsoft Excel spreadsheets to automatically
calculate results and determine pass/fail. The protocols and their spreadsheets were fully
validated in accordance with BioTek Product Validation policies and procedures.
The package also contains a user guide that describes the test methods, helps you get
started using the plate, and provides important information for cleaning and maintaining
the test plate. The guide also provides troubleshooting tips and information on the annual
recalibration program.

Results Analysis

Refer to the Fluorescence Test Plate User Manual for descriptions of the data reduction
calculations for each test. The tests must meet the following criteria to pass:

Fluorescence Intensity (FI) Tests

Corners %CV < 3.0

Linearity R2 >= 0.9500

Sensitivity, filter-based system:

Top optics, Sodium Fluorescein analogue Detection Limit <= 5.0 pM

Bottom optics, Sodium Fluorescein analogue Detection Limit <= 5.0 pM

Top optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Bottom optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Sensitivity, monochromator-based system:

1Fluorescence Test Plate PN 7092092 cannot be used for these tests.
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Fluorescence Intensity (FI) Tests

Top optics, Sodium Fluorescein analogue Detection Limit <= 20.0 pM

Bottom optics, Sodium Fluorescein analogue Detection Limit <= 20.0 pM

Top optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Bottom optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

TRF - FP tests:

Time-Resolved Fluorescence - Flash Test Detection Limit <= 250.0 fM

Time-Resolved Fluorescence - TRF Laser Test Detection Limit ≤ 40 fM

Fluorescence Polarization (FP) Test (filter-based system,
dual PMT)

HPR Polarization > 340 mP
LPR Standard Deviation < 5

Fluorescence Polarization (FP) Test (filter-based system,
single PMT)

HPR Polarization > 340 mP
LPR Standard Deviation < 5

Fluorescence Liquid Tests
BioTek has developed a series of liquid tests for verifying fluorescence performance.

Fluorescence Capability Applicable Liquid Test(s)

Filter-Based Fluorescence Intensity Corners, Sensitivity, Linearity

Monochromator-Based Fluorescence Intensity Corners, Sensitivity, Linearity

Fluorescence Polarization (for both single and
dual PMT)

"FP"

Time-Resolved Fluorescence "TRF Flash" or “TRF Laser”

l The Corners Test uses fluorescence compounds to verify that the plate carrier is
properly aligned in relation to the fluorescence probe(s).

l The Sensitivity Test uses a fluorescence compound and buffer solution to test the
fluorescence reading capability of the instrument. The ability to detect specific
compounds at the required limit of detection ensures that the filters, optical path,
and PMT(s) are all in working order. This test verifies that the difference between the
concentration well under investigation and the mean of the median buffer well is
statistically distinguishable.
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l The Linearity Test verifies that the system is linear, that is, the signal changes
proportionally with changes in concentration (R2 value). Proving that the system is
linear allows the Sensitivity Test to be run on two points instead of using serial
dilutions.

l The FP Test verifies the ability of the instrument to measure polarization of the
solution. It verifies the polarizers are installed in the proper orientation and the
mechanism is in proper order.

l The TRF Test verifies the performance of the xenon flash or TRF laser, and that the
filters, optical path, and PMTs are all in working order.

The tests presented in this section require specific microplates, solutions, wavelengths,
mirrors, and filters. Your laboratory may require a deviation from some of these tests. For
example, you may wish to use a different fluorescing solution or microplate.

1. If deviation from the tests as presented in this section is required, the following steps
should be taken the first time each test is run:

2. Perform the tests exactly as described on the following pages.

3. Rerun the tests using your particular solutions, filter cubes, microplates, and so on. If
results are comparable, then the results from these tests will be your baseline for future
tests.

4. Document your new test procedure(s), and save all test results.

Required Materials

Kits containing the microplates and solutions required for the Liquid Tests are available
for purchase; see Materials for Conducting Liquid Tests on page 5.

Microplates should be perfectly clean and free from dust or bottom scratches. Use new
microplates from sealed packages.

Manufacturer part numbers are subject to change.

All Tests:

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes
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l 95% ethanol (for cleaning clear-bottom plates)

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)

l Gen5 protocols listed in the next table and described starting on page 103

For the Filter-Based Fluorescence System

Synergy Neo2_FI_T_SF.prt Corners, Sensitivity, and Linearity tests for top optics, using sodium
fluorescein

Synergy Neo2_FI_B_
SF.prt

Corners, Sensitivity, and Linearity tests for bottom optics, using sodium
fluorescein

Synergy Neo2_FI_T_
MUB.prt

Alternative top optics test, using methylumbelliferone

Synergy Neo2_FI_B_
MUB.prt

Alternative bottom optics test, using methylumbelliferone

Synergy Neo2_Dual PMT_
FP.prt

Fluorescence Polarization test using dual PMT

Synergy Neo2_Single
PMT_FP.prt

Fluorescence Polarization test using single PMT

Synergy Neo2_TRF.prt Time-Resolved Fluorescence -flash test

Synergy Neo 2_TRF-
N2.prt

Time-Resolved Fluorescence -laser test

For the Monochromator-Based Fluorescence System

Synergy Neo2_M_FI_T_
SF.prt

Corners, Sensitivity, and Linearity tests for top optics, using sodium
fluorescein

Synergy Neo2_M_FI_B_
SF.prt

Corners, Sensitivity, and Linearity tests for bottom optics, using
sodium fluorescein

Synergy Neo2_M_FI_T_
MUB.prt

Alternative top optics test, using methylumbelliferone
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Corners/Sensitivity/Linearity Tests

Manufacturer part numbers are subject to change.

The materials listed here are for use with Sodium Fluorescein. Methylumbelliferone
can be used as an alternate or supplemental method for performing these tests. See
page 126.

Buffer:

n NIST-traceable Sodium Borate Reference Standard (pH 9.18) (e.g., Fisher-
Scientific 1 L Sodium Borate Mfr. #159532, or equivalent), or

n Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfr. #P4417,
or equivalent) and pH meter or pH indicator strips with pH range 4 to 10

l Sodium Fluorescein Powder (1 mg vial, BioTek PN 98155)

l If testing both Top and Bottom optics: A new, clean 96-well glass-bottom Greiner
SensoPlate (Mfr. #655892), a clean Hellma Quartz 96-well titration plate (Mfr.
#730.009.QG), or equivalent

l Top optics: A new, clean 96-well solid black microplate, such as Corning Costar #3915,
or equivalent

l Filter cubes:

n Upper Top: 3 or equivalent (dual PMT instruments)

n Lower Top: 107 or equivalent (485/528)

Fluorescence Polarization (FP) Test

l A new, clean, 96-well solid black microplate

l The recommended test solutions are available from Invitrogen Corporation in their
“FP One-Step Reference Kit” (PN P3088) or from BioTek (PN 7160014). This kit
includes:

n (Green) Polarization Reference Buffer, 15 mL

n Green Low Polarization Reference, 4 mL

n Green High Polarization Reference, 4 mL
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The Invitrogen kit also includes two red polarization solutions; these are not used.

l Filter cubes:

n Upper Top: 4 or equivalent (dual FP)

n Lower Top: 61 or equivalent (FP 485/528) (dual FP)

n 108 or equivalent (single PMT)

Time-Resolved Fluorescence (TRF) Test

l 15-mL conical-bottom, polypropylene sample tube

l Filter cubes:

Flash test TRF laser test

n Cube 3 or equivalent (dual PMT
instruments)

n Cube 112 or equivalent (360/620)

n Cube 126: 337/620; LUM

n Cube 3 or equivalent 

l A new, clean 96-well solid white microplate

l The recommended test solution (FluoSpheres carboxylate-modified microspheres, 0.2
µm europium luminescent, 2 μL) is available from Invitrogen Corporation (PN F20881)
or from BioTek (PN 7160011)

Fluorescence Test Solutions

Corners/Sensitivity/Linearity Tests Solution

If using the BioTek sodium fluorescein powder (PN 98155), be sure to hold the vial
upright and open it carefully; the material may be concentrated at the top. If a
centrifuge is available, spin down the tube before opening.

When diluting the sodium fluorescein powder in buffer, it takes time for the powder to
completely dissolve. Allow the solution to dissolve for five minutes, with intermittent
vortexing, before preparing the titration dyes.
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Wrap the vial containing the stock solution in foil to prevent exposure to light. Discard
any open, unused solution after seven days.

1. The Sodium Borate solution does not require further preparation; proceed to step 2. If
you are using PBS, prepare the solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of deionized
or distilled water.

l Follow the manufacturer’s instructions on the PBS packaging to create 200 mL,
dissolving the necessary amount of PBS into the filtered water.

l Stir the solution (preferably using a stir table) until the PBS is completely dissolved.

l Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the sodium fluorescein stock solution:

l Add 2.0 mL of the buffer solution to the 1 mg Sodium Fluorescein (SF) vial. This
yields a 1.3288 mM stock solution.

l Ensure that the dye has completely dissolved and is well mixed.

3. Carefully prepare the dilutions. Label each with “SF” and the concentration:

Mix This SF Solution: With Buffer: To Make:

0.53 mL of 1.3288 mM
stock solution

13.47 mL 50.2 μM

110 µL of 50.2 μM SF 13.89 mL 400 nM

3.5 mL of 400 nM SF 10.5 mL 100 nM

0.46 mL of 100 nM SF 13.54 mL 3.3 nM Corners Test

4.24 mL of 3.3 nM SF 9.76 mL 1 nM Sensitivity/Linearity
Tests

Fluorescence Polarization (FP) Test Solution

As described in Fluorescence Polarization (FP) Tests on page 103, the recommended test
solutions are available from Invitrogen Corporation or from BioTek. They do not require
additional preparation.

Time-Resolved Fluorescence (TRF) Test Solution

As described in Time-Resolved Fluorescence (TRF) Tests on page 104, the recommended
test solutions are available from Invitrogen Corporation or from BioTek.
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l Shake the FluoSpheres container vigorously for 30 seconds prior to pipetting.
Alternatively, sonicate or vortex the container.

l Mix 10 µL of FluoSpheres with 10 mL of deionized water, in a 15 mL conical-bottom,
polypropylene sample tube. This yields a 20 nM equivalent suspension.

l Shake the vial vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or
vortex the container.

l Mix 10 µL of 20 nM suspension with 10 mL of deionized water, in a 15 mL conical-
bottom, polypropylene sample tube. This yields a 20 pM equivalent suspension.

l Refrigerate any unused portions of the FluoSpheres. The temperature must be
between +2°C to +6°C.

The prepared TRF plate can be kept for a maximum of seven days, if covered and
stored in the dark between +2°C to +6°C.

Allow the plate to sit at room temperature for approximately 15 minutes prior to use.

Fluorescence Test Procedure

Top Optics

1. If you have not already done so, create the Gen5 protocols as described starting on
page 116.

2. If you have not already done so, prepare the solutions for the tests you plan to perform.
See Fluorescence Test Solutions on page 104.

Refer to the pipette maps starting on page 109 for the remaining steps.

3. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the filter-based
fluorescence system:

l Pipette the solutions for the Corners and Sensitivity/Linearity Tests into a clean,
new 96-well solid black plate.

l Create an experiment based on the Synergy Neo2_FI_T_SF.prt protocol.

l Perform the steps under Determine the Optimal Read Height to determine and
set the optimal read height for the filter cube/fluid height combinations.
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l Read the plate, and then save the experiment.

l If you intend to run this test in the future with the same filter cube, select File >
Save Protocol As, and save the updated protocol with the adjusted read height.
You must, however, rerun these steps if you change the filter cube used with this
test.

4. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the
monochromator-based fluorescence system:

l Create an experiment based on the Synergy Neo2_M_FI_T_SF.prt protocol. Read
the plate used in step 3, and then save the experiment.

5. To test Fluorescence Polarization capability:

l Pipette the solutions for the “FP” test into a new 96-well solid black plate.

l Create an experiment based on the Synergy Neo 2_Dual PMT_FP.prt or Synergy
Neo 2_Single PMT_FP.prt protocol. Read the plate and then save the experiment.

6. To test the Time-Resolved Fluorescence - Flash capability:

l Pipette the solutions for the “TRF” test into a new 96-well solid white plate.

l Create an experiment based on the Synergy Neo2_TRF.prt protocol. Read the
plate and then save the experiment.

7. To test the Time-Resolved Fluorescence - Laser capability:

l Pipette the solutions for the “TRF” test into a new 96-well solid white plate.

l Create an experiment based on the Synergy Neo2_TRF_N2.prt protocol. Read the
plate and then save the experiment.

8. Calculate and evaluate results as described under Results Analysis, starting on page
112.

Bottom Optics

1. If you have not already done so, create the Gen5 protocols as described starting on
page 116.

2. If you have not already done so, prepare the solutions for the tests you plan to perform.
See "Fluorescence Test Solutions" on page 104 on page 104.

Refer to the pipette maps starting on page 109 for the remaining steps.
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3. If applicable, perform the Corners/Sensitivity/Linearity tests using the Bottom optics of
the filter-based fluorescence system:

l Pipette the solutions for the Corners and Sensitivity/Linearity Tests into a clean,
96-well glass-bottom plate.

l Create an experiment based on the Synergy Neo2_FI_B_SF.prt protocol.

l Perform the steps under Determine the Optimal Read Height to determine and set
the optimal read height for the filter cube/fluid height combinations.

l Read the plate and then save the experiment.

l If you intend to run this test in the future with the same filter cube, select File
> Save Protocol As, and save the updated protocol with the adjusted read height.
You must, however, rerun these steps if you change the filter cube used with this
test.

4. Perform the Corners/Sensitivity/Linearity tests for the monochromator-based
fluorescence system:

l If you skipped step 3, pipette the solutions for the Corners and Sensitivity/Linearity
Tests into a clean, new 96-well glass-bottom plate.

l Create an experiment based on the Synergy Neo2_M_FI_B_SF.prt protocol. Read
the plate from step 3 (or the newly created plate described above) and then save
the experiment.

5. Calculate and evaluate results as described under Results Analysis, starting on page
112.

Determine the Optimal Read Height

1. Select Protocol > Procedure, and open the "Sensitivity Read" step.

2. Click Options, clear Automatic Gain Adjustment, and click OK.

3. Click Show advanced options to display the Read Height information.

4. Click Auto-Adjust. Set the Test Well to D7, and click Start Calibration. When prompted,
place the plate on the carrier and click OK.

5. When calibration is complete, a graph appears. Click Select to use the Optimal Height.

6. Click Options again, and select Automatic Gain Adjustment.

7. Record the optimal read height, then click OK to close the read step and return to the
Procedure dialog.
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8. Open the "Sensitivity Read Buffer" step. Set the read height to match the recorded
value from step 7 above, then return to the Procedure dialog.

9. Open the "Corners Read" step. Set the read height to match the recorded value from
step 7 above, then return to the Procedure dialog.

10. Open the "Linearity Read" step. Repeat steps 2–6 above; set the Test Well to C1 in step
4.

11. Return to the Procedure dialog, then click OK to close the Procedure and return to the
experiment.

Pipette Maps

Seal the plates with foil or store them in black polyethylene bags until use. When using
a clear-bottom plate, if the base of the plate is touched, clean the entire base with
alcohol (95% ethanol) and then wipe with a lint-free cloth. Before placing the plate in
the instrument, blow the bottom of the plate with an aerosol duster.

Perform these steps carefully, and refer to the grid on the next page.
For the Corners test:

l Pipette 200 μL of the 3.3 nM SF solution into wells A1–A3, A10–A12, H1–H3, and
H10–H12.

l If using a Hellma plate: Pipette 200 μL of buffer into the wells surrounding the 3.3 nM
wells ("CBUF" in the grid).

For the Sensitivity test:

l Pipette 200 μL of the 1 nM SF solution into well D7.

l Pipette 200 μL of the buffer solution into wells C9, D9, and E9.

For the Linearity test (wells C1–F5):

l Use a multichannel pipette with just four tips installed.

l Pipette 150 μL of buffer solution into wells C2–F5. Discard the tips.

l Pipette 150 μL of the 1 nM SF solution into wells C1–F1.

l Pipette 150 μL of the 1 nM SF solution into wells C2–F2. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from wells C2–F2, and dispense into wells C3–F3. Mix the wells using
the pipette. Do not discard the tips.
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l Aspirate 150 μL from wells C3–F3, and dispense into wells C4–F4. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 μL from wells C4–F4, and dispense into wells C5–F5. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 μL from wells C5–F5, and discard the tips.

Fluorescence Polarization (FP) Test

l Pipette 200 µL of the (green) polarization buffer (BUF) into wells A6–H6.

l Pipette 200 µL of the green high polarization reference (HPR) into wells A7–B7.

l Pipette 200 µL of the green low polarization reference (LPR) into wells A8–H9.
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Time-Resolved Fluorescence (TRF) Test

l Pipette 200 µL of deionized water into wells A6–C6.

l If you have not already done so, shake the vial of 20 pM europium suspension
vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or vortex the vial.

l Pipette 200 µL of the 20 pM europium suspension (Eu) into well A8.
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Results Analysis

Corners Test

1. Calculate the Mean of the 12 wells containing the 3.3 nM SF test solution (A1–A3, A10–
A12, H1–H3, and H10–H12).

2. Calculate the Standard Deviation for the same 12 wells.

3. Calculate the %CV: (Standard Deviation / Mean) * 100

The %CV must be < 3.0 to pass.

Sensitivity Test

1. Calculate the Mean and Standard Deviation of the 16 reads for each of the buffer wells
(C9, D9, E9).

2. Among the three buffer wells, find the Median Standard Deviation and corresponding
Mean.

3. Calculate the Mean for the 16 reads of the SF Concentration well (D7).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean SF Concentration, Buffer
Media STD with its corresponding Buffer Mean: 
(SF Mean – Buffer Mean)/3 * Buffer STD)

5. Calculate the Detection Limit, in pM, using the known concentration value of SF and the
Calculated SNR: 1000/SNR

Filter-Based Fluorescence System

Optics Filter Cube
To pass, the Detection Limit

must be:

Top Cube 107 (or
equivalent): 485/20, 528/20,

510 nm dichroic mirror

< 5 pM

Bottom Cube 107 (or
equivalent): 485/20, 528/20,

510 nm dichroic mirror

< 5 pM
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Monochromator-Based Fluorescence System

Optics Wavelength
To pass, the Detection Limit

must be:

Top/Bottom EX 485 nm, EM 528 nm <=20 pM

Linearity Test

1. Calculate the Mean of the four wells for each concentration in columns 1–5.

2. Perform linear regression using these values as inputs:

Filter- and Monochromator-Based Fluorescence System

X Y

1000 Mean of the 1000 pM wells

500 Mean of the 500 pM wells

250 Mean of the 250 pM wells

125 Mean of the 125 pM wells

62.5 Mean of the 62.5 pM wells

3. Calculate the R-Square value; it must be >= 0.9500 to pass.

Fluorescence Polarization (FP) Test

1. Using the raw data from the Parallel read:

l Calculate the Mean Blank (wells A6–H6).

l Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

l Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

2. Using the raw data from the Perpendicular read:
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l Calculate the Mean Blank (wells A6–H6)

l Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

l Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

3. Calculate the G-Factor for each LPR well:
(Parallel LPR Sign * (1–0.02)) / (Perpendicular LPR Signal * (1+0.02))

4. Calculate the Mean G-Factor.

5. Calculate the Polarization value in mP for each HPR well (“PHPR”):

Parallel HPR Signal – Mean G-Factor *
Perpendicular HPR Signal * 1000

Parallel HPR Signal + Mean G-Factor *
Perpendicular HPR Signal

6. Calculate the Mean PHPR, in mP.

Filter Cubes To pass, the Mean PHPR must be:

Dual PMT—Cube 61 (or equivalent);
Single PMT—Cube 108 (or equivalent): 
485/20, 528/20, 510 nm,
dichroic mirror

> 340 mP

7. Calculate the Polarization value in mP for each LPR well (“PLPR”):

Parallel LPR Signal – Mean G-Factor *
Perpendicular LPR Signal * 1000

Parallel LPR Signal + Mean G-Factor *
Perpendicular LPR Signal

8. Calculate the Standard Deviation of the “PLPR,” in mP.

Filter Cubes
To pass, the Standard
Deviation of the PLPR:

Dual PMT—Cube 61 (or equivalent);
Single PMT—Cube 108 (or equivalent): 485/20,
528/20, 510 nm dichroic mirror

< 5
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Time-Resolved Fluorescence (TRF) Test

1. Calculate the Mean and Standard Deviation of the 16 reads for each of the buffer wells
(A6, B6, C6).

2. Among the three buffer wells, find the Media Standard Deviation and corresponding
Mean.

3. Calculate the Mean for the 16 reads of the Eu Concentration well (A8).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean Eu Concentration and Buffer
Median STD with its corresponding Buffer Mean:
(Eu Mean – Buffer Mean)/(3 * Buffer STD)

5. Calculate the Detection Limit, in fM:
20000/(Mean Eu – Mean DI water)/(3 * Standard Deviation DI water)

Light Source Filter Cube
To pass, the Detection

Limit must be:

Xenon flash Cube 112 (or
equivalent): 360/40,

620/40, 400 nm dichroic
mirror

<= 250 fM

TRF laser Cube 126: 337/10, 620/40 <= 40 fM

Troubleshooting Fluorescence Liquid Tests
If any tests fail, please try the following suggestions. If the test(s) continue to fail, print the
results and contact Technical Support.

l Are the solutions fresh? Discard the plate and any opened, unused test solutions after
seven days.

l Are the excitation/emission filters clean?

l Are you using the proper filter cube?

l If the Corners Test continues to fail, the hardware may be misaligned. Contact
Technical Support.

l Are you using new/clean plates? If the base of a clear-bottom plate is touched, clean
the entire base with alcohol (95% ethanol) and then wipe with a lint-free cloth. Before
placing the plate in the instrument, blow the bottom of the plate with an aerosol
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duster. If the test fails again, the optical probe(s) may need to be cleaned. Contact
Technical Support.

l Review the pipetting instructions to verify the plate was correctly prepared.

l Does the Plate Type setting in the Gen5 protocol match the plate you used?

l For models with a dispenser, spilled fluid inside the reader may be fluorescing, which
can corrupt your test results. If you suspect this is a problem, contact Technical
Support.

l When testing Fluorescence Polarization capability using a solid black plastic
microplate, if the standard deviation for the buffer wells is too high, try moving the
buffer wells to another column. With some black plastic plates, the wells in the center
of the plate may be slightly distorted due to the plate molding process, and this can
affect the standard deviation.

l The Read steps in the protocols use the Gen5 Automatic Gain Adjustment feature to
determine optimum sensitivity values for the plate. If an Auto Gain Result value is
outside the range of 30–200, this may indicate a problem.

If the value is less than 30:

n The stock solution/dilution concentrations may be too high. Try creating fresh
solutions/dilutions, and rerun the test using a new, clean plate.

n If all of the tests are passing but the Gain value is low, a PMT in your reader
may just be very sensitive. Contact Technical Support to confirm that this may
be the case.

If the value is greater than 200:

n The stock solution/dilution concentrations may be too low. Try creating fresh
solutions/dilutions, and rerun the test using a new, clean plate.

n For injector models, spilled fluid inside the reader may be fluorescing, which
can corrupt your test results. If you suspect this is a problem, contact
Technical Support.

n The PMTs or optical path(s) may be deteriorating, or the optics or other
hardware may be misaligned. Contact Technical Support.

Gen5 Protocol Reading Parameters
The information in the following tables represents the recommended reading parameters.
It is possible that your tests will require modifications to some of these parameters, such as
the Plate Type (see Troubleshooting Tips on page 115).
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The Plate Type setting in each Gen5 protocol must match the plate you are actually
using.

Synergy Neo 2_FI_T_SF.prt/Synergy Neo 2_FI_B_SF.prt

Parameter Setting

Detection Method: Fluorescence intensity

Read Type: Endpoint

Plate Type: Top Read: Costar 96 black opaque (#3915)
Bottom Read: Greiner Sensoplate

Read Step 1:

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Well: D7

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Scale to High
Wells, D7, 50000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50

Read Height: 5.75 mm (top read); 9.25 mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Read Step 2:

Kinetic: Run Time: 0:01:35
Interval: 0:00:06
Reads: 16
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Parameter Setting

Step Label: Sensitivity Read Buffer

Read Wells: C9..E9

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Use first
filter set gain from FIRST Read Step

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50

Read Height: 5.75 mm (top read); 9.25 mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Read Step 3:

Step Label: Corners Read

Read Wells: A1–A3, A10–A12, H1–H3, H10–H12

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Scale to High
Wells, A3, 50000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50

Read Height: 5.75 mm (top read); 9.25 mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Read Step 4:
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Parameter Setting

Step Label: Linearity Read

Read Wells: C1–F5

Filter Sets: Single PMT
Filter set 1: 485/528
Optics position: Top/Bottom
Gain: (top and bottom optics) Auto, Scale to High
Wells, C1, 50000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50

Read Height: 5.75 mm (top read); 9.25 mm (bottom read)

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Synergy Neo 2_Single PMT_FP.prt and Synergy Neo 2_Dual PMT_FP.prt

This procedure contains one Read step using filters with Fluorescence Polarization
enabled, inside a Plate Mode block.

Parameter Default Setting

Detection Method: Fluorescence polarization

Read Type: Endpoint

Plate Type: Costar 96 black opaque (#3915)

Synchronized Mode: Plate Mode with Timing Control

Read Wells: A6–H9
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Parameter Default Setting

Filter Sets: Single/Dual PMT
FP 485/528
Optics position: Top
Gain: Single PMT—Auto, Scale to well: A9, Scale
value: 20000
Gain: Dual PMT—Side PMT1/Top PMT2: Auto,
Scale to well: A9, Parallel scale value: 20000,
Requested polarization: 20

Read Speed: Normal

Delay After Plate Movement: 0 msec

Measurements Per Data Point: 50

Read Height: 6.50 mm

Dynamic Range: Standard

Light source: Xenon Flash

Lamp energy: Low (faster)

Synergy Neo 2_TRF.prt

Parameter Default Setting

Detection Method: Time-resolved fluorescence -flash

Read Type: Endpoint

Plate Type: Costar 96-well white opaque

Delay Step: 3 minutes

Read Step 1:

Kinetic: Run Time: 0:00:15
Intervale: 0:00:01
Reads: 16

Step Label: Sensitivity Read

Read Well: A8
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Parameter Default Setting

Filter Sets: Single PMT
360/620
Optics position: Top
Gain: Auto, Scale to High Wells, A8, 30000

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Read Height: 4.50 mm

Light source: Xenon Flash

Lamp energy: Low (faster)

Dynamic Range: Standard

Delay: 300 µsec

Data collection time: 1000 µsec

Read Step 2:

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: A6–C6

Filter Sets: Single PMT
360/620
Optics position: Top
Gain: Auto, Use first filter set gain from
FIRST Read Step

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Read Height: 4.50 mm

Light source: Xenon Flash
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Parameter Default Setting

Lamp energy: Low (faster)

Dynamic Range: Standard

Delay: 300 µsec

Data collection time: 1000 µsec

Synergy Neo 2_M_FI_T_SF.prt and Synergy Neo 2_M_FI_B_SF.prt

Parameter Default Setting

Detection Method: Fluorescence

Read Type: Endpoint

Plate Type: Top: Costar 96 black opaque
Bottom: Greiner SensoPlate

Read Step 1:

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Well: D7

Wavelength: Excitation: 485/14, Emission: 528/14

Optics Position: Top/Bottom

Gain Top: Auto, Scale to High Wells, D7, 50000

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height (for top optics): 5.00 mm

Read Step 2:
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Parameter Default Setting

Kinetic: Run Time: 0:01:35
Interval: 0:00:06
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: C9–E9

Wavelengths: Excitation: 485/14, Emission: 528/14

Optics Position: Top/Bottom

Gain: Top: Auto, Use first filter set gain from
FIRST Read Step

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height (for top optics): 5.00 mm

Read Step 3:

Step Label: Corners Read

Read Wells: A1–A3, A10–A12, H1–H3, H10–H12

Wavelengths: Excitation: 485/14, Emission: 528/14

Optics Position: Top/Bottom

Gain: Top: Auto, Scale to High Wells, A3, 50000

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard
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Parameter Default Setting

Read Height (for top optics): 5.00 mm

Read Step 4:

Step Label: Linearity Read

Read Wells: C1–F5

Wavelengths: Excitation: 485/14, Emission: 528/14

Optics Position: Top

Gain: Top: Auto, Scale to High Wells, C1, 50000

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height (for top optics): 5.00 mm

Synergy Neo 2_TRF-N2.prt (requires Gen5 v. 3.06 or higher)

To qualify Synergy Neo 2 “T” models. Dedicated filter cube required: Cube #126 (337/620;
LUM) PN 1035126

Parameter Default Setting

Detection Method: Time-resolved fluorescence -laser

Read Type: Endpoint

Plate Type: Costar 96-well white opaque

Delay Step: 3 minutes

Read Step 1:

Kinetic: Run Time: 0:00:30
Intervale: 0:00:02
Reads: 16

Step Label: Sensitivity Read
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Parameter Default Setting

Read Well: A8

Filter Sets: Single PMT
337/620
Optics position: Top
Gain: Auto, Scale to High Wells, A8, 50000

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Read Height: 4.50 mm

Light source: TRF Laser

Dynamic Range: Standard

Delay: 250 µsec

Data collection time: 1000 µsec

Read Step 2:

Kinetic: Run Time: 0:01:15
Interval: 0:00:05
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: A6–C6

Filter Sets: Single PMT
360/620
Optics position: Top
Gain: Auto, Use first filter set gain from
FIRST Read Step

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Read Height: 4.50 mm

Light source: TRF Laser
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Parameter Default Setting

Dynamic Range: Standard

Delay: 250 µsec

Data collection time: 1000 µsec

Alternate/Supplemental Tests Using Methylumbelliferone (MUB)
As an alternative to using Sodium Fluorescein, Methylumbelliferone (“MUB”) can be used
to test the top and bottom optics for filter-based fluorescence systems and the top optics
for monochromator-based fluorescence systems.

Required Materials

Microplates should be perfectly clean and free from dust or bottom scratches. Use new
microplates from sealed packages.

Manufacturer part numbers are subject to change over time.

BioTek offers a liquid test kit (PN 7160012) containing the microplates and solutions
used in the MUB fluorescence liquid tests for the Top optics. If also testing the Bottom
optics (filter-based system), you will need an additional microplate (see below).

l Methylumbelliferone (“MUB”) (10-mg vial, BioTek PN 98156)

l Carbonate-Bicarbonate buffer (“CBB”) capsules (BioTek PN 98158)

l 100% methanol (BioTek PN 98161)

l Top optics: A new, clean 96-well solid black plate microplate, such as Corning Costar
#3915 or equivalent. The same plate is used to test both filter- and monochromator-
based systems.

l Bottom optics: A new, clean 96-well glass-bottom Greiner SensoPlate (Mfr. #655892),
a clean Hellma Quartz 96-well titration plate (Mfr. #730.009.QG), or equivalent

l Filter cube 107 or equivalent (360/460)

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l 95% ethanol (for cleaning clear-bottom plates)
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l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)

l Gen5 protocols described on page 132:

n Synergy Neo 2_FI_T_MUB.prt tests the top filter-based fluorescence system

n Synergy Neo 2_FI_B_MUB.prt tests the bottom filter-based fluorescence
system

n Synergy Neo 2_M_FI_T_MUB.prt tests the top optics of the monochromator-
based fluorescence system

Test Solutions

Filter solutions to remove particulates that could cause erroneous readings. Do not
allow dust to settle on the surface of the solution; use microplate covers or seals when
not reading the plate.

Wrap the vial containing the MUB stock solution in foil to prevent exposure to light.

Discard any open, unused solutions after seven days.

1. Prepare the buffer (CBB) solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of deionized
or distilled water.

l Open and dissolve the contents of two CBB capsules (do not dissolve the outer
gelatin capsule) into 200 mL of the water.

l Stir the solution (preferably using a stir table) until the CBB is completely
dissolved.

2. Prepare the MUB stock solution:

l Add 1 mL of 100% methanol to the 10 mg vial of MUB.

l Make sure all of the dye has completely dissolved and is well mixed. This yields a
10 mg/mL stock solution.
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l Wrap the solution in aluminum foil to prevent exposure to light.

3. Prepare the dilutions. Label each with “MUB” and the concentration.

Mix This MUB Solution: With: To Make:

0.5 mL of 10 mg/mL stock solution 4.5 mL of 100% methanol 1 mg/mL

0.88 mL of 1 mg/mL solution 4.12 mL of CBB 176 μg/mL

0.1 mL of 176 μg /mL solution 9.9 mL of CBB 1.76 μg /mL

0.5 mL of 1.76 μg /mL solution 4.5 mL of CBB 176 ng/mL

1 mL of 176 ng/mL solution 9 mL of CBB 17.6 ng/mL
(100 nM)

Procedure

1. If you have not already done so, create the Gen5 protocols as described on page 132.

2. If you have not already done so, prepare the test solutions. See page 127.

3. Perform the Sensitivity and Linearity tests using the Top optics of the filter-based
fluorescence system:

l Refer to the pipette map in the next section and pipette the solutions into a clean,
96-well plate.

l Create an experiment based on the Synergy Neo 2_FI_T_MUB.prt protocol.

l Perform the steps under Determine the Optimal Read Height to determine and
set the optimal read height for the filter cube/fluid height combination.

l Read the plate, and then save the experiment.

l If you intend to run this test in the future with the same filter cube, select File >
Save Protocol As, and save the updated protocol with the adjusted read height.
You must, however, rerun these steps if you change the filter cube used with this
test.

4. Perform the Sensitivity and Linearity tests for the monochromator-based fluorescence
system:

l Create an experiment based on the Synergy Neo 2_M_FI_T_MUB.prt protocol.

l Read the plate from step 3, and then save the experiment.
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5. If applicable, perform the Sensitivity and Linearity tests using the Bottom optics of the
filter-based fluorescence system:

l Refer to the pipette map in the next section, and pipette the solutions into a clean,
96-well clear-bottom plate.

l Create an experiment based on the Synergy Neo 2_FI_B_MUB.prt protocol.

l Perform the steps under Determine the Optimal Read Height to determine and set
the optimal read height for the filter cube/fluid height combination.

l Read the plate, and then save the experiment.

l (Optional) Save the updated protocol with the adjusted read height.

6. Calculate and evaluate the results as described under Results Analysis, starting on page
131.

Determine the Optimal Read Height

1. Select Protocol > Procedure, and open the "Sensitivity Read" step.

2. Click Options, clear Automatic Gain Adjustment, and click OK.

3. Click Show advanced options to display the Read Height information.

4. Click Auto-Adjust. Set the Test Well to D7, and click Start Calibration. When prompted,
place the plate on the carrier and click OK.

5. When calibration is complete, a graph appears. Click Select to use the Optimal Height.

6. Click Options again, and select Automatic Gain Adjustment.

7. Record the optimal read height, then click OK to close the read step and return to the
Procedure dialog.

8. Open the "Sensitivity Read Buffer" step. Set the read height to match the recorded
value from step 7 above, then return to the Procedure dialog.

9. Open the "Linearity Read" step. Repeat steps 2–6 above; set the Test Well to C1 in step
4.

10. Return to the Procedure dialog, then click OK to close the Procedure and return to the
experiment.
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Pipette Map

Seal the plate with foil or store it in a black polyethylene bag until use. When using a
clear-bottom plate, if the base of the plate is touched, clean the entire base with
alcohol (95% ethanol) and then wipe with a lint-free cloth. Before placing a plate in the
instrument, blow the bottom of the plate with an aerosol duster.

For the Sensitivity test: 

l Pipette 200 µL of 100 nM MUB solution into well D7.

l Pipette 200 µL of buffer into wells C9, D9, and E9.

For the Linearity test:
Using a multi-channel pipette with just four tips installed to process rows C–F:

l Pipette 150 µL of buffer into columns 2–5 (not column 1). Discard the tips.

l Pipette 150 µL of the 17.6 ng/mL (100 nM) solution into column 1. Discard the tips.

l Pipette 150 µL of the 17.6 ng/mL (100 nM) solution into column 2. Do not discard the
tips.

l Aspirate 150 µL from column 2 and dispense it into column 3. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 µL from column 3 and dispense it into column 4. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 µL from column 4 and dispense it into column 5. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 µL from column 5. Discard the tips.
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Results Analysis

Sensitivity Test

1. Calculate the Mean and Standard Deviation of the 16 reads for each of the buffer wells
(C9, D9, E9).

2. Among the three buffer wells, find the Median Standard Deviation and corresponding
Mean.

3. Calculate the Mean for the 16 reads of the MUB concentration well (D7).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean MUB Concentration and Buffer
Media STD with its corresponding Buffer Mean:
(Mean MUB – Buffer Mean)/(3 * Buffer STD)

5. Calculate the Detection Limit, in ng/mL, using the known concentration value of MUB
and the calculated SNR: 17.6/SNR
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Filter-Based Fluorescence System:

Filter Cube Optic Position To pass, the Detection Limit must be:

Cube 107 (or
equivalent)—360/40,
460/40, 400 nm
dichroic mirror

Top/Bottom <= 0.16 ng/mL (0.91 nM)

Monochromator-Based Fluorescence System:

Wavelengths Optic Position To pass, the Detection Limit must be:

Excitation—360 nm
Emission—460 nm

Top <= 0.16 ng/mL (0.91 nM)

Linearity Test

1. Calculate the Mean of the four wells for each concentration in columns 1–5.

2. Perform linear regression using these values as inputs:

x y

100 Mean of the 100 nM wells

50 Mean of the 50 nM wells

25 Mean of the 25 nM wells

12.5 Mean of the 12.5 nM wells

6.25 Mean of the 6.25 nM wells

3. Calculate the R-Square value; it must be >= 0.9500 to pass.

Gen5 Protocol Reading Parameters

The information in the following table represents the recommended reading parameters. It
is possible that your test will require modifications to some of these parameters, such as
the Plate Type (see Troubleshooting on page 115).

The Plate Type setting in the Gen5 protocol should match the plate you are actually
using.
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Neo 2_FI_T_MUB.prt and Neo 2_FI_B_MUB.prt

Parameter Default Setting

Plate Type: Top Optics: Costar 96-well black opaque (#3915)
Bottom Optics: Greiner Sensoplate

Detection Method: Fluorescence

Read Type: Endpoint

Read Step 1:

Kinetic Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Well: D7

Filter Sets: Single PMT
360/460
Optics position: Top/Bottom
Gain: Auto, Scale to High Wells, D7, 80000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50

Read Height: 4.50 mm (top read); 8.75 mm (bottom read)

Dynamic Range: Standard

Light Source: Xenon Flash

Lamp Energy: Low (faster)

Read Step 2:

Kinetic: Run Time: 0:01:35
Interval: 0:00:06
Reads: 16

Step Label: Sensitivity Read Buffer

Read Well: C9, D9, E9
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Parameter Default Setting

Filter Sets: Single PMT
360/460
Optic position: Top/Bottom
Gain: Auto, Use first filter set gain from FIRST Read Step

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50

Read Height: 4.50 mm (top read); 8.75 mm (bottom read)

Dynamic Range: Standard

Light Source: Xenon Flash

Lamp Energy: Low (faster)

Read Step 3:

Step Label: Linearity Read

Read Well: C1–F5

Filter Sets: Single PMT
360/460
Optics position: Top/Bottom
Gain: Auto, Scale to High Wells, C1, 80000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50

Read Height: 4.50 mm (top read); 8.75 mm (bottom read)

Dynamic Range: Standard

Light Source: Xenon Flash

Lamp Energy: Low (faster)

Neo 2_M_FI_T_MUB.prt

Parameter Default Setting

Plate Type: Costar 96-well black opaque (#3915)
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Parameter Default Setting

Detection Method: Fluorescence

Read Type: Endpoint

Read Step 1:

Kinetic: Run Time: 0:00:45
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read

Read Wells: D7

Wavelengths: Excitation: 360/14, Emission: 460/14

Optics Position: Top

Gain: Auto, Scale to High Wells, D7, 80000

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height: 4.50 mm

Read Step 2:

Kinetic: Run Time: 0:01:35
Interval: 0:00:03
Reads: 16

Step Label: Sensitivity Read Buffer

Read Wells: C9, D9, E9

Wavelengths: Excitation: 360/14, Emission: 460/14

Optics Position: Top

Gain: Auto, Use first filter set gain from FIRST Read Step

Read Speed: Normal
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Parameter Default Setting

Delay after plate movement: 100 msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height: 4.50

Read Step 3:

Step Label: Linearity Read

Read Wells: C1–F5

Wavelengths: Excitation: 360/14, Emission: 460/14

Optics Position: Top

Gain: Auto, Scale to High Wells, C1, 80000

Read Speed: Normal

Delay after plate movement: 100 msec

Measurements per data point: 50

Lamp Energy: Low (faster)

Dynamic Range: Standard

Read Height: 4.50 nm
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Luminescence Test
Luminescence performance is verified using the Harta™ Luminometer Reference
Microplate, which is an LED-based test plate available for purchase.
Depending on the instrument model, one or two luminescence tests should be performed.
Filter-based luminescence is available in most instrument models (except NEO2MON-N).
“M”-models with a monochromator also include a broadband fiber for luminescence.
BioTek recommends performing both luminescence tests at initial setup. On a monthly or
quarterly basis, your organization’s instrument qualification practices and the frequency of
performing luminescence assays with each method should dictate the necessity of testing
performance with both methods.

Required Materials

l Harta Luminometer Reference Microplate, PN 8030015

l Gen5 protocol (see page 139)

l Filter-based test: LUM Upper and Lower Top filter cubes (e.g., #3 and #112, or
equivalent)

Procedure

1. Turn on the Harta reference plate using the I/O switch on the back of the plate.

2. Check the plate’s battery by pressing the test button on the back of the plate and
ensuring that the test light turns on.

The test light may be difficult to see in bright light. Change your angle of view or move
to a darker environment if you cannot see it.

3. Place the Harta plate adapter on the reader’s carrier, then place the test plate on top of
the adapter (PN 8042263).

4. Create an experiment based on the Synergy Neo2 LumTest_Harta.prt or Synergy Neo2
M-LumTest_Harta.prt protocol and read the plate.

5. Calculate and evaluate results as described under Results Analysis below.

Plate Layout
Filter LUM test: Synergy Neo2 LumTest_Harta.prt
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Monochromator broadband LUM: Synergy Neo2 M-LumTest_Harta.prt
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Results Analysis

Through a manual correlation process, it was found that the system requires
approximately 35 photons per attomole of ATP, thus a conversion factor of 0.02884
attomole/photon was applied to determine ATP concentration from the NIST data in
photons/s.

1. On the Harta plate’s Calibration Certificate, locate the NIST measurement for the A2
position and convert it to attomoles:
(A2 NIST measurement*0.02884)

2. Determine if the plate’s battery is functioning properly:

n If A8 > (0.2 * A7), the battery is good. Otherwise, it requires replacement.

A replacement battery is included with each Harta plate. A new spare battery will
be supplied when the plate is recertified.

3. Calculate the signal-to-noise ratio:
(A2–Mean of the buffer cells)/(3 * Standard deviation of
buffer cells)

4. Calculate the detection limit:
A2 NIST measurement in attomoles/signal-to-noise ratio

n If the reader is equipped with the low-noise PMT, the detection limit must be:

n filter-based luminescence: ≤ 50 amol to pass.

n broadband-fiber luminescence: ≤ 75 amol to pass.

n If the reader is equipped with the red-shifted PMT (monochromator or filter), the
detection limit must be ≤ 500 amol to pass with either method.

Gen5 Protocol Reading Parameters
The information in the following tables represents the recommended reading parameters.

Synergy Neo 2_LumTest_Harta.prt

Parameter Default Setting

Plate Type: 8030015 Harta - w/o 8032028 adapter
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Parameter Default Setting

Delay Step: 3 minutes

Read Step 1:

Detection Method: Luminescence

Read Type: Endpoint

Optics Type: Filters

Step Label: Reference well A2

Read Wells: A2

Light path 1: LUM (Single PMT)

Optics position: Top

Gain: 200

Integration Time: 0:10.00 MM:SS.ss

Delay After Plate Movement: 0 msec

Read Height: 10.00 mm

Read Step 2:

Detection Method: Luminescence

Read Type: Endpoint

Step Label: Background

Read Wells: D1..G4

Light path 1: LUM (Single PMT)

Gain: 200

Integration Time: 0:10.00 MM:SS.ss

Delay After Plate Movement: 0 msec

Read Height: 10.00 mm

Read Step 3:

Detection Method: Luminescence
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Parameter Default Setting

Read Type: Endpoint

Read Wells: A7–A8

Step Label: Battery Check

Light path 1: LUM (Single PMT)

Optics Position: Top

Gain: 60

Integration Time: 0:01.00 MM:SS.ss

Delay After Plate Movement: 0 msec

Read Height: 10.00 mm

Synergy Neo 2 M-LumTest_Harta.prt (requires Gen5 v. 3.06 or higher)

Parameter Default Setting

Plate Type: 8030015 Harta - w/o 8032028 adapter

Delay Step: 3 minutes

Read Step 1:

Detection Method: Luminescence

Read Type: Endpoint

Optics Type: Luminescence fiber

Step Label: Reference well A2

Read Wells: A2

Light path 1: LUM (Single PMT)

Gain: 200

Integration Time: 0:10.00 MM:SS.ss

Delay After Plate Movement: 0 msec

Read Height: 1.00 mm
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Parameter Default Setting

Read Step 2:

Detection Method: Luminescence

Read Type: Endpoint

Step Label: Background

Read Wells: F1..G12

Light path 1: LUM (Single PMT)

Gain: 200

Integration Time: 0:10.00 MM:SS.ss

Delay After Plate Movement: 0 msec

Read Height: 1.00 mm

Read Step 3:

Detection Method: Luminescence

Read Type: Endpoint

Read Wells: A7–A8

Step Label: Battery Check

Light path 1: LUM (Single PMT)

Gain: 60

Integration Time: 0:01.00 MM:SS.ss

Delay After Plate Movement: 0 msec

Read Height: 1.00 mm

Luminescence Troubleshooting
If the luminescence test fails, try the following suggestions. If it continues to fail, print the
results and contact Technical Support.

l Ensure that the reading is performed through a hole in the filter cube, not through a
glass filter.

l Verify that the filter cube settings in Gen5 match the physical cube.
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l If the test continues to fail, the optical probe(s) may need to be cleaned. Contact
Technical Support for instructions.

Dispense Module Tests

This section applies only to models with the dispenser.

BioTek has developed a set of tests that you can perform to ensure that the dispense
module performs to specification initially and over time. We recommend that you perform
these tests before first use (e.g., during the Initial OQ), and then every three months.

l The Accuracy Test is a measure of the mean volume per well for multiple dispenses.
The actual weight of the dispensed fluid is compared to the expected weight and must
be within a certain percentage to pass. Pass/Fail criteria depends on the per-well
volume dispensed: 2.0% for 80 µL, 5.0% for 20 µL, and 20.0% for 5 µL. It is assumed
that one gram is equal to one milliliter.

The test uses a single green dye test solution and a 96-well microplate (per
injector) to test the three different volumes. The balance is tared with the empty
plate, and then the 80 µL dispense is performed for columns 1–4. The fluid is
weighed and the balance is tared again (with the plate on the balance). This
process is repeated for the 20 µL and 5 µL dispenses. It is assumed that the
solutions used are at room temperature. A precision balance (three-place) is used
to weigh the plate.

l The Precision Test is a measure of the variation among volumes dispensed to multiple
wells. For each volume dispensed (80 µL, 20 µL, and 5 µL) to four columns, the %CV
(coefficient of variation) of 32 absorbance readings is calculated. Pass/Fail criteria
depends on the per-well volume dispensed: 2.0% for 80 µL, 7.0% for 20 µL, and 10.0%
for 5 µL. The plate is read in an absorbance reader at 405/750 nm for columns 1–4
and at 630/750 nm for columns 5–12.

The two tests are performed simultaneously and use the same plate.

Failures

If any tests fail, prime the fluid lines and rerun the test(s).
If the test(s) fail again, the injectors may require cleaning; see Periodic Maintenance.
If tests continue to fail, contact Technical Support.

Required Materials

Manufacturer part numbers are subject to change over time.
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l Absorbance reader with capability of reading at 405, 630, and 750 nm. The reader
must have an accuracy specification of ± 1.0% ± 0.010 OD or better and a repeatability
specification of ± 1.0% ± 0.005 OD or better.

The Synergy Neo 2 may be used if it has passed the Absorbance Plate Test or
Absorbance Liquid Test 2, and Absorbance Liquid Test 1.

l Microplate shaker (if the absorbance reader does not support shaking)

l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l 50–200 µL hand pipette and disposable tips

l Deionized water

l Supply bottles

l 250-mL beaker

l New 96-well, clear, flat-bottom microplates

l BioTek’s Green Test Dye Solution (PN 7773003) undiluted, or one of the alternate test
solutions listed in the next section

l 100-mL graduated cylinder and 10-mL pipettes (if not using BioTek’s Green Test Dye
Solution)

l Gen5 software installed on the host PC

l Gen5 protocols as defined by the procedure on page 147

Test Solution Formulas

80 µL of test solution with 150 µL of deionized water should read between 1.300 and
1.700 OD at 405/750 nm. The solutions should be at room temperature.

If you do not have the Green Test Dye Solution (PN 7773003), prepare a dye solution using
one of the following methods:

Using the Blue and Yellow Concentrate Dye Solutions:

Material Quantity

Concentrate Blue Dye Solution (PN
7773001, 125 mL)

4.0 mL
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Material Quantity

QC (Yellow) Solution (PN 7120782,
125 mL)

5.0 mL

Deionized water 90.0 mL

Using FD&C Blue and Yellow Dye Powder:

Material Quantity

FD&C Blue No. 1 0.200 grams

FD&C Yellow No. 5 0.092 grams

Tween 20 1.0 mL

Sodium Azide N3Na 0.100 gram

Deionized water Make to 1 liter

Procedure

If you have not already done so, create Gen5 protocols Synergy Neo2_Disp 1 Test.prt
and Synergy Neo2_Disp 2 Test.prt. Instructions begin on page 147.

1. Prime both dispensers with 4000 µL of deionized or distilled water.

2. Remove the inlet tubes from the supply bottles. Prime both dispensers with the Volume
set to 2000 µL. This prevents the water from diluting the dye.

3. Fill a beaker with at least 20 mL of the green dye solution. Prime both dispensers with
2000 µL of the solution. When finished, remove the priming plate from the carrier.

4. In Gen5, create an experiment based on Synergy Neo2_Disp 1 Test.prt.

5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on the microplate carrier.
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Running a dispense procedure without placing a plate in the reader will result in
contamination of the reader from spilled liquid.

When each dispense step is finished, you will weigh the plate, record the weight,
tare the balance with the plate on it, and then place the plate back on the carrier
for the next step.

7. Initiate a plate read. Gen5 prompts you to empty the tip priming trough.

8. When ready, click OK at the Load Plate dialog to begin the experiment. The sequence is
as follows:

a. Dispense 80 µL/well to columns 1–4.

b. Remove the plate and weigh it. Record the weight and tare the balance.

c. Place the plate on the carrier and dispense 20 µL/well to columns 5–8.

d. Remove the plate and weigh it. Record the weight and tare the balance.

e. Place the plate on the carrier and dispense 5 µL/well to columns 9–12.

f. Remove the plate and weigh it. Record the weight.

g. Manually pipette 150 µL of deionized or distilled water into all 12 columns, on top
of the green test dye solution.

h. Place the plate on the carrier for a 30-second shake, the “80 µL” read at 405/750
nm, and the “20 and 5 µL” read at 630/750 nm.

9. When finished, select File > Save As. Enter an identifying file name and click Save.

10. Remove the plate from the carrier and set it aside.

11. Repeat steps 4–9 using Synergy Neo2_Disp 2 Test.prt.

12. See page "Results Analysis" below for instructions on analyzing the results.

When all tests are complete, prime both dispensers with at least 5000 µL of deionized
water to flush out the green dye solution.

Results Analysis

For your convenience, worksheets are included at the end of this chapter for recording
the dispense weights, Delta OD values, calculations, and pass/fail.
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The pass/fail criteria for each set of 32 wells with the same dispense volume is based on
the calculated coefficient of variation (% CV) and Accuracy % Error.
For each volume dispensed (80 µL, 20 µL, 5 µL), for each dispenser (1, 2):

l Calculate the Standard Deviation of the 32 wells

l Calculate the Mean of the 32 wells

l Calculate the %CV: (Standard Deviation / Mean) x 100

l Calculate the Accuracy % Error:
((Actual Weight – Expected Weight)/Expected Weight)* 100

Expected Weights for 32 wells: 80 µL (2.560 g), 20 µL (0.640 g), 5 µL (0.160 g). It is
assumed that one gram is equal to one milliliter.

Dispense Volume To pass, %CV must be
To pass, Accuracy % 
Error must be:

80 µL ≤ 2.0% ≤ 2.0%

20 µL ≤ 7.0% ≤ 5.0%

5 µL ≤ 10.0% ≤ 20.0%

Failures

If any tests fail, prime the fluid lines and rerun the test(s).

l If the test(s) fail again, the injectors may require cleaning (see Periodic Maintenance).

If tests continue to fail, contact Technical Support.

Gen5 Test Protocols
This section contains instructions for creating two Gen5 protocols specifically for
performing the Synergy Neo 2 Dispense Precision and Accuracy test.

1. Select System > Instrument Configuration, and add/configure the Synergy Neo 2 (if it is
not already there).

2. Create a new protocol.

To edit a protocol category, double-click its “branch” in the tree.
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3. Perform the steps in the following three sections to define the Procedure, customize the
Plate Layout, and add Data Reduction steps, to test Dispenser #1.

4. When finished, select File > Save As and save the file as Synergy Neo2_Disp 1 Test.prt.

5. Repeat steps 2–4 above to create Synergy Neo2_Disp 2 Test.prt to test Dispenser 2.

Define the Procedure

In brief, the protocol’s procedure follows the sequence below. After each Dispense step,
the plate is ejected to allow the operator to weigh it and then tare the balance.

l Dispense 80 µL dye to columns 1–4

l Dispense 20 µL dye to columns 5–8

l Dispense 5 µL dye to columns 9–12

l Shake the plate for 30 seconds

l Read columns 1–4 at 405/750 nm and calculate the Delta OD

l Read columns 5–12 at 630/750 nm and calculate the Delta OD

The detailed procedure is described on the next page. To add a step to the procedure, click
the appropriate button on the left side of the Procedure dialog and define the required
parameters.

The comments suggested for use with the Plate Out/In steps are optional, but they may
be useful for the person running the test. When the Plate Out/In step is executed,
Gen5 displays its comment in a message box.

Gen5 Procedure Steps

Step Type Details

1. Dispense Dispenser <select 1 or 2, depending on the protocol>

Dispense to wells A1..H4

Tip prime before this dispense step, 20 µL

Dispense 80 µL at rate 275 µL/sec

2. Plate Out,In Suggested comment: Weigh the plate (80 µL test). RECORD
the weight, TARE the balance. Place the plate back on the
carrier. Click OK to continue.
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Gen5 Procedure Steps

Step Type Details

3. Dispense Dispenser <select 1 or 2, depending on the protocol>

Dispense to wells A5..H8

Tip prime before this dispense step, 20 µL

Dispense 20 µL at rate 250 µL/sec

4. Plate Out,In Suggested comment: Weigh the plate (20 µL test). RECORD
the weight and TARE the balance. Place the plate back on
the carrier. Click OK to continue.

5. Dispense Dispenser <select 1 or 2, depending on the protocol>

Dispense to wells A9..H12

Tip prime before this dispense step, 5 µL

Dispense 5 µL at rate 225 µL/sec

6. Plate Out,In Suggested comment: Weigh the plate (5 µL test). RECORD
the weight. PIPETTE 150 µL/well of DI water into all 12
columns. Place the plate back on the carrier. Click OK to
perform the Read steps.

7. Shake Orbital at 425 cpm (3 mm) for 30 seconds.

8. Read Step label: “80 ul Read_Disp 1” (or _Disp 2)

Wells: A1..H4

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 405 and 750 nm
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Gen5 Procedure Steps

Step Type Details

9. Read Step label: “20 and 5 ul Read_Disp 1” (or _Disp 2)

Wells: A5..H12

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 630 and 750 nm

Customize the Plate Layout (Optional)
The results analysis worksheet at the end of this chapter requires the calculation of the
Standard Deviation, Mean, and % CV of the ODs read for each dispense volume in each
plate (six sets of calculations). By identifying the wells by their dispense volumes in the
Plate Layout, Gen5 will calculate these values for you.

1. In the protocol, open the Plate Layout dialog.

2. Set the Type set to Assay Control and define three control types: Disp_80, Disp_20, and
Disp_5.

3. In the Plate Layout, select Disp_80 and highlight wells A1 to H4.

4. Select Disp_20 and highlight wells A5 to H8.

5. Select Disp_5 and highlight wells A9 to H12.

6. Click OK to save the changes and close the dialog.

After running the experiment, view the Statistics for each Delta OD Data Set to view
the calculations

Add Data Reduction Steps
Each Read step is performed using two wavelengths, so you will create two data reduction
steps to calculate the Delta OD values.
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1. In the protocol, open the Data Reduction dialog and click Custom. Transformation.

2. Click Select multiple data sets and then select DS2.

3. Set the Data In for DS1 to the 80 µL Read step at 405 nm.

4. Set the Data In for DS2 to the 80 µL Read step at 750 nm.

5. Click OK to return to the Transformation dialog.

6. In the New Data Set Name field, type an identifying name such as Delta OD 80 ul_Disp
1.

7. Clear Use single formula for all wells.

8. In the Current Formula field, type DS1–DS2 and then highlight wells A1 to H4 to assign
the formula.

9. Click OK to add the transformation to the Data Reduction list.

10. Create another Transformation similar to the above, with these characteristics:

n DS1 set to the 20 and 5 µL Read step at 630 nm

n DS2 set to the 20 and 5 µL Read step at 750 nm

n New Data Set Name resembling Delta OD 20 and 5 uL_Disp 1

n Remember to clear Use single formula for all wells

n Formula DS1–DS2 applied to wells A5 to H12

11. When you are finished, the Data Reduction Steps list shows two Delta OD
transformations:

12. Click OK to close the Data Reduction dialog.

Alpha Detection Test
This section applies only to models with the Alpha module.

The alpha laser has been factory-calibrated to meet specification. BioTek has developed a
test protocol that can be used with AlphaScreen TruHits Kit, available from PerkinElmer
(Mfg. #6760627), to verify the functionality of the alpha laser system.
The Crosstalk test is a measure of how well the optical system can distinguish the signals
emitted from the well being read from those of any adjacent well. This test also determines
the signal-to-noise ratio (SNR) of the test plate and verifies that the signal is at an
acceptable level for the sample material used. The test is designed for use with
AlphaScreen TruHits, and it is assumed that 96-well plates are used with 100 µL well
volumes.
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After pipetting the solutions into the microplate, allow the plate to sit at room
temperature for 15 minutes before starting the experiment. Cover the plate to prevent
any light from hitting the beads.

Required Materials

Manufacturer part numbers are subject to change.

l Recommended test solution, AlphaScreen TruHits Kit, available from PerkinElmer
(Mfg. #6760627)

l Buffer: Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfg. #P4417
or equivalent)

l Clean 96-well solid white microplate

l 1.5-mL conical-bottom, polypropylene sample tube

l Alpha filter cubes

l Dual PMT system: 2 or equivalent (Alpha Top)

l 1 or equivalent (Alpha Bottom)

l Gen5 protocol: "Gen5 Protocol Reading Parameters" on page 155

Test Solutions

AlphaScreen beads are light sensitive. All tests should be performed under subdued
laboratory lighting of less than 100 lux.

1. Prepare the PBS buffer solution:

a. (Optional, but recommended) Use a 0.45-micron filter to filter 200 mL of deionized or
distilled water.

b. Follow the manufacturer's instructions on the PBS packaging to create 200 mL,
dissolving the necessary amount of PBS into the filtered water.

c. Stir the solution (preferably using a stir table) until the PBS is completely dissolved.

d. Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the TruHits bead suspension:
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a. Shake the container of TruHits bead suspension vigorously for 30 seconds prior to
pipetting. Alternatively, sonicate or vortex the container.

b. Pipette the Donor and Acceptor beads into the bottom of a 1.5 mL conical-bottom,
polypropylene sample tube

l Donor beads 8 µL

l Acceptor beads 8 µL

c. Replace the tube cap and cover the tube with foil.

d. Incubate for 15 minutes at room temperature.

e. Add diluent to a final volume of 1 mL.

l PBS 984 µL

f. Replace the tube cap and cover the tube with foil.

g. Incubate for 15 minutes at room temperature.

h. This yields a TruHits bead suspension that is 20 µg/mL with respect to the Acceptor
beads.

i. Discard the remaining bead solution.

j. If extra beads have been reacted, they can be stored for later use. For storage,
refrigerate any unused portions of the TruHits bead suspension. The temperature
must be between +2°C and +6°C.

Do NOT use sodium azide as a preservative as it will affect the AlphaScreen signal.
Procline™ 300 at 0.03% is suggested.
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Pipette Map

Procedure
Crosstalk Test

1. Pipette 100 µL of PBS in wells A1–A12, B1, B3–B4, B6–B7, B9–B10, B12, C1–C12, and
G1–H12 (see pipette map, “BUF“ wells).

2. Pipette 100 µL of 20 µg/mL AlphaScreen beads suspension into wells B2, B5, B8, and
B11 (see pipette map, “20 µg/mL OMB” wells).

Allow the plate to sit at room temperature for approximately 15 minutes prior to use.

3. Create an experiment based on the Synergy Neo2 AlphaTest_Crosstalk.prt protocol.
Read the plate, and then save the experiment.

4. Open the Plate menu and export the data to the embedded Power Export spreadsheet.
The spreadsheet reports pass or fail for the test performed. See Results Analysis, next,
for descriptions of the calculations and troubleshooting tips.

5. Print the spreadsheets and store them with your test records.
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Results Analysis

1. Calculate the crosstalk for each of the four wells of AlphaScreen beads solution by
dividing the background-subtracted Mean value of the surrounding adjacent wells by
the background-subtracted AlphaScreen beads suspension well.

2. Average the % crosstalk of the four test wells to determine level of crosstalk
(Crosstalk Mean).

3. Verify that the % crosstalk is less than or equal to 0.1%

4. Calculate the signal-to-noise ratio (SNR) by using the following equation:
SNR = (signal mean – background mean)/(SQRT(signal STD² +
background STD²))

5. Verify that SNR is greater than or equal to 10.

Troubleshooting Alpha Tests
If the test fails, please try the following suggestions. If the test(s) continue to fail, print the
results and contact Technical Support.

l Are the solutions fresh?

l Have the solutions been stored properly (between +2°C and +6°C)?

l Has the kit been exposed to excessive light (in excess of 100 lux)?

l If the Crosstalk test continues to fail, the laser may not be firing. Contact Technical
Support.

Gen5 Protocol Reading Parameters
The information in the following table represents the recommended reading parameters. It
is possible that your tests will require modifications to some of these parameters, such as
Plate Type or Gain value (see Troubleshooting Tips above).

The Plate Type setting in the Gen5 protocol must match the plate you are actually
using.

Synergy Neo 2 AlphaTest_Crosstalk.prt

This procedure contains one read step and calculates crosstalk based on the full plate data.
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Parameter Default Setting

Plate Type Costar 96-well white opaque

Detection Method Alpha

Read Type Endpoint

Read Wells Full plate

Gain 120

Delay after plate movement 0 msec

Excitation time 100 msec

Delay after excitation 120 msec

Integration time 100 msec

Read height 7.00 mm
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This appendix contains the published specifications for the Synergy Neo 2.
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General Specifications

Microplates

The Synergy Neo 2 accommodates standard 6-, 12-, 24-, 48-, 96-, 384-, and 1536-well
microplates with 128 x 86 mm geometry and the Take3 and Take3 Trio Micro-Volume
Plates.

Maximum Plate Height: 0.89"

Hardware and Environmental

Light Source

Absorbance, Fluorescence
(FI), monochromator-
based:

Xenon flash light source, 20W maximum average power

Fluorescence (FI/FP),
filter-based:

Xenon flash light source, 5W maximum average power

TRF xenon flash filter-
based:

Xenon flash light source, 5W maximum average power

TRF laser filter-based: Nitrogen (N2) laser light source

With all modules installed, without power supply or dispense module attached:

Weight: approximately 100 lbs. (45.36 kg)

Dimensions 16.25" H x 15" W x 24.5" D

46.4 cm H x 38.1 cm W x 62.3 cm D

Environment: Power-up temperature 18° to 30°C

Operational temperature 18° to 40°C

Storage temperature -25°C to 50°C

Humidity: Operational: 10% to 85% relative humidity (non-condensing)

Storage: 10% to 80% relative humidity (non-condensing)

Power: Powered from an external 250W (minimum), 24VDC power supply
compatible with 100-240 volts AC @50-60Hz
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Microplates

Incubation: AlphaScreen only: Temperature control range from 3°C over ambient
to 30°C.
All other modes: Temperature control range from 4°C over ambient to
65°C (70°C for models with 70°C support, indicated in the instrument
system test report). For incubation setpoints > 65°C, ambient room
temperature must be at least 20°C.
Temperature variation ± 0.5°C across the plate @ 37°C, tested with
Innovative Instruments, Inc. temperature test plate

Dispense/Read Specifications

Maximum Delay between End of Dispense and Beginning of Read
96/384-Well Plates, Default Probe Heights

Bottom Mono Fluorescence T < 1.0 second

Luminescence (filter or
broadband)

T < 1.0 second

Top Filter Fluorescence T < 1.0 second

Top Mono Fluorescence T < 1.0 second

Absorbance T < 1.0 second

Bottom Filter Fluorescence T < 1.0 second

Dispense/Read, for Models with the Dual-Reagent Dispense Module

Plate Type Both injectors dispense to standard height 6-, 12-, 24-, 48-, 96-,
and 384-well microplates.

Detection Method Absorbance, Fluorescence (FI, FP, TRF), Luminescence

Volume Range 5–1000 µL with a 5–20 µL tip prime

Reagent Dead Volume < 1100 µL, with dead volume recovery function (back flush)

Injection Speeds 225, 250, 275, 300 µL/second

Accuracy ± 1µL or 2.0%, whichever is greater
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Dispense/Read, for Models with the Dual-Reagent Dispense Module

Precision < 2.0% for volumes of 50–200 µL

< 4.0% for volumes of 25–49 µL

< 7.0% for volumes of 10–24 µL

< 10.0% for volumes of 5–9 µL
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Absorbance Specifications

Note: For the performance specifications described in this section, the gain on the
optics test should be <= 8.

Optics

Wavelength Range 230 to 999 nm

Wavelength Bandpass < 4 nm (230–285 nm), < 8 nm (> 285 nm)

Measurement Range 0.000 to 4.000 OD

Resolution 0.0001 OD

Increment 1 nm

Wavelength Accuracy ± 2 nm

Wavelength Precision ± 0.2 nm

Minimum kinetic interval (450 nm) < 12 seconds, sweep mode, 384-well microplate

Plate In/Plate Out Speed

< 20 seconds, 450 nm, sweep mode, 384-well microplate

Accuracy, Linearity, Repeatability

Specifications apply from 250–999 nm, 200 µL (96-well microplates) and 80 µL (384-well
microplates).

Accuracy (tested with certified neutral density glass)

96-well plate, normal read speed

0–2 OD: +/-1% +/-0.010 OD, delay after plate movement = 100 ms

2–2.5 OD: +/-3% +/-0.010 OD, delay after plate movement = 100 ms

384-well plate, normal read speed

0–2 OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms

2–2.5 OD: +/-5% +/-0.010 OD, delay after plate movement = 100 ms
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Accuracy, Linearity, Repeatability

96-well and 384-well plate, sweep read speed

0–1 OD: +/-2% +/-0.010 OD

Linearity (by liquid dilution)

96-well plate, normal read speed

0–2 OD: +/-1% +/-0.010 OD, delay after plate movement = 100 ms

2–2.5 OD: +/-3% +/-0.010 OD, delay after plate movement = 100 ms

384-well plate, normal read speed

0–2 OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms

2–2.5 OD: +/-5% +/-0.010 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed

0–1 OD: +/-2% +/-0.010 OD

Repeatability (tested with certified neutral density glass/measured by one standard deviation: 8
measurements per data point)

96-well and 384-well plate, normal read speed

0–2 OD: +/-1% +/-0.005 OD, delay after plate movement = 100 ms

2–2.5 OD: +/-3% +/-0.005 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed

0–1 OD: +/-2% +/-0.010 OD

Take3 Plate

Detection Limit, 260 nm dsDNA < 5 ng/μL
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Fluorescence Specifications (Mono-Based)
The Synergy Neo 2 measures fluorescence with monochromators from the top and bottom
of 6- to 1536-well plates.

Monochromator-Based Fluorescence

Excitation
range

250-700 nm with low-noise PMT

250–850 nm with red-shifted PMT

Emission
range

250-700 nm with low-noise PMT

250–850 nm with red-shifted PMT; 300 nm minimum with EM scan.

Bandpass Excitation and Emission: Variable, from 3 nm–50 nm (wavelength dependent) in 1
nm increments

Optical Probes

Top position 2.00 mm diameter fixed

Bottom position 2.00 mm diameter fixed

Plate In/Plate Out Speed

< 20 seconds for filter set, sweep mode, 384-well microplate

Sensitivity

96-/384-well
plates

Sodium Fluorescein in phosphate buffered saline (PBS)
DL <= 20 pM top or bottom read
Excitation 485 nm, Emission 528 nm
Methylumbelliferone (MUB) in carbonate-bicarbonate buffer (CBB)
DL <= 0.16 ng/mL (0.91 nM) top read
Excitation 360 nm, Emission 460 nm
Propidium Iodide (PI) in PBS
DL <= 62.5 ng/mL bottom read
Excitation 485 nm, Emission 645 nm
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Fluorescence Specifications (Filter-Based)
The Synergy Neo 2 measures fluorescence with filters from the top and bottom of 6- to
1536-well plates. The xenon flash bulb is used for TRF flash reads except when the TRF
laser is selected in T-model instruments. The T-models use an N2 laser to perform TRF
using filters and top probe.

Optical Probes

Top position 2.6-mm diameter fixed

Bottom position 2.6-mm diameter fixed

Top Single PMT

Plate In/Plate Out Speed

< 20 seconds for filter set, sweep mode, 384-well microplate

Sensitivity

96-/384-well plates DL < 5 pM solution of Sodium Fluorescein in PBS Excitation 485/20,
Emission 528/20, 510 nm mirror

DL ≤ 0.16 ng/mL (0.91 nM) solution of Methylumbelliferone in CBB,
Excitation 360/40, Emission 460/40, 400 nm mirror

Time-Resolved Fluorescence Flash

96-/384-well plates DL Europium ≤ 250 fM

Excitation 360/40 nm,

Emission 620/40 nm 400 nm mirror

Integration Interval 20 to 2000 µs

Delay 0 to 2000 µs

Granularity 1-µs step
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T-Models with TRF Laser only: Gen5 version 3.06 or higher.

Time-Resolved Fluorescence Laser

96-/384-well plates DL Europium ≤ 20 fM (50 measurements/well - 384-well plate, 100
µL/well); DL Europium ≤ 40 fM (50 measurements/well - 96-well
plate, 200 µL/well)

Delay 250 µsec

Collection time 1000 µsec

HTRF (Cisbio®) HTRF Assays successfully performed with white and black microplates

Top Double PMT

Plate In/Plate Out Speed

< 20 seconds for filter set, sweep mode, 384-well microplate

Fluorescence Polarization

96-/384-well plate < 5 mP standard deviation at 1 nM Sodium Fluorescein
Excitation 485/20 nm, Emission 528/20 nm, 510 nm mirror

Bottom Optics

Sensitivity

96-/384-well plates DL < 5 pM solution of Sodium Fluorescein in PBS Excitation
485/20, Emission 528/20, 510 nm mirror

DL ≤ 0.16 ng/mL (0.91 nM) solution of Methylumbelliferone in
CBB, Excitation 360/40, Emission 460/40, 400 nm mirror
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Luminescence Specifications
The Synergy Neo 2 measures luminescence from the top of 6- to 384-well plates. The
following requirements apply to 96-well plates with 200 µL/well, at room temperature.
Product testing is performed using a Harta plate.

Luminescence - Filter-based detection

96-well plate ≤ 50 amol/well—standard low-noise PMT

≤ 500 amol/well—red-shifted PMT

Integration Time 10 seconds

Blank Wells 16

Cross-talk < 0.1% in 96-well plate

< 0.25% in low-volume 384-well plate

Synergy Neo 2 models with this capability require Gen5 version 3.06 or higher:

Luminescence - Broadband fiber detection

96-well plate ≤ 75 amol/well —standard low-noise PMT

≤ 500 amol/well—red-shifted PMT

Integration Time 10 seconds

Blank Wells 16

Alpha Detection Specifications

Alpha Laser

Laser Output Power 100 mW ± 10%
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Error Conditions

This appendix lists and describes Synergy Neo 2 error codes that may
appear in Gen5.

Error Codes Overview 168

Error Codes 168
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Error Codes Overview
When a problem occurs during operation with the Synergy Neo 2, an error message
appears in Gen5. Error messages typically contain four characters, such as “4168,” and in
most cases are accompanied by descriptive text, such as “PMT overload error.” With many
errors, the instrument will beep repeatedly; press the carrier eject button to stop this
alarm.
Some problems can be solved easily, such as “2B0A: Priming plate not detected” (place a
priming plate on the carrier). Some problems can be solved only by trained Technical
Support personnel. This appendix lists the most common and easily resolved error codes
that you may encounter.

Error codes beginning with “A” (e.g., A100) indicate conditions that require immediate
attention. If this type of code appears, turn the instrument off and on. If the System
Test does not conclude successfully, record the error code, note the instrument serial
number and contact Technical Support.

If an error code appears in Gen5, you may want to run a System Test for diagnostic
purposes. In Gen5, select System > Diagnostics > Run System Test.

If an error message appears while an experiment is in process and after having received
measurement data, it is your responsibility to determine if the data is valid.

Technical Support
Use this appendix to diagnose problems and solve them if possible. If you need further
assistance, contact Technical Support; see page vi.

For errors that are displayed during operation of the Synergy Neo 2 with the stacker or
the BioStack 4, refer to the stacker's or Biostack's user manuals.

Error Codes
This table lists the most common and easily resolved error codes that you may encounter.
If an error code appears in Gen5, look for it here. If you find the code, follow the
suggestions provided for solving the problem. If you cannot find the code or if you are
unable to solve the problem, please contact Technical Support. The Gen5 Help system also
provides troubleshooting tips.
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Code Description and Possible Remedy

2353 Expected plug/hole/filter not found in filter cube

This error indicates that the filter cube is not installed and is required for the
read. Install the filter cube or check that it is installed correctly.

2700 Error attempting to run the barcode scanner SET command

A response returned from the scanner is invalid.

2701 Error attempting to run the barcode scanner SET command

The command message is calling out an invalid barcode location. Valid
numbers are 1–4.

2702 Error attempting to get barcode scanner information regarding one of the
barcode types

The barcode type returned by the scanner is not one of those expected.

2703 Barcode type is not supported

One of the four barcode types is not supported by the scanner.

2704 Error disabling start/stop character transmission

While attempting to tell the scanner to disable the transmission of start and
stop characters along with the barcode value for the Codebar barcode type,
an error occurred.

2B0A Priming plate not detected

2B0x Dispenser syringe 1 or 2 (respectively) did not home

x=1–3

Generally, this error indicates the syringe was not properly installed. Make
sure the syringe’s thumbscrews are properly threaded. (Refer to the
Installation chapter for instructions.) Restart the reader.

2B04 Dispenser syringe 1 or 2 (respectively) failed position verify

Generally, this error indicates the syringe was not properly installed. Make
sure the syringe’s thumbscrews are properly threaded. Restart the reader.
(Refer to the Installation chapter for instructions.)
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Code Description and Possible Remedy

2D15 Kinetic interval is out of range.

Valid range is 9 to 9999 seconds.

37x0/47x0
38x0/48x0
39xy/49xy

Noise Test Errors
Offset Test Errors
Dark Range Errors

x=0, 1; y=0–6

This series of System Test errors may indicate too much light inside the
chamber. Make sure the plate carrier door and the front hinged door are
properly closed. For models with the dispense module, if the dispense tubes
are not connected to the reader, re-install the light shield that shipped with
the instrument (or cover the hole with black tape). Restart the reader.

4Fxy Fluorescence signal out of range.

x=0, 1; y=0–6

Too low of a reading indicates a light signal problem. Ensure that Gen5
Fluor/Lum wavelengths table matches the actual filter installed in the filter
cube.

40xx PMT overload well error at <well #xxx>

This error typically means that the fluid in a well has oversaturated the PMT
(i.e., the well is too bright). Try lowering the sensitivity value in the read step.

To identify the well:

Wells are counted starting at A1, moving left-to-right, row-by-row. The row
and column of the well can be extracted from the well number code by
applying the following formula (example uses 8 x 12 geometry, 96-well plate):

1. Convert the ASCII hex string to a decimal equivalent. Ex: “057” indicates 57
hex, yielding a well code of 87 decimal.

2. Row = (well code) / (columns in plate), rounded up to a whole number. Ex:
87/12 = 7.25, indicating row 8 (or H).

3. Column = (well code) - ((row-1) * (columns in plate)). Ex: 87 - ((8 - 1) * 12) =
column 3.
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Code Description and Possible Remedy

4Exy Detector saturated (too much light). Relative Fluorescing Units (RFU)
reached (99999).

X = Fluorescence channel

Fluorescence/Luminescence Channel Codes

Mono optics reference channel 0

Mono optics PMT channel 1

Top filter optics reference channel 2

Top filter optics, top PMT channel 3

Top filter optics, side PMT channel 4

Bottom filter optics reference channel 5

Bottom filter optics PMT channel 6

Y = PMT Test Type Code

Connection Test 0 PMT not connected

High Voltage Test 1 Failure during test at higher voltage

Low Voltage Test 2 Failure during test at lower voltage

Well Overload Test 5 Failure during test at well

Background Overload Test 8 Failure during background overload test

OR Y = filter readset

This error can indicate one of several scenarios. It is possibly due to incorrect
chemistry, e.g., the fluorescence standards dispensed to the plate exceed
expectations.

For models with the dispense module, the internal chamber may require
cleaning (contact Technical Support).

2D46 Fluorescence wavelength not found in table

This error indicates that the wavelength specified in the procedure is not
detected in the instrument’s filter table. In Gen5, verify the Fluorescence filter
table has the wavelengths loaded into the reader. Compare the contents of
the table with the filters installed in the filter cube (see the Gen5 Help system
for more information). Restart the reader.
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Code Description and Possible Remedy

50xx
510x

Axis failed to home

Top filter optics, lower filter/mirror slider 03

Top filter optics, upper filter/mirror slider 04

Bottom filter optics, filter/mirror slider 06

Generally, this error indicates the filter cube is not seated properly in the
reader. Remove it, ensure each filter or plug is properly positioned and
reinstall it securely. Restart the reader.

540x Filter cube failed positional verify

Top filter optics, lower filter/mirror slider 03

Top filter optics, upper filter/mirror slider 04

Bottom filter optics, filter/mirror slider 06

Generally, this error indicates the filter cube is not seated properly in the
reader. Remove it, ensure each filter or plug is properly positioned and
reinstall it securely. Restart the reader.
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Code Description and Possible Remedy

55xy <Motor> not homed successfully

xy=axis

Axis Codes

Carrier X 00

Carrier Y 01

Top probe Z 02

Top filter optics, lower filter/mirror slider 03

Top filter optics, upper filter/mirror slider 04

Bottom probe Z 05

Bottom filter optics, filter/mirror slider 06

Mono optics, excitation filter sector 07

Mono optics, emission filter sector 08

Mono optics, excitation slit wheel 09

Mono optics, emission slit wheel 0A

Mono optics, excitation probe changer 0B

Mono optics, emission probe changer 0C

Excitation monochromator grating 0D

Emission monochromator grating 0E

Dispenser syringe 1 0F

Dispenser syringe 2 10

N2/XE selector 11

This error indicates that an axis failed a previous verify function and now
needs to be homed. Check for any obstructions that may prevent the carrier,
syringes, or filter cube from moving normally. Restart the reader.

570x Area Scan matrix too large for perimeter wells

x=0, 1

For some plate type and read probe combinations, it might not be possible to
define the entire area scan matrix offered by Gen5 for some perimeter wells,
due to the physical limitations of carrier travel. Redefine the area scan to
include a smaller matrix or select wells in a different row or column.
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Code Description and Possible Remedy

5A0x Plate could not be moved inside

x=0, 1

Make sure the Plate Type defined in the Gen5 Protocol matches the plate you
are using. This error can also occur if the plate type is correct but the lid was
left on the plate. If you wish to read the plate with a lid on it, create a new
plate type in Gen5 with the correct Plate Height. This error can also indicate
that the plate is not seated in the carrier correctly. Remove the plate and
replace it securely in the carrier.

Verify the tip priming trough has not become dislodged. Remove any plates
from the carrier and power cycle the instrument to see if the error is resolved.

5B00 Required carrier in when expected to be outside

Carrier is inside the chamber when it should be outside. This may occur if the
read was aborted and "home all axes" not performed.

This error can also occur if the carrier is inside and the newly defined plate
height is different from the most recently specified plate height.

To resolve the error, eject the carrier prior to running the experiment.

70xx Motor synchronization error

If at any time it is discovered that a motor is currently on the wrong microstep
boundary for a move of a specified microstep size, a motor synch error is
flagged.

l Verify there is no binding of axis movement.

l Turn the instrument off and on to see if the error is repeatable.

l Reload the basecode.
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Microplate Barcode Scanner

This appendix contains instructions for installing the optional microplate
barcode scanner and specifications for microplate barcode label format and
positioning. It also tells you how to set up Gen5 to view and use the
scanned barcodes.

Overview 176

Install the Microplate Barcode Scanner 176

About Barcode Labels 179

Placing a Barcode Label 180

Microplate Scanner Diagnostic Utility 182
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Overview
The external barcode scanner allows you to automate the reading of microplate barcode
labels in a robotic system. If a valid barcode is read, the barcode value is automatically
passed to Gen5 for storage in the Gen5 experiment.

Laser Beam. Serious eye injury may occur if you stare directly into the laser
beam of the barcode scanner during operation of the scanner. This hazard
is noted by the symbol shown here. Do not look directly into the laser
beam during operation of the scanner.

The barcode scanner can be installed on either side of or in front of the reader, depending
on which side of the microplate the barcode label is located.

Package Contents
PN 1030008 contains:

l Barcode scanner assembly: scanner (housed in a protective cover), scanner cable, and
mirror attached to a removable mounting bracket

l Scanner alignment bracket

Install the Microplate Barcode Scanner

Be very careful not to scratch or damage the scanner's mirror when unpacking or
installing the microplate barcode scanner! If you are using a stacker, install the stacker
with the interfacing instrument before installing the barcode scanner. See Chapter 2,
Installation.

Make sure the reader is powered off during installation of the barcode scanner.

The barcode scanner can be placed to the left, the right, or in front of the reader's carrier.
Select the mounting position based on the location of the barcode labels on your
microplates.

1. Lift the front of the Synergy Neo 2, place the mounting bracket under the locating pins,
and carefully lower the instrument into the mounting bracket.
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2. Determine the appropriate mounting position for the barcode scanner: left, front, or
right.
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3. Mount the barcode scanner in the bracket, then tighten the thumbscrew.

4. Plug one end of the communications cable into the barcode reader and connect the
other end to the Synergy Neo 2.
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About Barcode Labels
Barcode labels are available for purchase, or they may be created using barcode software
and label products that meet the following specifications:

l Label format (“symbology”): Required formats are:

o Code 128 o Codebar

o Code 39 o UPS

o Datamatrix o QR

o PDF 417 o GS1 Databar

l Industry Standards: The labels should be made in accordance with Automation
Identification Manufactures (AIM) uniform symbol specification for all codes
supported. Label decodability should meet ANSI Specification X2, 182-199 “Bar-Code
Print Quality Guideline” for a rating of A/05/880.

l Label quality: The labels should be printed on good-quality copier machines or
laserjet printers.

l Label position on plate: The labels should not extend above or below the edges of the
plate, because the plates may stick to one another when they are stacked.

See "Placing a Barcode Label" on the next page on page 180 for more information about
where to place the label on the microplate.
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The following figures contain barcode label artwork that may be submitted to a print
vendor for creating labels. The areas marked as quiet zones are critical for the reader to
locate the barcode image.

Placing a Barcode Label
Barcode labels can be located on either the long sides of a microplate or the short side
opposite the well A1 location. The next figure shows the location on the microplate where
the label must be placed in order to be read properly.
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Label Placement Examples
Review the following examples of good label placement:

These examples demonstrate poor placement of the barcode labels:
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Microplate Scanner Diagnostic Utility
To ensure that the microplate barcode scanner mirror is correctly positioned to scan the
barcodes, use the Barcode Scanner Diagnostic utility in Gen5.

1. Place a microplate with a barcode label on the Synergy Neo 2 carrier.

2. From the main Gen5 screen, click System > Instrument Configuration, select the
Synergy Neo 2, and click View/Modify > Setup.

3. On the Barcode Scanner Diagnostic tab, click Start Diagnostic. You can see the reflected
red light from the laser shining toward the microplate carrier.

4. If necessary, click Jog Carrier In to gradually move the carrier so that the barcode label is
within the range of the laser light. When the barcode scanner can read the label, the
results are displayed in the Reader Response area.
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5. If the scanner is unable to read the label, adjust the scanner's mirror position using the
mirror adjustment thumbscrew and run the utility again.

6. When the mirror is set correctly, click Stop Diagnostic. The barcode scanner is now
ready to use.
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Safety Information
Veiligheidsmededelingen

Avis de sécurité

Sicherheitshinweise

Avvisi di sicurezza

Avisos de seguridad

This appendix contains safety information for the 800 TS, translated into
Dutch, French, German, Italian, and Spanish.
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Safety Notices
Veiligheidsmededelingen
Avis de sécurité
Sicherheitshinweise
Avvisi di sicurezza
Avisos de seguridad
Pay special attention to the following safety notices in all product documentation.
Let vooral op de volgende veiligheidsmededelingen in alle productdocumentatie.
Portez une attention particulière aux avis de sécurité suivants dans l'ensemble de la
documentation du produit.
Achten Sie besonders auf die folgenden Sicherheitshinweise in allen
Produktdokumentationen.
Prestare particolare attenzione agli avvisi di sicurezza presenti in tutta la documentazione
del prodotto.
Preste especial atención a los siguientes avisos de seguridad en toda la documentación del
producto.
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A WARNING notice denotes a hazard. It calls attention to an operating
procedure, practice, or the like that, if not correctly performed or
adhered to, could result in personal injury or death. Do not proceed
beyond a WARNING notice until the indicated conditions are fully
understood and met.

De aanduiding WAARSCHUWING duidt op een gevaar. Deze vestigt de
aandacht op een bedieningsprocedure, praktijk of iets dergelijks die,
indien niet correct uitgevoerd of nageleefd, persoonlijk letsel of de dood
tot gevolg kan hebben. Ga niet verder bij een aanduiding
WAARSCHUWING voordat de aangegeven voorwaarden volledig
begrepen zijn en eraan voldaan is.

Un AVERTISSEMENT signale un danger. Il attire l'attention sur une
procédure d'utilisation, une pratique ou autre qui, si elle n'est pas
correctement exécutée ou respectée, peut entraîner des dommages
corporels, voire un décès. Ne passez pas outre l'AVERTISSEMENT
uniquement si les conditions indiquées sont entièrement comprises et
remplies.

Ein WARNHINWEIS weist auf eine Gefahr hin. Er weist auf ein
Betriebsverfahren, eine Vorgehensweise oder ähnliches hin, deren falsche
Ausführung oder Nichtbeachtung zu Verletzungen oder zum Tod führen
können. Fahren Sie bei einem WARNHINWEIS erst dann mit Ihrer Arbeit
fort, wenn die angegebenen Bedingungen vollständig verstanden und
erfüllt sind.

Un avviso di AVVERTENZA indica un pericolo. Richiama l'attenzione su
procedure operative, pratiche o azioni simili che, se non rispettate o
eseguite correttamente, potrebbero causare lesioni personali o decesso.
Non procedere ignorando un avviso di AVVERTENZA fino a quando le
condizioni indicate non sono state completamente comprese e
soddisfatte.

Un aviso de ADVERTENCIA indica un peligro. Destaca la importancia de un
procedimiento operativo, una práctica o un proceso similar que, si no se
realiza o se sigue correctamente, podría provocar lesiones o la muerte.
No siga adelante sin antes comprender y cumplir plenamente los
requisitos indicados en el aviso de ADVERTENCIA.
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A CAUTION notice denotes a hazard. It calls attention to an operating
procedure, practice, or the like that, if not correctly performed or
adhered to, could result in damage to the product or loss of important
data. Do not proceed beyond a CAUTION notice until the indicated
conditions are fully understood and met.

De aanduiding VOORZICHTIG duidt op een gevaar. Deze vestigt de
aandacht op een bedieningsprocedure, praktijk of iets dergelijks die,
indien niet correct uitgevoerd of nageleefd, schade aan het product of
verlies van belangrijke gegevens tot gevolg kan hebben. Ga niet verder bij
een aanduiding VOORZICHTIG voordat de aangegeven voorwaarden
volledig begrepen zijn en eraan voldaan is.

Une MISE EN GARDE signale un danger. Elle attire l'attention sur une
procédure d'utilisation, une pratique ou autre qui, si elle n'est pas
correctement exécutée ou respectée, peut endommager le produit ou
entraîner la perte de données importantes. Ne passez pas outre la MISE
EN GARDE uniquement si les conditions indiquées sont entièrement
comprises et remplies.

Ein VORSICHTSHINWEIS weist auf eine Gefahr hin. Er weist auf ein
Betriebsverfahren, eine Vorgehensweise oder ähnliches hin, deren falsche
Ausführung oder Nichtbeachtung zu einer Beschädigung des Produkts
oder zum Verlust wichtiger Daten führen kann. Fahren Sie bei einem
VORSICHTSHINWEIS erst dann mit Ihrer Arbeit fort, wenn die
angegebenen Bedingungen vollständig verstanden und erfüllt sind.

Un avviso di ATTENZIONE indica un pericolo. Richiama l'attenzione su
procedure operative, pratiche o azioni simili che, se non rispettate o
eseguite correttamente, potrebbero causare danni al prodotto o perdita
di dati importanti. Non procedere ignorando un avviso di ATTENZIONE
fino a quando le condizioni indicate non sono state completamente
comprese e soddisfatte.

Un aviso de PRECAUCIÓN indica un peligro. Destaca la importancia de un
procedimiento operativo, una práctica o un proceso similar que, si no se
realiza o no se sigue correctamente, podrían provocar daños en el
producto o la pérdida de datos importantes. No siga adelante sin antes
comprender y cumplir plenamente los requisitos indicados en el aviso de
PRECAUCIÓN.
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Warnings and Precautions

Electrical Hazards

Elektrische gevaren
Risques électriques
Elektrische Gefahren
Rischi elettrici
Peligros eléctricos

Internal Voltage. Always turn off the power switch and unplug the power
supply before cleaning the outer surface of the instrument.

Interne spanning. Zet altijd de stroomschakelaar uit en haal de stekker uit
het stopcontact voordat de buitenkant van het instrument wordt
gereinigd.

Tension interne. Désactivez toujours l'interrupteur d'alimentation
électrique et débranchez l'alimentation avant de nettoyer la surface
extérieure de l'instrument.

Spannung im Geräteinneren. Vor dem Reinigen der Außenfläche des
Geräts grundsätzlich den Stromschalter ausschalten und das Stromkabel
aus der Steckdose ziehen.

Tensione interna. Spegnere sempre l'interruttore dell'alimentazione e
scollegare l'alimentazione prima di pulire le superfici esterne dello
strumento.

Tensión interna. Siempre apague el interruptor y desconecte la fuente de
alimentación antes de limpiar la superficie exterior del instrumento.
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Power Rating. The instrument’s power supply or power cord must be
connected to a power receptacle that provides voltage and current within
the specified rating for the system. Use of an incompatible power
receptacle may produce electrical shock and fire hazards.

Vermogensklasse. De voeding of het netsnoer van het instrument moet
worden aangesloten op een stopcontact dat spanning en stroom levert
binnen de gespecificeerde nominale waarden voor het systeem. Gebruik
van een niet-compatibel stopcontact kan leiden tot elektrische schokken
en brandgevaar.

Puissance électrique nominale. L'alimentation ou le cordon d'alimentation
de l'instrument doit être raccordé(e) à une prise de courant qui fournit la
tension et le courant correspondants à la puissance spécifiée du système.
L'emploi d'une prise de courant incompatible peut entraîner un choc
électrique et un risque d'incendie.

Leistungsbemessung. Die Stromversorgung des Geräts bzw. das
Anschlusskabel muss mit einer Steckdose verbunden werden, deren
Spannungs- und Stromwerte innerhalb der für das System
vorgeschriebenen Nennwerte liegen. Die Verwendung einer nicht
kompatiblen Steckdose kann zu einem elektrischen Schlag und Brandgefahr
führen.

Potenza nominale. L'alimentazione o il cavo di alimentazione dello
strumento devono essere collegati a una presa di corrente che fornisca
tensione e corrente comprese entro il valore nominale previsto per il
sistema. L'uso di una presa di alimentazione non compatibile può causare
scosse elettriche e rischi di incendio.

Potencia nominal. La fuente de alimentación o el cable de alimentación del
instrumento tienen que conectarse a un receptáculo que suministre
tensión y corriente dentro de la potencia especificada para el sistema. El
uso de un receptáculo incompatible puede producir descargas eléctricas y
riesgo de incendio.
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Electrical Grounding. Never use a plug adapter to connect primary power
to the external power supply. Use of an adapter disconnects the utility
ground, creating a severe shock hazard. Always connect the power cord
directly to an appropriate receptacle with a functional ground.

Elektrische aarding. Gebruik nooit een stekkeradapter om de primaire
stroom aan te sluiten op de externe voeding. Het gebruik van een adapter
verbreekt de verbinding met de aarding van het elektriciteitsnet, waardoor
een ernstige schok kan ontstaan. Sluit het netsnoer altijd rechtstreeks aan
op een geschikt stopcontact met werkende aarding.

Mise à la terre électrique. N'utilisez jamais d'adaptateur de prise pour
raccorder l'alimentation principale à l'alimentation électrique extérieure.
L'utilisation d'un adaptateur déconnecte la terre du secteur, créant un
risque important de choc. Raccordez toujours le cordon d'alimentation
directement à une prise appropriée dotée d'une mise à la terre
fonctionnelle.

Elektrische Erdung. Verwenden Sie niemals einen Steckeradapter zum
Anschließen der Primärstromversorgung an die externe Stromversorgung.
Bei Verwendung eines Adapters wird die Verbindung zur Gebäudeerde
unterbrochen, sodass ein erhebliches Stromschlagrisiko besteht. Das
Stromkabel ist immer direkt an eine geeignete Steckdose mit
Funktionserdung anzuschließen.

Messa a terra elettrica. Non usare mai un adattatore per collegare
l'alimentazione principale all'alimentazione esterna. Se si usa un
adattatore, si scollega la messa a terra della rete elettrica creando un grave
pericolo di scosse elettriche. Collegare sempre il cavo di alimentazione
direttamente a una presa idonea dotata di messa a terra funzionale.

Conexión a tierra. Nunca use un adaptador de enchufe para conectar la
corriente principal a la fuente de alimentación externa. El uso de un
adaptador desconecta la tierra del servicio y crea un riesgo de descarga
grave. Conecte siempre el cable de alimentación directamente a un
receptáculo adecuado con una toma de tierra funcional.
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Service. Only qualified technical personnel should perform service
procedures on internal components.

Service. Alleen gekwalificeerd technisch personeel mag serviceprocedures
aan interne onderdelen uitvoeren.

Entretien. L'exécution des procédures d'entretien des composants internes
doit être réservée au personnel technique qualifié.

Wartung.Wartungsarbeiten an Komponenten im Geräteinneren sollten
nur von qualifizierten Servicetechnikern durchgeführt werden.

Manutenzione. Le procedure di manutenzione sui componenti interni
devono essere eseguite esclusivamente da personale tecnico qualificato.

Revisión. Solo puede realizar procedimientos de revisión de los
componentes internos el personal técnico cualificado.

Power Supply. Use only the power supply shipped with the instrument,
and operate it within the range of line voltages listed on it.

Voeding. Gebruik alleen de voeding die bij het instrument is geleverd en
gebruik deze binnen het bereik van de netspanningen die op de voeding
staan vermeld.

Alimentation électrique. Utilisez exclusivement l'alimentation électrique
fournie avec l'instrument dans la plage de tension de ligne indiquée dessus.

Stromversorgung. Verwenden Sie nur die im Lieferumfang des Geräts
enthaltene Stromversorgung und betreiben Sie diese innerhalb des darauf
angegebenen Netzspannungsbereichs.

Alimentazione. Usare esclusivamente l'alimentatore fornito con lo
strumento, utilizzando quest'ultimo entro l'intervallo delle tensioni di linea
indicato sull'unità.

Fuente de alimentación. Use únicamente la fuente de alimentación
incluida con el instrumento y úsela en el rango de tensiones de línea
indicado en ella.
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Chemical/Environmental

Chemisch/Milieu
Substances chimiques/Environnement
Chemie/Umwelt
Rischi chimici/ambientali
Riesgos químicos y medioambientales

Potential Biohazards. Some assays or specimens may pose a biohazard.
Adequate safety precautions should be taken as outlined in the assay’s
package insert. Always wear safety glasses and appropriate protective
equipment, such as chemical-resistant rubber gloves and apron.

Potentiële biologische gevaren. Sommige tests of specimens kunnen een
biologisch gevaar inhouden. Er moeten adequate veiligheidsmaatregelen
worden getroffen zoals aangegeven in de bijsluiter van de test. Draag altijd
een veiligheidsbril en geschikte beschermingsmiddelen, zoals
chemicaliënbestendige rubberen handschoenen en een schort.

Risques biologiques potentiels. Certains tests ou échantillons peuvent
présenter un risque biologique. Des précautions de sécurité adéquates
doivent être prises, comme indiqué dans la notice de l'emballage du test.
Portez toujours des lunettes de sécurité et un équipement de protection
approprié, comme des gants en caoutchouc résistant aux substances
chimiques et un tablier.

Potenzielle Biogefahren.Manche Assays oder Proben stellen eine
Biogefahr dar. Es sollten angemessene Sicherheitsvorkehrungen
entsprechend der Packungsbeilage des Assays ergriffen werden. Tragen Sie
immer eine Schutzbrille und eine geeignete Schutzausrüstung, wie
chemikalienbeständige Gummihandschuhe und Schürze.
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Potenziali rischi biologici. Alcuni test o campioni potrebbero comportare
un rischio biologico. Implementare misure di sicurezza adeguate secondo
quanto delineato nel foglietto della confezione del test. Indossare sempre
occhiali di sicurezza e dispositivi di protezione appropriati, ad esempio
guanti e grembiule in gomma resistenti alle sostanze chimiche.

Riesgos biológicos potenciales. Algunos ensayos y especímenes pueden
constituir un riesgo biológico. Se han de tomar precauciones de seguridad
suficientes tal como se indica en el folleto del paquete del ensayo. Use
siempre gafas de seguridad y equipos protectores adecuados, como
guantes de caucho resistentes a productos químicos y un delantal.
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Liquids. Avoid spilling liquids on the instrument; fluid seepage into internal
components creates a potential for shock hazard or instrument damage. If
a spill occurs while a program is running, stop the program and turn off the
instrument. Wipe up all spills immediately. Do not operate the instrument
if internal components have been exposed to fluid.

Vloeistoffen. Voorkom dat vloeistoffen op het instrument worden
gemorst; het doorsijpelen van vloeistoffen in interne onderdelen kan
leiden tot schokgevaar of beschadiging van het instrument. Als een lekkage
optreedt terwijl een programma loopt, stopt u het programma en schakelt
u het instrument uit. Veeg alle gemorste vloeistof onmiddellijk op. Gebruik
het instrument niet als interne onderdelen aan vloeistof zijn blootgesteld.

Liquides. Évitez de renverser des liquides sur l'instrument ; les infiltrations
de liquide dans les composants internes créent un risque potentiel de choc
ou de détérioration de l'instrument. En cas de déversement de liquide alors
qu'un programme est en cours d'exécution, arrêtez le programme et
mettez l'instrument hors tension. Essuyez immédiatement tout liquide
renversé. N'utilisez pas l'instrument si les composants internes ont été
exposés à du liquide.

Flüssigkeiten. Keine Flüssigkeiten auf dem Gerät verschütten! In die
Bauteile im Geräteinneren bilden einsickernde Flüssigkeiten ein Potenzial
für die Gefahr von Stromschlägen oder Schäden am Gerät. Bei Verschütten
von Flüssigkeiten während ein Programm läuft, ist dieses zu stoppen und
das Gerät auszuschalten. Verschüttete Flüssigkeiten sind unverzüglich
abzuwischen. Das Gerät darf nicht betrieben werden, wenn Komponenten
im Geräteinneren Flüssigkeiten ausgesetzt waren.

Liquidi. Evitare di versare liquidi sullo strumento; l'infiltrazione di fluidi nei
componenti interni crea rischi di scosse elettriche o danni allo strumento.
Se si verifica un versamento durante l'esecuzione di un programma,
arrestare il programma e spegnere lo strumento. Ripulire immediatamente
tutti i versamenti. Non utilizzare lo strumento se i componenti interni sono
stati esposti a fluidi.

Líquidos. Procure no derramar líquidos sobre el instrumento, ya que si se
filtran fluidos en los componentes internos se puede producir un riesgo de
descarga o de deterioro del instrumento. Si se produce un derramamiento
mientras se está ejecutando un programa, detenga el programa y apague
el instrumento. Limpie el derrame inmediatamente. No utilice el
instrumento si los componentes internos han estado expuestos a fluidos.
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Liquids. Do not immerse the instrument, spray it with liquid, or use a
dripping-wet cloth on it. Do not allow water or other cleaning solution to
run into the interior of the instrument. If this happens, contact Technical
Support.

Vloeistoffen. Dompel het instrument niet onder, bespuit het niet met
vloeistof en gebruik er geen druipnatte doek op. Zorg ervoor dat er geen
water of andere schoonmaakmiddelen in het inwendige van het
instrument terechtkomen. Als dit gebeurt, neem dan contact op met de
afdeling Technische Ondersteuning.

Liquides. N'immergez pas l'instrument, ne le vaporisez pas de liquide et
n'utilisez pas de chiffon non essoré dessus. Ne laissez pas d'eau ou autre
solution de nettoyage pénétrer à l'intérieur de l'instrument. Le cas
échéant, contactez l'assistance technique.

Flüssigkeiten. Das Gerät nicht in Flüssigkeit eintauchen oder damit
einsprühen und keine tropfnassen Tücher verwenden. Kein Wasser oder
andere Reinigungslösung in das Geräteinnere eindringen lassen. Sollte dies
vorkommen, setzen Sie sich mit dem technischen Kundendienst in
Verbindung.

Liquidi. Non immergere lo strumento, nebulizzarlo con liquidi né usare un
panno che non sia stato strizzato bene. Evitare che acqua o soluzioni
detergenti penetrino all'interno dello strumento. Se si verifica
un'infiltrazione, contattare il supporto tecnico.

Líquidos. No sumerja el instrumento, no lo pulverice con líquidos y no use
un paño mojado que gotee sobre él. No permita que entre agua ni otra
solución de limpieza en el interior del instrumento. Si esto sucediera,
póngase en contacto con el servicio de soporte técnico.
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Environmental Conditions. Do not expose the instrument to temperature
extremes. For proper operation, temperature near the instrument should
remain within the range in the Specifications section of this document.
Performance may be adversely affected if temperatures fluctuate above or
below this range.

Omgevingsvoorwaarden. Stel het instrument niet bloot aan extreme
temperaturen. Voor een goede werking moet de temperatuur in de buurt
van het instrument binnen het bereik blijven zoals aangegeven in het
gedeelte Specificaties van dit document. De prestaties kunnen nadelig
worden beïnvloed als de temperatuur boven of onder dit bereik
schommelt.

Conditions environnementales. N'exposez pas l'instrument à des
températures extrêmes. Pour assurer un bon fonctionnement, la
température à proximité de l'instrument doit demeurer dans la plage
indiquée sous la rubrique Spécifications du présent document. La
performance peut être affectée négativement si les températures fluctuent
au-dessus ou au-dessous de cette plage.

Umgebungsbedingungen. Das Gerät darf keinen Extremtemperaturen
ausgesetzt werden. Für den ordnungsgemäßen Betrieb müssen die
Temperaturen in Gerätenähe in den im Abschnitt Spezifikationen dieses
Dokuments angegebenen Grenzen bleiben. Temperaturschwankungen
über diese Grenzwerte hinaus können die Geräteleistung beeinträchtigen.

Condizioni ambientali. Non esporre lo strumento a temperature estreme.
Per il corretto funzionamento, la temperatura nei pressi dello strumento
deve restare nell'intervallo indicato nella sezione Specifiche di questo
documento. Fluttuazioni delle temperature al di sopra o al di sotto di
questo intervallo possono compromettere le prestazioni dello strumento.

Condiciones ambientales. No exponga el instrumento a temperaturas
extremas. Para su correcto funcionamiento, la temperatura que rodee al
instrumento deberá estar dentro del rango indicado en la sección
Especificaciones de este documento. Si las temperaturas fluctúan por
encima o por debajo de este rango, el rendimiento puede verse afectado
negativamente.
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Sodium Hypochlorite. Do not expose any part of the instrument to the
recommended diluted sodium hypochlorite solution for more than 20
minutes. Prolonged contact may damage the instrument surfaces. Be
certain to rinse and thoroughly wipe all surfaces.

Natriumhypochloriet. Stel geen enkel deel van het instrument langer dan
20 minuten bloot aan de aanbevolen verdunde
natriumhypochlorietoplossing. Langdurig contact kan de oppervlakken van
het instrument beschadigen. Zorg ervoor dat alle oppervlakken goed
worden afgespoeld en schoongeveegd.

Hypochlorite de sodium. N'exposez aucune pièce de l'instrument à la
solution d'hypochlorite de sodium diluée comme recommandé pendant
plus de 20 minutes. Un contact prolongé peut endommager les surfaces de
l'instrument. Veillez à rincer et essuyer soigneusement toutes les surfaces.

Natriumhypochlorit. Kein Teil des Geräts darf der empfohlenen
verdünnten Natriumhypochloritlösung länger als 20 Minuten lang
ausgesetzt werden. Bei längerem Kontakt drohen Beschädigungen an den
Geräteoberflächen. Alle Oberflächen unbedingt abspülen und gründlich
abwischen.

Ipoclorito di sodio. Non esporre nessun componente dello strumento alla
soluzione di ipoclorito di sodio diluita raccomandata per più di 20 minuti.
Un contatto prolungato potrebbe danneggiare le superfici dello strumento.
Accertarsi di sciacquare e ripulire accuratamente tutte le superfici.

Hipoclorito sódico. No exponga ninguna parte del instrumento a la
solución de hipoclorito sódico diluido recomendada durante más de 20
minutos. Un contacto demasiado prolongado puede dañar las superficies
del instrumento. Asegúrese de aclarar y secar concienzudamente todas las
superficies.
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Lubricants. Do not apply lubricants to moving parts. Lubricant on
components in the carrier compartment will attract dust and other
particles, which may cause the instrument to produce an error.

Smeermiddelen. Breng geen smeermiddelen aan op bewegende delen.
Smeermiddel op onderdelen in het draagcompartiment zal stof en andere
deeltjes aantrekken, waardoor het instrument een fout kan produceren.

Lubrifiants. N'appliquez pas de lubrifiants sur les pièces mobiles. La
présence de lubrifiant sur les composants dans le compartiment du portoir
attire la poussière et autres particules, ce qui peut provoquer une erreur
de l'instrument.

Schmierstoffe. Keine Schmierstoffe auf bewegliche Teile auftragen.
Schmierstoffe auf Komponenten im Trägerfach ziehen Staub und andere
Teilchen an, die zu einem Gerätefehler führen können.

Lubrificanti. Non applicare lubrificanti alle parti in movimento. La presenza
di lubrificante sui componenti del vano portapiastra attira polvere e altre
particelle che potrebbero causare errori dello strumento.

Lubricantes. No aplique lubricantes en las piezas móviles. El lubricante en
los componentes del compartimento del portador atraerá polvo y otras
partículas que pueden hacer que el instrumento muestre un error.

Synergy Neo 2 User Manual
1351000N Revision A

BioTek Instruments, Inc.



199 | Appendix D: Safety Information

Components

Onderdelen
Composants
Komponenten
Componenti
Componentes

Laser Beam. Serious eye injury may occur if you stare directly
into the laser beam of the barcode scanner during operation of
the scanner. This hazard is noted by the symbol shown here. Do
not look directly into the laser beam during operation of the
scanner.

Laserstraal. Er kan ernstig oogletsel ontstaan als u tijdens het
gebruik van de scanner rechtstreeks in de laserstraal van de
barcodescanner kijkt. Dit gevaar wordt aangegeven met het hier
afgebeelde symbool. Kijk tijdens het gebruik van de scanner niet
rechtstreeks in de laserstraal.

Faisceau laser. De graves lésions oculaires peuvent survenir si
vous regardez directement dans le faisceau laser du lecteur de
code-barres pendant le fonctionnement du scanner. Ce danger
est signalé par le symbole illustré ci-contre. Ne regardez pas
directement dans le faisceau laser pendant le fonctionnement du
scanner.
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Laserstrahl. Schwere Augenverletzungen können auftreten,
wenn Sie während des Betriebs des Scanners direkt in den
Laserstrahl des Barcode-Scanners blicken. Diese Gefahr wird
durch das hier abgebildete Symbol angezeigt. Während des
Betriebs des Scanners nicht direkt in den Laserstrahl blicken.

Raggio laser. Per evitare gravi lesioni oculari, non fissare
direttamente il raggio laser dello scanner di codici a barre
durante il funzionamento dello scanner. Questo pericolo è
segnalato dal simbolo mostrato qui. Non fissare direttamente il
raggio laser durante il funzionamento dello scanner.

Haz del láser.Mirar directamente al haz del láser del escáner de
código de barras cuando el escáner está en funcionamiento
puede provocar lesiones oculares graves. El símbolo que se
muestra aquí advierte sobre este peligro. No mire directamente
al haz del láser cuando el escáner esté funcionando.
Class 1 Laser Product. Alpha laser “A” and TRF laser “T” models.

See "Report on laser safety" on page 208.

Klasse 1 laserproduct. Alpha Laser "A" en TRF laser "T" -
modellen.

Zie "Rapport over laserveiligheid" op pagina 208.

Laser de classe 1. Alpha Laser "A" et laser TRF modèles "T".

Voir « Rapport sur la sécurité laser» à la page 209.

Klasse 1 Laserprodukt. Alpha Laser "A" und TRF Laser "T" -
Modellen.

Siehe "Bericht zur Lasersicherheit" auf Seite 210.

Classe di prodotti laser 1. Alpha Laser "A" e laser modelli "T"
della Fondazione.

Vedere "Rapporto sulla sicurezza laser" a pagina 211.

Producto láser de clase 1.Modelos de láser alfa “A” y láser TRF
“T”.

Ver "Informe sobre seguridad láser" en la página 212.
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Pinch Hazard. Some areas of the external dispense module can
present pinch hazards when the instrument is operating. Keep
hands and fingers clear of these areas when the instrument is
operating.

Beknellingsgevaar. Sommige delen van de externe
uitgiftemodule kunnen beknellingsgevaar opleveren wanneer het
instrument in bedrijf is. Houd handen en vingers uit de buurt van
deze gebieden wanneer het instrument in bedrijf is.

Risque de pincement. Certaines zones du module de dispense
externe peuvent présenter des risques de pincement lors du
fonctionnement de l'instrument. Gardez vos mains et vos doigts à
l'écart de ces zones lors du fonctionnement de l'instrument.

Quetschgefahr. In einigen Bereichen des externen Dispenser-
Moduls können beim Betrieb des Geräts Quetschgefahren
auftreten. Hände und Finger von diesen Bereichen fernhalten,
wenn das Gerät in Betrieb ist.

Rischio di pizzicamento. Alcune aree del modulo di erogazione
esterno possono presentare rischi di pizzicamento quando lo
strumento è in funzione. Tenere le mani e le dita lontane da
queste aree quando lo strumento è in funzione.

Peligro de atrapamiento. Algunas áreas del módulo dispensador
externo pueden presentar riesgos de atrapamiento cuando el
instrumento está en funcionamiento. Mantenga las manos y los
dedos alejados de estas áreas cuando el instrumento esté en
funcionamiento.
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Hot Surface. The lamp assembly is hot when the instrument is
turned on. Turn off the reader and allow the bulb to cool for at
least 15 minutes before attempting to replace it.

Heet oppervlak. De lamp is heet wanneer het instrument wordt
ingeschakeld. Zet het leesapparaat uit en laat de lamp ten minste
15 minuten afkoelen alvorens te proberen deze te vervangen.

Surface chaude. La lampe est chaude lorsque l'instrument est
allumé. Éteignez le lecteur et laissez l'ampoule refroidir pendant
15 minutes au moins avant de la remplacer.

Heiße Oberflächen. Bei eingeschaltetem Gerät ist die Lampe
heiß. Schalten Sie den Reader aus und lassen Sie die Glühbirne
mindestens 15 Minuten lang abkühlen, bevor Sie versuchen, sie
auszutauschen.

Superficie molto calda. Il gruppo lampada diventa molto caldo
quando lo strumento è acceso. Prima di tentare di sostituirlo,
spegnere il lettore e lasciare raffreddare la lampadina per almeno
15 minuti.

Superficie caliente. El conjunto de piezas de la lámpara está
caliente cuando el instrumento está encendido. Apague el lector
y deje que la bombilla se enfríe durante al menos 15 minutos
antes de proceder a cambiarla.
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Two-person lift. The instrument should be lifted by two people.
The instrument with all available modules weighs up to 45.5.kg.

Tillen door twee personen. Het instrument moet door twee
personen worden opgetild. Het instrument met alle beschikbare
modules weegt maximaal 45,5 kg.

Charge à soulever par deux personnes. L'instrument doit être
soulevé par deux personnes. L'instrument avec tous les modules
disponibles pèse jusqu'à 345,5 kg

Anheben durch zwei Personen. Das Gerät sollte von zwei
Personen angehoben werden. Das Gerät mit allen verfügbaren
Modulen wiegt bis zu 45,5 kg.

Due persone per il sollevamento. Lo strumento deve essere
sollevato da due persone. Lo strumento con tutti i moduli
disponibili pesa fino a 45,5 kg.

Levantamiento por dos personas. Es necesario que dos personas
levanten el instrumento. El instrumento con todos los módulos
disponibles puede pesar hasta 45,5 kg.

Accessories. Only accessories that meet the manufacturer's
specifications shall be used with the instrument.

Accessoires. Bij het instrument mogen alleen accessoires worden
gebruikt die voldoen aan de specificaties van de fabrikant.

Accessoires. L'instrument doit être utilisé exclusivement avec des
accessoires correspondant aux spécifications du fabricant.

Zubehör. In Verbindung mit dem Gerät dürfen nur
Zubehörkomponenten verwendet werden, die den
Spezifikationen des Herstellers entsprechen.

Accessori. Utilizzare esclusivamente accessori dello strumento
che rispettano le specifiche del fabbricante.

Accesorios. Solamente aquellos accesorios que cumplan las
especificaciones del fabricante deberán usarse con el
instrumento.
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Shipping Hardware. All shipping hardware must be removed
before operating the instrument and reinstalled before
repackaging the instrument for shipment.

Verzendingshardware. Alle verzendingshardware moet worden
verwijderd voordat het instrument wordt gebruikt en opnieuw
worden geïnstalleerd voordat het instrument opnieuw wordt
verpakt voor verzending.

Matériel d'expédition. Tout le matériel d'expédition doit être
retiré avant d'utiliser l'instrument et réinstallé avant de remballer
l'équipement pour expédition.

Festes Versandmaterial. Alle festen Versandmaterialien müssen
vor der Inbetriebnahme des Geräts entfernt und vor der
Wiederverpackung des Geräts zum Versand neu angebracht
werden.

Minuteria di spedizione. Prima di utilizzare lo strumento,
rimuovere tutta la minuteria di spedizione, che dovrà essere
reinstallata prima di reimballare lo strumento per la spedizione.

Equipo de envío. Antes de utilizar el instrumento es necesario
retirar todo el equipo de envío y, del mismo modo, habrá que
volver a colocárselo cuando el instrumento se vaya a enviar.
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Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories
may result in a loss of warranty and potentially impair instrument
performance or cause damage to the instrument.

Reserveonderdelen. Voor onderhoud mogen alleen
goedgekeurde reserveonderdelen worden gebruikt. Het gebruik
van niet-goedgekeurde onderdelen en accessoires kan tot gevolg
hebben dat de garantie vervalt en mogelijk de prestaties van het
instrument nadelig beïnvloeden of het instrument beschadigen.

Pièces de rechange. Utilisez exclusivement des pièces de
rechange approuvées pour l'entretien. L'utilisation de pièces de
rechange et accessoires non approuvés peut entraîner
l'annulation de la garantie et potentiellement nuire à la
performance de l'instrument ou l'endommager.

Ersatzteile. Für die Wartung sollten nur genehmigte Ersatzteile
verwendet werden. Die Verwendung nicht genehmigter
Ersatzteile und Zubehörkomponenten kann zum Verlust der
Garantie führen und möglicherweise die Geräteleistung
beeinträchtigen oder Schäden am Gerät verursachen.

Parti di ricambio. Per la manutenzione, usare esclusivamente
parti di ricambio approvate. L'uso di parti di ricambio e accessori
non approvati potrebbe dare luogo all'annullamento della
garanzia e ripercuotersi negativamente sulle prestazioni o
causare danni allo strumento.

Repuestos. Durante el mantenimiento, solo deben emplearse
repuestos originales. El uso de repuestos y accesorios no
autorizados puede producir la pérdida de la garantía y reducir el
funcionamiento del instrumento o provocar daños en él.
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Service. Only qualified technical personnel should perform
service procedures on internal components.

Service. Alleen gekwalificeerd technisch personeel mag
serviceprocedures aan interne onderdelen uitvoeren.

Entretien. L'exécution des procédures d'entretien des
composants internes doit être réservée au personnel technique
qualifié.

Wartung.Wartungsarbeiten an Komponenten im Geräteinneren
sollten nur von qualifizierten Servicetechnikern durchgeführt
werden.

Manutenzione. Le procedure di manutenzione sui componenti
interni devono essere eseguite esclusivamente da personale
tecnico qualificato.

Revisión. Solo puede realizar procedimientos de revisión de los
componentes internos el personal técnico cualificado.
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Intended Product Use

Beoogd productgebruik
Utilisation prévue du produit
Vorgesehene Produktverwendung
Uso previsto del prodotto
Uso previsto del producto

Software Quality Control. The operator must follow the manufacturer’s
assay package insert when modifying software parameters and establishing
reading methods. It is considered good laboratory practice to run
laboratory samples according to instructions and specific
recommendations included in the assay package insert for the test to be
conducted. Failure to conduct quality control checks could result in
erroneous test data.

Softwarekwaliteitscontrole. Bij het wijzigen van de softwareparameters en
het vaststellen van afleesmethoden moet de operator de bijsluiter van de
test van de fabrikant volgen. Het wordt beschouwd als een goede
laboratoriumpraktijk om laboratoriummonsters te onderzoeken volgens de
instructies en specifieke aanbevelingen die zijn opgenomen in de bijsluiter
van de verpakking van de uit te voeren test. Het niet uitvoeren van
kwaliteitscontroles kan leiden tot foutieve testgegevens.

Contrôle de qualité du logiciel. L'opérateur doit respecter la notice
présente dans l'emballage du test lorsqu'il modifie les paramètres du
logiciel et établit les méthodes de lecture. L'exécution d'échantillons de
laboratoire conformément aux instructions et aux recommandations
spécifiques présentées dans la notice de l'emballage du test à réaliser est
considérée comme une bonne pratique de laboratoire. Ne pas exécuter les
vérifications de contrôle de qualité peut produire des données de test
erronées.
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Report on laser safety

Synergy Neo2 T-models with the N2 laser

Synergy Neo2 “T” models include a nitrogen laser MNL-100 manufactured by LTB. This
laser is classified to class 3B and therefore the safety aspects are made according to laser
class 3B.

Synergy Neo2 A-models with the Alpha Laser

Synergy Neo2 “A” models include an Alpha Laser, K6880E09FN-0.800W manufactured by
BWT Beijing. This laser is classified to class 3B and therefore the safety aspects are made
according to laser class.

Concerning class 3B lasers, the International Standard IEC 60825-1 on the safety of laser
products states the following: “Class 3B: Lasers are normally hazardous when direct
intrabeam exposure occurs (i.e., within the NOHD). Viewing diffuse reflections is normally
safe.”
Regarding laser safety, it is extremely important to prevent the user from being exposed to
laser beam, either directly or through reflection from a mirror surface. Although the laser
used in Synergy Neo2 is a class-3B laser, the Synergy Neo2 instrument is a class 1 laser
product. This is possible, because Synergy Neo2 has adequate laser shielding which
prevents the user being exposed to the laser radiation.
The Synergy Neo2's interlock system prevents user exposure to the laser beam by disabling
the laser whenever the top-filter door, plate carrier, or side (bottom-filter) hatch of the
instrument is open. The state of the interlock is made visible to users via LEDs on the laser
unit attached to the rear of the instrument. Red LEDs indicate interlock activity; green LEDs
indicate safe laser usage.
When closed the three doors form a light-tight system. Light tightness is essential not only
for laser safety, but also for the functional performance of the instrument. The laser itself
has been installed on the instrument under a protective casing, and the laser beam is led
by an optical fiber via the electronics compartment to the light-tight instrument
compartment.

Rapport over laserveiligheid

Synergy Neo2 T-modellen met de N2-laser

Synergy Neo2 "T"-modellen bevatten een stikstoflaser MNL-100 vervaardigd door LTB.
Deze laser is geclassificeerd in klasse 3B en daarom zijn de veiligheidsaspecten gemaakt
volgens laserklasse 3B.
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Synergy Neo2 A-modellen met de Alpha Laser

Synergy Neo2 "A"-modellen bevatten een Alpha Laser, K6880E09FN-0.800W, vervaardigd
door BWT Beijing. Deze laser is geclassificeerd in klasse 3B en daarom zijn de
veiligheidsaspecten gemaakt volgens laserklasse.
Met betrekking tot lasers van klasse 3B stelt de internationale norm IEC 60825-1 over de
veiligheid van laserproducten het volgende: “Klasse 3B: lasers zijn normaal gesproken
gevaarlijk wanneer directe blootstelling binnen de bundel plaatsvindt (d.w.z. binnen de
NOHD). Het bekijken van diffuse reflecties is normaal gesproken veilig.”
Met betrekking tot laserveiligheid is het uiterst belangrijk om te voorkomen dat de
gebruiker wordt blootgesteld aan laserstralen, hetzij direct, hetzij door reflectie van een
spiegelend oppervlak. Hoewel de laser die in Synergy Neo2 wordt gebruikt een laser van
klasse 3B is, is het Synergy Neo2-instrument een laserproduct van klasse 1. Dit is mogelijk
omdat Synergy Neo2 een adequate laserafscherming heeft die voorkomt dat de gebruiker
wordt blootgesteld aan de laserstraling.
Het interlocksysteem van de Synergy Neo2 voorkomt blootstelling van de gebruiker aan de
laserstraal door de laser uit te schakelen wanneer de bovenste filterdeur, plaatdrager of
zijklep (onderfilter) van het instrument open is. De status van de vergrendeling wordt voor
gebruikers zichtbaar gemaakt via LED's op de lasereenheid die aan de achterkant van het
instrument is bevestigd. Rode LED's geven interlock-activiteit aan; groene LED's geven
veilig lasergebruik aan.
In gesloten toestand vormen de drie deuren een lichtdicht systeem. Lichtdichtheid is niet
alleen essentieel voor de laserveiligheid, maar ook voor de functionele prestaties van het
instrument. De laser zelf is onder een beschermende behuizing op het instrument
geïnstalleerd en de laserstraal wordt door een optische vezel via het
elektronicacompartiment naar het lichtdichte instrumentencompartiment geleid.

Rapport sur la sécurité laser

Modèles Synergy Neo2 T avec le laser N2

Les modèles Synergy Neo2 « T » comprennent un laser à azote MNL-100 fabriqué par LTB.
Ce laser est classé dans la classe 3B et donc les aspects de sécurité sont réalisés selon la
classe laser 3B.

Modèles Synergy Neo2 A avec le laser Alpha

Les modèles Synergy Neo2 "A" incluent un laser Alpha, K6880E09FN-0.800W fabriqué par
BWT Beijing. Ce laser est classé dans la classe 3B et donc les aspects de sécurité sont faits
selon la classe laser.
Concernant les lasers de classe 3B, la norme internationale IEC 60825-1 sur la sécurité des
produits laser stipule ce qui suit : « Classe 3B : les lasers sont normalement dangereux
lorsqu'une exposition directe à l'intérieur du faisceau se produit (c'est-à-dire dans le
NOHD). La visualisation des réflexions diffuses est normalement sans danger.
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En ce qui concerne la sécurité laser, il est extrêmement important d'empêcher l'utilisateur
d'être exposé au faisceau laser, soit directement, soit par réflexion sur une surface de
miroir. Bien que le laser utilisé dans Synergy Neo2 soit un laser de classe 3B, l'instrument
Synergy Neo2 est un produit laser de classe 1. Ceci est possible, car Synergy Neo2 dispose
d'un blindage laser adéquat qui empêche l'utilisateur d'être exposé au rayonnement laser.
Le système de verrouillage du Synergy Neo2 empêche l'exposition de l'utilisateur au
faisceau laser en désactivant le laser chaque fois que la porte du filtre supérieur, le support
de plaque ou la trappe latérale (filtre inférieur) de l'instrument est ouvert. L'état du
verrouillage est rendu visible aux utilisateurs via des LED sur l'unité laser fixée à l'arrière de
l'instrument. Les LED rouges indiquent l'activité de verrouillage ; les LED vertes indiquent
une utilisation sûre du laser.
Lorsqu'elles sont fermées, les trois portes forment un système étanche à la lumière.
L'étanchéité à la lumière est essentielle non seulement pour la sécurité laser, mais aussi
pour les performances fonctionnelles de l'instrument. Le laser lui-même a été installé sur
l'instrument sous un boîtier de protection, et le faisceau laser est conduit par une fibre
optique via le compartiment électronique vers le compartiment de l'instrument étanche à
la lumière.

Bericht zur Lasersicherheit

Synergy Neo2 T-Modelle mit dem N2-Laser

Die Synergy Neo2 „T“-Modelle enthalten einen Stickstofflaser MNL-100, hergestellt von
LTB. Dieser Laser ist in die Klasse 3B eingestuft und daher werden die Sicherheitsaspekte
nach der Laserklasse 3B ausgeführt.

Synergy Neo2 A-Modelle mit dem Alpha Laser

Die Synergy Neo2 „A“-Modelle umfassen einen Alpha-Laser, K6880E09FN-0.800W,
hergestellt von BWT Beijing. Dieser Laser ist in die Klasse 3B eingestuft und daher werden
die Sicherheitsaspekte entsprechend der Laserklasse vorgenommen.
In Bezug auf Laser der Klasse 3B heißt es in der Internationalen Norm IEC 60825-1 zur
Sicherheit von Laserprodukten: „Klasse 3B: Laser sind normalerweise gefährlich, wenn eine
direkte Strahlenexposition (d. h. innerhalb des NOHD) auftritt. Das Betrachten von diffusen
Reflexionen ist normalerweise sicher.“
In Bezug auf die Lasersicherheit ist es äußerst wichtig zu verhindern, dass der Benutzer
direkt oder durch Reflexion von einer Spiegeloberfläche dem Laserstrahl ausgesetzt wird.
Obwohl der in Synergy Neo2 verwendete Laser ein Laser der Klasse 3B ist, ist das Synergy
Neo2-Gerät ein Laserprodukt der Klasse 1. Dies ist möglich, da Synergy Neo2 über eine
ausreichende Laserabschirmung verfügt, die verhindert, dass der Benutzer der
Laserstrahlung ausgesetzt wird.
Das Interlock-System des Synergy Neo2 verhindert, dass der Benutzer dem Laserstrahl
ausgesetzt wird, indem der Laser deaktiviert wird, wenn die obere Filtertür, der
Plattenträger oder die seitliche (untere Filter-) Klappe des Instruments geöffnet ist. Der
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Zustand der Verriegelung wird dem Benutzer über LEDs an der an der Geräterückseite
angebrachten Lasereinheit sichtbar gemacht. Rote LEDs zeigen Interlock-Aktivität an; grüne
LEDs zeigen eine sichere Lasernutzung an.
Im geschlossenen Zustand bilden die drei Türen ein lichtdichtes System. Lichtdichtheit ist
nicht nur für die Lasersicherheit, sondern auch für die Funktionstüchtigkeit des Instruments
unerlässlich. Der Laser selbst ist unter einem Schutzgehäuse am Gerät installiert und der
Laserstrahl wird über einen Lichtwellenleiter über den Elektronikraum in den lichtdichten
Geräteraum geführt.

Rapporto sulla sicurezza laser

Synergy Neo2 T-modelli con il laser N2

I modelli Synergy Neo2 “T” includono un laser ad azoto MNL-100 prodotto da LTB. Questo
laser è classificato alla classe 3B e quindi gli aspetti di sicurezza sono realizzati secondo la
classe laser 3B.

Synergy Neo2 modelli A con Alpha Laser

I modelli Synergy Neo2 "A" includono un laser Alpha, K6880E09FN-0.800W prodotto da
BWT Beijing. Questo laser è classificato in classe 3B e quindi gli aspetti di sicurezza sono
realizzati in base alla classe laser.
Per quanto riguarda i laser di classe 3B, lo standard internazionale IEC 60825-1 sulla
sicurezza dei prodotti laser afferma quanto segue: "Classe 3B: i laser sono normalmente
pericolosi quando si verifica un'esposizione diretta all'interno del raggio (cioè, all'interno
del NOHD). La visualizzazione di riflessi diffusi è normalmente sicura.”
Per quanto riguarda la sicurezza del laser, è estremamente importante evitare che l'utente
venga esposto al raggio laser, direttamente o attraverso la riflessione da una superficie a
specchio. Sebbene il laser utilizzato in Synergy Neo2 sia un laser di classe 3B, lo strumento
Synergy Neo2 è un prodotto laser di classe 1. Ciò è possibile, poiché Synergy Neo2 dispone
di un'adeguata schermatura laser che impedisce all'utente di essere esposto alla radiazione
laser.
Il sistema di interblocco di Synergy Neo2 impedisce l'esposizione dell'utente al raggio laser
disabilitando il laser ogni volta che lo sportello del filtro superiore, il portapiastre o il
portello laterale (filtro inferiore) dello strumento sono aperti. Lo stato dell'interblocco è
reso visibile agli utenti tramite LED sull'unità laser fissata sul retro dello strumento. I LED
rossi indicano l'attività dell'interblocco; i LED verdi indicano un utilizzo sicuro del laser.
Quando sono chiuse le tre ante formano un sistema a tenuta di luce. La tenuta alla luce è
essenziale non solo per la sicurezza del laser, ma anche per le prestazioni funzionali dello
strumento. Il laser stesso è stato installato sullo strumento sotto un involucro protettivo e
il raggio laser è guidato da una fibra ottica attraverso il vano dell'elettronica al vano dello
strumento a tenuta di luce.
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Informe sobre seguridad láser

Modelos Synergy Neo2 T con el láser N2

Los modelos Synergy Neo2 “T” incluyen un láser de nitrógeno MNL-100 fabricado por LTB.
Este láser está clasificado en la clase 3B y, por lo tanto, los aspectos de seguridad se
realizan de acuerdo con la clase de láser 3B.

Modelos Synergy Neo2 A con Alpha Laser

Los modelos Synergy Neo2 “A” incluyen un Alpha Laser, K6880E09FN-0.800W fabricado por
BWT Beijing. Este láser está clasificado en la clase 3B y, por lo tanto, los aspectos de
seguridad se realizan de acuerdo con la clase de láser.
Con respecto a los láseres de clase 3B, la norma internacional IEC 60825-1 sobre la
seguridad de los productos láser establece lo siguiente: “Clase 3B: los láseres son
normalmente peligrosos cuando se produce una exposición directa al haz (es decir, dentro
del NOHD). Normalmente, ver reflejos difusos es seguro ".
Con respecto a la seguridad del láser, es extremadamente importante evitar que el usuario
se exponga al rayo láser, ya sea directamente o mediante el reflejo de la superficie de un
espejo. Aunque el láser utilizado en Synergy Neo2 es un láser de clase 3B, el instrumento
Synergy Neo2 es un producto láser de clase 1. Esto es posible, porque Synergy Neo2 tiene
un blindaje láser adecuado que evita que el usuario se exponga a la radiación láser.
El sistema de enclavamiento del Synergy Neo2 evita la exposición del usuario al rayo láser
al desactivar el láser siempre que la puerta del filtro superior, el portador de la placa o la
trampilla lateral (filtro inferior) del instrumento estén abiertos. El estado del enclavamiento
se hace visible para los usuarios a través de LED en la unidad láser adjunta a la parte
posterior del instrumento. Los LED rojos indican actividad de interbloqueo; Los LED verdes
indican un uso seguro del láser.
Cuando están cerradas, las tres puertas forman un sistema hermético a la luz. La
estanqueidad a la luz es esencial no solo para la seguridad del láser, sino también para el
rendimiento funcional del instrumento. El láser en sí se ha instalado en el instrumento
debajo de una carcasa protectora, y el rayo láser es conducido por una fibra óptica a través
del compartimiento de la electrónica al compartimiento del instrumento a prueba de luz.
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This document contains installation, operation, maintenance, and qualification information
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